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1

Metalogix Content Matrix Console - eRoom Edition simplifies the process of migrating eRoom content

to SharePoint. With Metalogix Content Matrix Console - eRoom Edition, you no longer need to

consider manual copy and paste efforts, arduous custom programming initiatives or dangerous

database level conversions. Instead, Metalogix Content Matrix Console - eRoom Edition lets you

connect remotely to all of your source eRooms and target SharePoint sites in one central, easy to use

interface. All eRoom content types can be migrated and all migration occurs through supported eRoom

and SharePoint APIs. Folders, documents, calendars, eRoom databases, discussion lists or polls can all

be migrated from eRoom to their SharePoint equivalents. eRoom deployments that are document-

centric can be migrated as Document Libraries. In addition to the content itself, permissions, versions,

and metadata can all be automatically migrated. Metalogix Content Matrix Console - eRoom Edition

takes care of the technical details so that migration teams can focus on getting the content migrated

to SharePoint in a way that makes the most sense for the business.
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Supported Source Systems
 

Metalogix Content Matrix console supports any version of eRoom that has the "eRoomXML API"

enabled.

Supported Target Systems
The following target systems are supported in Metalogix Content Matrix Console:

· SharePoint 2013 (Foundation and Server)

· SharePoint 2016

· SharePoint 2019

· SharePoint Server Subscription Edition

· Microsoft Office 365

Key Features
There are many advantages to using Metalogix Content Matrix Console, including the following:

Ease of use
Similar to the Windows File Explorer, Metalogix Content Matrix Console has a familiar, tree-based

copy-and-paste style user interface. 

Valuable data retention
All version chains, metadata, user-edit information, and most views can be preserved.

Multiple site connections
Connect to multiple SharePoint sites, across any number of servers, for easy consolidation or

distribution of your SharePoint data.

Working remotely
Do all the heavy lifting for your SharePoint migration from the convenience of your own machine.

Metalogix Content Matrix Console connects to any SharePoint site that you can access with your

browser, even those outside your organization's intranet.

Batch work
Multiple list migration operations can be batched up for convenience, and re-run at any time. Run your

migrations at night and view the results/logs in the morning.
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Compliance
All migration activity is done through the supported SharePoint APIs. There are no unsupported, direct

writes to the SharePoint database.

PowerShell functionality
PowerShell functionality is incorporated into the Metalogix Content Matrix User Interface (UI), and any

action in the UI can also be performed with PowerShell. Cmdlets are also included, so scripts can be

manually created and run. 

Product Announcements Splash Screen

When you launch the Metalogix Content Matrix Console, a splash screen displays with the latest

Metalogix Content Matrix product announcements.  If you have internet access, you will receive

announcements directly from the Quest website.  If you do not have internet access, the splash screen

displays offline text included with your Metalogix Content Matrix installation.

You have the option of preventing this screen from displaying in the future by clicking the Do not show

this screen again box.  (If you select this option, display of the splash screen will resume the next time

you perform a Metalogix Content Matrix Console installation or upgrade.)

Automatic Updates

Metalogix Content Matrix Console can automatically check online to see if a more recent version of

the product is available for download. This takes place when Metalogix Content Matrix starts.  To help

ensure that you are taking advantage of the latest features and fixes, it provides a direct line to

download and installation of new Metalogix Content Matrix builds.

Automatic Upgrades requires access to the internet. While Metalogix Content Matrix will check every

time it is opened, it is also possible to run a manual check. To do so, go to the main toolbar and choose

Help > Check for Updates.

If you are already running the latest build, the Check for Updates dialog will open and you will be

informed that you already have the latest version installed. If there is a new build available for

download, the Download and Install Update dialog will open.

Running the Automatic Update
When Metalogix Content Matrix checks for updates and finds a newer build available for download,

users will be prompted to update with the Download and Install Update dialog.
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1. Click [Download] to directly download the latest build to your current machine. 

The progress of the download is displayed in the Download progress bar.

NOTE:  If you are accessing the internet through a proxy server, the here link can be clicked on to

open the proxy configuration dialog.

2. Once the download is complete, click [OK] to continue.

The Download and Install Update dialog will still be open, but the Download button will be replaced

with the [Install] button.

You will have the option of installing the new build directly from here by clicking the [Install] button.

This will open the Installation guide. If you are continuing the installation process directly from this

dialog, then the Metalogix Content Matrix Console will close itself down, so the install process can be

run.

NOTE:  When running the automatic upgrade process, only the latest build of the Metalogix Content

Matrix Console will be updated. Any installations of the Metalogix Extensions Web Service will have

to be updated manually.  See the Metalogix Content Matrix Advanced Install Guide for details.
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Entering the License Key

2

You will be prompted to input an Activation License Key when launching the Content Matrix Console:

· for the first time after it has been installed if an existing license is not detected

OR

· after your license has expired.

NOTE:  If users are not required to be a local administrators on the machine where Content Matrix is

installed, every user who launches a Console needs to enter a license key.  If users are are required to

be a local administrator, only the first user who launches a Console needs to enter a license key.

IMPORTANT:  During installation, all Editions of the Console (SharePoint, eRoom, and Public Folder)

are installed.  However, the license will only be activated for Editions that are covered by it.  If an

Edition is not covered by the license, the message Invalid license:  License key is not valid for the given

product. will display in the Activate License Key dialog.

If you are performing an online activation, you can also do it silently, using Powershell.

To enter a license key:

1. In the Activate License Key dialog, select I have a license key, and enter the license key provided

by Quest (the key can be copied and pasted into the provided space).



15
Entering the License Key

Metalogix® Content Matrix eRoom Edition

NOTE:  If you are updating from a Metalogix Content Matrix installation older than version 6,

select the I am updating from an older version and have an old-style key option, and enter the

key in the provided space (or paste into the first field from your clipboard).

2. Select the appropriate activation method. 

NOTE:  Most systems can use the Online activation method as long as the system has internet

access. If you are unable to use the online activation method due to security settings or lack of

internet access, the Offline activation option can be used.

Online Activation
NOTE:  In order to activate your license, the following URL must be unblocked by your firewall: 

https://license.metalogix.com

1. After entering the license key, select Online activation. 

2. If you need to configure proxy settings:

§ Click the Set proxy… link.

§ Follow the procedure for Configuring Proxy Settings.

3. Click [Next].

Metalogix Content Matrix will contact the licensing server and attempt to authenticate the license

key, after which, on successful activation, a 'Congratulations!' message will be returned, and the

license key will be active and in use.

4. Click [Finish] to complete the process.

http://license.metalogix.com
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Offline Activation
NOTE:  The offline activation option is generally used in cases where you cannot use the online

activation due to security settings or lack of internet access. This option will still require some

internet access, but allows for the authentication to be done from another machine that is not as

restricted by security or has a connection to the internet.

1. Select Offline activation.

2. Click [Next].

A Generate Activation Request dialog displays with a different key. This key can be copied from

the window, or the Save to file option can be used to save the key into a text file (in case it needs

to be copied to another machine).

3. Copy the Activation URL (listed under the Activation Request) to a web browser that has internet

access. 

Alternately if the system the Metalogix Content Matrix Console is on does have internet access

through a Web browser, click Go to automatically open a web browser to this URL.

4. On a machine that has internet access, use the Activation URL to navigate to the Offline Activation

page.

5. Either:

§ Enter the key into the Activation data text box. 

OR 

§ If the key was saved to a file, select Browse and navigate to the file.

6. Click [Activate].

Upon successful activation, a new key displays in the text box.

7. Do one of the following:

§ To save the key as a DAT file, click [Download file].

OR

§ To copy the key to the clipboard (if the license will be activated on the same machine), click

[Copy text].

8. Click [OK] to continue.

9. Return to the Activate License dialog.

10. If the Generate Activation Request window is still active, click [Next]. to the Enter your Activation

Response window.

11. Use one of the following options:

§ If you copied the key to the clipboard on the same machine, paste it into the window.

§ If you saved the key to a DAT file, navigate to, and select the DAT file. 

12. Click [Next]. The license key will be active and in use.
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13. Click [Finish] to complete the process.

Checking the Current Content Matrix Console
License

To check the status of the license key in use, open the About dialog. Here, information such as the

license type, expiration date (if any), size limitations for migrations, and how much data has already

been migrated can be seen.

NOTE:  If an offline license is used, the offline activation process will need to be used to do this

update instead, unless the system that the Metalogix Content Matrix Console is installed on has

internet access.

To check the current license:

1. In the Content Matrix Console ribbon toolbar, choose Help > About.

2. In the dialog that opens, click [Refresh]. This will initiate a refresh of this data from the licensing

servers and update the information.
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Selecting the SQL Database You
Want to Connect to

3

The first time you launch the Content Matrix Console you will be prompted to select the SQL database

that you want to connect to. Options are:

· Connect to Job Database (SQL Server)*

* NOTE:  The option Connect to Distributed Database (SQL Server) is disabled as it is only valid for

SharePoint Edition.

· Connect to New Job List (SQL Server Compact 4.0* Required)

· Connect to Existing Job List (SQL Server Compact 4.0* Required)

NOTE:  The use of SQL CE in a production environment is discouraged because of the following

limitations:

§ It uses a single .lst file that is less robust and reliable and may be corrupted after the database

reaches 4 GB.

§ Data compression is not supported.

§ Support for large objects is limited.

§ Microsoft support for SQL CE has ended.

If you still want to use SQL CE, SQL Server Compact 4.0 must already be installed on your machine. 

You can download it from Microsoft, install it, then restart the Console.  

NOTE:  If you have upgraded from version 9.3 or earlier and are using SQL CE (.lst) files but SQL

Server Compact is not installed, a pop-up will display.  You will be given the option of either installing

SQL Server Compact 4.0 or selecting a different Job database.

SQL CE Exception for eRoom Edition

For eRoom Edition only, SQL CE is still used (to store link mappings and for reporting), so if you are

connecting via the eRoom Edition console, SQL Server Compact 4.0 must be installed on the machine

regardless of whether you choose to connect to a full SQL Jobs database.  If SQL Server Compact 4.0 is

not already installed, you will be prompted to download and install it.

To create or connect to a full SQL database: 

IMPORTANT: If you are connecting to an Azure SQL database, the database must already have been

created via Azure Portal.  You cannot create or delete an Azure SQL database from within Content

Matrix.

https://www.microsoft.com/en-us/download/details.aspx?id=30709
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1. From the Please connect to a job database dialog, select Connect to Job Database (SQL Server).

2. Complete the Connect to SQL Server dialog: 

§ If you are connecting to an on premises SQL database, create (using the New Database option)

or select the database you want to use.

§ If you are connecting to an Azure SQL database, select the database that has been created in

Azure Portal for use by Content Matrix.  (Note that the New Database and Delete Database

options will be disabled.)

3. If you want to use an encrypted connection to the database, check the Encrypt Connection box.

NOTE:  If the certificate used for encryption is not trusted, you will also need to check the Trust

Server Certificate box.

4. Select an Authentication method for connecting to SQL server.:

· Use Current Windows User

OR

· Use SQL Server Login

NOTE:  Currently, Use SQL Server login is the only valid option for an Azure SQL server.

5. Click [OK].
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Content Matrix Console End User
Interface

4

The Metalogix Content Matrix Console User Interface (UI) is simple and easy to use. There are three

high level components to the configurable interface:

· Explorer View 1 - At minimum, the interface will always display one Explorer Control, providing

multiple ways to view the content for any active connections to source and target environments.

· Explorer View 2 - A second explorer control can be displayed simultaneously. Having two explorers

visible allows the user to simultaneously view two different parts of the connected content set. For

example, in many cases it makes sense to show a migration source on the left in Explorer Control

1, and a SharePoint migration target on the right in Explorer Control 2.

· Job List - Beneath the Explorer Control windows is a Job list that shows the history of migration

jobs and other tasks that have been run or batched in Content Matrix.

More information on these UI components is provided in the topics that follow.

Main (Ribbon) Toolbar

At the top of the Metalogix Content Matrix Console is a ribbon toolbar allowing access to the following

five menu group settings:

· Connection
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· View

· Settings 

· Help

The Metalogix Content Matrix Console menu ribbon can be expanded or minimized to fit the user's

needs. When expanded, a set of options will be available depending on the selected menu heading. 

When minimized, options will only be visible when a menu heading is selected. Otherwise, only menu

headings will show. The minimize and expand options can also be accessed by right-clicking an option

in the ribbon itself. This opens a context (right-click) menu where the Minimize the Ribbon option can

be selected or deselected.

Quick Access Toolbar

The Quick Access Toolbar can be accessed above the ribbon. The Quick Access Toolbar can also be

moved just below the ribbon by selecting the drop down menu (on the top left-hand side) and choosing

Show Quick Access Toolbar Below the Ribbon, or it can be placed back above the ribbon by choosing

Show Quick Access Toolbar Above the Ribbon.  Any option that is available under one of the menu

group headings can have a shortcut for the option placed into the Quick Access Toolbar. This can be

done by right-clicking on the option in the ribbon, and choosing Add to Quick Access Toolbar.  

Shortcuts can also be removed from the Quick Access Toolbar either by selecting the option within the

ribbon and opening the context (right-click) menu, or by selecting the shortcut option itself, opening the

context (right-click) menu, and choosing Remove from Quick Access Toolbar.
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Explorer Control View Tabs

The Metalogix Content Matrix Console user interface uses an Explorer Control style window which

allows you to navigate, view, and select the desired content for migration. The Explorer Control

window is broken up into three separate tab options, each of which contains its own set of options for

viewing content and data. They are:

· Explorer View Tab

· Items View Tab 

· Browser View Tab 

Explorer View Tab

The Explorer view tab allows you to navigate through your various connections in a tree view.  You can

navigate to and selected a desired SharePoint site collect, site, list/document library or sub-folder or a

under a specific connection or a specific eRoom source connection.

There are a set of filtering options that are available in this tab, as well as a set of ordering options.
This allows you to display, sort, and filter all of your connections as desired.
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There are three primary Filtering options: Text Filter, Connections Filter, and Status Filter.

· Text Filter:  For example, if you only want to view connections that contain "2010" in the URL, you

can enter "2010" in the Filter text box, and click the Filter button to the right of the text value. The

filter will then be applied to all connections in that Explorer View tab, and only connections that

contain a "2010" value will be displayed.

NOTE:  To remove a text box filter, delete the filter value from the text box and re-run the filter

action.

· Connections Filter - This option consists of a drop down menu that allows you to filter by

connection type. By default, all of these options are selected, but one or more can be DE-selected.

 

· Status Filter - This option  consists of a drop-down list with the various connection status options.

§ NotChecked – Metalogix Content Matrix has not tried to validate the connection yet.

§ Checking - Metalogix Content Matrix is currently trying to validate the connection.
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§ Valid - Metalogix Content Matrix has tried to validate the connection, and has been successful.

A connection has been established.

§ Invalid - Metalogix Content Matrix has tried to validate the connection, and has been

unsuccessful. A connection has not been established.

§ Warning - Metalogix Content Matrix has tried to validate the connection, and has been

successful. A connection has been established, however, a warning message has been given.

By default all of the status types are selected but, as with the Connections Filter, one or more can be

de-selected.

You can also Sort by 

· Default - All of the connections in the order they were added.

· Type -These are the same types that are listed in the Connections Filter drop down menu. When

selected, connection types will be sorted in the following order:

§ SharePoint farms (this includes all Web App and Farm connection to a server, as well as

Database connections)

§ SharePoint Site connections, which include Site connection types, and Read-only connections to

SharePoint

§ eRoom Server  

You can combine various filter and sort options.

Items View Tab

The Items View tab displays any items/documents that exist directly under the selected node (that is,

the content of any subfolders under the selected node-will not be displayed), along with column

metadata.
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There are four main options that are available through this tab. These options are:

· Search – To perform a full or partial text search, enter the string in the search box then either and

either press <Enter>, or click the magnifying glass icon to run the search. 

NOTE:  The search will be run on the name column (the FileLeafRef) by default, but you can select a

different  column to search from the drop-down to the right of the search box.

· Refresh - This button will refresh all of the items in the Items View tab.

· Show/Hide Version History - This button option is only available when the selected document

library/list has versioning configured. When this button is selected the Items View tab will be

divided into two sections, a top section displaying all of the items/documents and a bottom section

displaying all of the versions for the selected item/document.
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When an item/document is selected in the top window, all of that item/document's version’s will

be listed in the bottom half of the window. You can then look at the metadata for each

item/document version that exists. This option can be combined with the Show/Hide Properties

button.

If the Show Version History button has already been selected, this will change to be a Hide Version

History button instead. You can use this option to stop looking at item/document version histories.

· Show/Hide Properties - The Show Properties button allows you to see a list-style view of the

available fields (columns) and their values, for a selected item/document. Any value listed in dark

text can be edited and within the window. 

The fields in the Properties window can also be ordered by category, or alphabetically. By default, the

fields are ordered by category, and are listed alphabetically within each category. If listed

alphabetically, then all property fields (columns) will be listed in alphabetical order, with no breakdown

by category. There are two buttons at the top of the Properties window that can be used to determine

what ordering type is used. This option can be combined with the Show/Hide Version History button.

If the Show Properties button has already been selected, this will change to be a Hide Properties

button instead. Use this option to close the Properties window.

Browser View Tab

The Browser View displays a view of the content as it would be seen in a web browser for a selected

node. It is also available if selecting a single item in the Items View. When selected, this tab will display

a fully functioning web browser view of the selected content. You can use this Browser View to

navigate or work with their content, the same way they would through a normal web browser window.
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Jobs List

Jobs in Metalogix Content Matrix Console can be managed from the Job List. Jobs are listed for

migration actions that have already been run, as well as for actions that have been saved. 

 

Using Multi-Select

Multi-select can be used to select a number of nodes on the source side Explorer View tree, and

migrate those nodes to a target SharePoint instance. Multiple SharePoint connections can be selected

at one time, but only to Disconnect or Refresh those connections. If connected to a SharePoint farm

or web application, only a single site collection can be selected at a time, however, multi-select can be

used on any sub-sites under a single site collection.

This feature also works for migrating a single list or site into multiple target locations at the same time;

for example, if you have a document library that you want to migrate into two or more target
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SharePoint sites. After the library is copied, any number of desired target sites can be selected, as long

as they are all under the same target connection node, and when pasted the list will be migrated to all

of the selected target site nodes. The basic cases for multi-select are copying: multiple to one, one to

multiple, and multiple to multiple.

For example, if an eRoom facility is selected in the Explorer View, and the navigation tree is expanded,

you can select a number of rooms (Room A, Room B, etc.) and these can all be migrated at the same

time. After pasting the content all the selected content (Room A, Room B, etc.) will be migrated under

the target SharePoint node.

In addition to using check boxes to multi-select, you can use <Shift> and the <Ctrl> keys in the

conventional way.

Limitations of Multi-Select

There are a few limitations when using multi-select. These limitations are:

· Only one node type can be selected at a time - This means that if a SharePoint site node is

selected, then only other site nodes can be selected, and included in the action.  

While the content under those nodes will be migrated (as per the selected options), only other site

nodes themselves can be selected. This is the same for SharePoint lists/libraries, and folders. When

connected to a SharePoint server only a single site collection can be selected at one time, but

multiple sites under the site collection level can be selected. 

 If an eRoom connection type is made, only nodes under each specific connection can be selected

at one time. This means that users cannot select a facility node under two separate connections at
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the same time. While the content under the selected connection node will be migrated (as per the

selected options), only other eRoom nodes of the same type, and under that same connection, can

be selected at one time

The first node selected in the multi-select will determine what type of node can be included, and if

an invalid selection is made, then the node that you tried to select will only blink. For example, if a

list is selected, then only other lists, within the site collection, can be selected. If you try to select a

SharePoint folder or site, then this is an invalid selection, and the folder or site will blink.

· Column Mapping - Column mapping is not available in some cases when using multi-select. If

multiple lists are selected (on the source or target) then the Column Mapping feature will not be

available. Column mapping is only available when migrating eRoom facilities or rooms, and will not

be available if migrating items or other content types (such as Databases, calendars, etc.). 

· Available Context (Right-Click) Menu Options - When using multi-select the options that are

available in the context (right-click) menu can change depending on where the multi selection is

taking place.

 When copying multiple nodes from the source, only a few context menu options are available. For

example, if migrating multiple eRoom rooms, then the following options would be available: Copy

Containers and Refresh Nodes. If only one source item is selected and pasted to multiple locations, a

few more of the Paste context menu options become available.
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Connecting to eRoom

5

Prerequisite for Connecting to eRoom

Connecting to eRoom requires that the eRoom server have the eRoomXML API enabled. 

As long as this prerequisite is met, you should be able to connect and migrate, regardless of the specific

eRoom version. 

To Connect to eRoom:

1. In the  Metalogix Content Matrix Console -ribbon, choose Connection > Connect to eRoom to

display the eRoom Logon dialog.

2. In the Site Address field, enter the base URL of the eRoom server. 

The base URL is the part of the eRoom server address without the "/eRoom" suffix. For example, if

your eRoom server was accessed in a browser at http://eRoom.quest.com/eRoom, you would

enter http://eRoom.quest.com into the Site Address box. Whenever a legitimate site address is

entered, the XML address (for the XML service) will be automatically generated as a result. The Site

Address is only used for migrating Images for Database (DB) content, however, since the XML

address is generated automatically when the site address is entered you will be able to access all of

your content.
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Note that there is also an XML Address field.  Content Materix will attempt to generate the
expected XML Address field based on the site address. This field is the address for eRoom's
XML request service, and is the main address that eRoom Edition uses when migrating content
from eRoom (such as calendar items, documents, etc.). While this address can be generated
for you (when the site address is entered), you still have the option to enter it manually or to
change the address that is being used. This field is mandatory for connecting to eRoom,
whether the content is automatically generated or is manually entered.

3. Enter the Username  and Password of the eRoom user to be used to connect to the eRoom server.

NOTE:  You can optionally choose to save the credentials of the specified user on the local

machine, by using a check-box option. If you choose this option, the password will be stored in an

encrypted format in the current Windows user's local applications directory.

4. If you need to configure Proxy Settings:

a) Select the Proxy Settings tab.
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b) Use the information in the following table to determine the appropriate action to take.

If you want to ... Then ...

use the proxy

that is specified

by the system's

Internet Options

Select Use default web proxy.

use the poxy

specified in the

Edit Proxy

Settings dialog

· Select Use application proxy server.

· Click [Edit Proxy Settings] to display the Configure

Proxy Settings dialog.

· Enter the Proxy Server Address.

· If using using different user credentials (i.e., other

than the logged in account), select Use different user

credentials and enter the account's  Username and

Password.
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5. If necessary, in the Certificates tab, you can specify any certificates to use. For more information

about adding certificates, see Connecting with Certificates.

6. To connect, click [OK]. 

The eRoom Server node will be added to the Explorer view. If the connection fails due to an

authentication issue, the Failed to login dialog box appears. For more information, see the

Connecting or Reconnecting to eRoom Using Web Browser Authentication.

Enabling eRoom XML

Metalogix Content Matrix communicates with eRoom through the eRoom XML API which is remotely

accessible.  This enables Metalogix Content Matrix to be a true client of eRoom by using this

communication layer,  with no eRoom server side install required.

The eRoom XML API can be toggled on or off via eRoom settings. In the unlikely event that eRoom XML

API is turned off, it will have to be re-enabled for Metalogix Content Matrix to be able to access the

eRoom environment.

To enable eRoom XML:

1. Log in to eRoom via the web interface as an eRoom Site Administrator.

2. On the My eRooms page, go to the Administration section and follow the Site Settings link.

3. On the General Site Settings page, under the Options section, ensure that the Allow XML queries

and commands from external applications option is turned on.

IMPORTANT: In some versions of eRoom, the Allow XML option is available, but not exposed via the

settings web interface. If this is the case in your environment, please contact Quest directly for

information about how to turn this option on. 

Connecting or Reconnecting to eRoom Using
Web Browser Authentication

If the connection to eRoom fails due to authentication issues - for example, if incorrect credentials are

entered, or if the appropriate certificates are not provided when connecting to a secured eRoom

server - the following dialog displays
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Click [Yes] to launch web browser authentication. Enter your credentials and click [OK][ OK]

Invoking the Web Browser Authentication from the right-click
menu 

In order to reconnect to eRoom using web browser authentication - for example, if a certificate was

revoked, or if the current session's authentication cookie expired - right-click the disconnected eRoom

server node and choose Reconnect using Web Browser to launch web browser authentication. The

Login Browser appears, along with a Windows Security dialog. Enter your credentials and click [OK].
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Connecting to SharePoint

6

The following basic connection adapters are supported for making connections to SharePoint from

Metalogix Content Matrix Console:

· A local connection to a SharePoint site or server *

· A remote connection to a SharePoint site or server

·  A client side object model (CSOM) connection for SharePoint Online at the site level 

 * As of version 9.3 the Metalogix Content Matrix Console client application requires Microsoft .NET

Framework 4.7.2 to run. Since this .NET requirement applies to the machine on which Metalogix

Content Matrix is installed, Metalogix Content Matrix cannot make a local Object Model (OM)

connection on a SharePoint 2007 or 2010 environment, because SharePoint 2007 and 2010 require an

earlier version of the .NET Framework (v.3.5), which prohibits Metalogix Content Matrix from

completing the connection.  Because of this, any migration ‘jobs’ configured to connect to SharePoint

2007 and 2010 environments using a Local OM connection type will cease to work, and these jobs will

need to be recreated for use over MEWS or DB.

The following table identifies the connection adapter types for each supported version of SharePoint:

SharePoint Server

Type

Local Object Model (OM)

Connection (Metalogix

Content Matrix Console -

installed on server)

Remote Object Model (OM)

Connection (Metalogix

Extensions Web Service

installed on remote server)

SharePoint Client Side Object

Model (CSOM) Connection

Microsoft Office 365 - -

Microsoft SharePoint

2013 -

Microsoft SharePoint

2016 -

Microsoft SharePoint

2019

* *

-
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SharePoint Server

Type

Local Object Model (OM)

Connection (Metalogix

Content Matrix Console -

installed on server)

Remote Object Model (OM)

Connection (Metalogix

Extensions Web Service

installed on remote server)

SharePoint Client Side Object

Model (CSOM) Connection

Microsoft SharePoint

Server Subscription

Edition

*

-

*  Currently, if Content Matrix is installed in a FIPS-enabled environment, you cannot connect/migrate

to SharePoint 2019.  For SharePoint Server Subscription Edition in a FIPS-enabled environment, you

can only connect using a remote object model connection.  See Errors Connecting to SharePoint

2019 or SharePoint Server Subscription Edition in a FIPS-Enabled Environment for more

information.

 

Connecting to a SharePoint On Premises Site or
Server
The same connection methods and options can be used for a normal connection to SharePoint and a

read-only connection to SharePoint. The below steps can be used for both connection types. The read-

only connection can be used to help users keep their source and target connection separate (and it can

help ensure that users do not accidentally migrate any data to a source connection).

NOTES: 

· When making a secure connection to a SharePoint URL that is configured with TLS, Content Matrix

can use any version of TLS that is compatible with .NET Framework 4.7.2.  The default version of

TLS used by the operating system on the machine from which you are connecting will be used by

Content Matrix.  

· Currently, connections to a SharePoint server cannot be made for SharePoint 2019 in a FIPS-

enabled environment. (See Errors Connecting to SharePoint 2019 or SharePoint Server Subscription

Edition in a FIPs-Enabled Environment for more information.)  

To connect to a SharePoint site or server:

In the Metalogix Content Matrix ribbon, choose Connection > Connect to SharePoint.
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To complete the Connection Options tab:

1. For Address, enter either the URL or IP address of the SharePoint site or server to which you want

to connect.

Note that the drop-down menu displays a list of previous connections.

2. For Target Type, select the connection type.  Use the information in the following table for

guidance.

If you want to connect… Select …

directly to a SharePoint site Site.

to a specific Web application on a

SharePoint server

Web App.

NOTE:  This option can only be used if using the

Local or Metalogix Extensions Web Service

connection type.

to a SharePoint instance at the

Farm/server level 

(which will allow you to see all site

collections for all Web Application on the

selected server)

Farm.

NOTE:  This option can only be used if using the

Local or Metalogix Extensions Web Service

connection type.
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3. Select a Connection Type from the drop-down.  Use the information in the following table for

guidance.

 

If … Select … Notes

you want to have

Metalogix Content

Matrix choose the

connection adapter

type that makes the

most sense for the

target SharePoint

instance

Auto Detect
· If the SharePoint instance is local

(installed on the same machine as the

Metalogix Content Matrix Console), the

Local Connection (SharePoint Object

Model) will be used

· If the SharePoint instance is remote

(installed on another machine), and the

Metalogix Extensions Web Service is

installed, the Remote Connection

(Metalogix SharePoint Extensions

Web Service) type will be used.

Metalogix Content

Matrix Console is

installed locally (that

is, on the same

SharePoint server or

one of its Web Front

Ends (WFEs)

Local Connection

(SharePoint Object

Model)

This connection type 

· is generally recommended for the

target SharePoint instance if possible,

to help with performance and to help

provide the product with greater

leverage into SharePoint.

AND

· the account used for the connection.

must be the logged in user and have

the following permissions:

· Farm Administrator

· Site Collection Administrator

· DB_Owner on the Content

Database (to allow the connecting

user access to the local SharePoint

Object Model).   

NOTE:  Currently, a local connection to a

SharePoint server cannot be made for

SharePoint Server Subscription Edition in a

FIPS-enabled environment. (See Errors

Connecting to SharePoint 2019 or
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If … Select … Notes

SharePoint Server Subscription Edit in a

FIPs-Enabled Environment for more

information.)  

· Metalogix Content

Matrix Console is

not installed

locally

AND

· Metalogix

SharePoint

Extensions Web

Service (MEWS) is

installed on the

SharePoint

server/WFE to

which you are

connecting 

Remote Connection

(Metalogix

SharePoint Extensions

Web Service)

The connecting account requires Full

Control over the content being connected

to and migrated. Additional permissions are

provided through the use of the Metalogix

Extensions Web Service.

NOTE:  Although it is strongly

recommended that the version of the

Metalogix Extensions Web Service

(MEWS) match the installed version of

Content Matrix, you can override it to use

an earlier MEWS version.

NOTE:  As of version 9.5, Content Matrix no longer supports CSOM connections to SharePoint on

premises.  The option will work for backward compatibility with existing jobs, but if you select it

for a new connection, a pop-up warning will display.

4. For Authentication Type, select the method to use when trying to connect to the specified

SharePoint instance. 

Use the information in the following table for guidance.

If … Select …. Notes

you want Metalogix Content

Matrix to automatically

check against the SharePoint

environment 

Auto Detect Metalogix Content Matrix will check

for non-Office 365 authentication

types listed in the drop-down (in order),

and use the first method that is found.
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If … Select …. Notes

you want to connect to the

SharePoint environment

using the currently logged in

Windows user’s credentials

Windows

Authentication

· The logged in user credentials are

used by default; however, other

credentials that use this 

authentication method can also be

entered. 

· This is the authentication type that

most environments use.

· you selected Metalogix

SharePoint Extensions

Web Service as the

Connection Type

AND

· you want to connect

using Forms Based

Authentication

Forms Based

Authentication

· Most setups for Forms Based

Authentication are supported. 

· This method is limited to the

Metalogix SharePoint Extensions

Web Service connection type

because it authenticates through

IIS and not Active Directory (AD).

you want to connect through

a Web browser 

Web Browser

Authentication (Not

Auto Detected)

This option is not searched for within

the “Auto Detect” option, and needs to

be manually set. 

In order for the Metalogix Content

Matrix Console to logon to the system,

users must have logged on to the

system being connected to through the

web browser on that system first (only

before the initial connection). Since

this is all done using the Web browser

for authentication, the credentials

section of the window will be grayed

out (since it is not needed), and it is

limited to the MetalogixSharePoint

Extension Web Services Connection

Type because it authenticates through

IIS and not the Active Directory (AD).

NOTES:  

· Because this connection method

uses cookies from the browser, it

may require multiple logins when

running a single migration.

However, this is only likely if the

migration is running for a long
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If … Select …. Notes

session; this is mainly determined

by the web browser settings for

authentication. In the event that a

login is required, a dialog box

appears that lets users log in. After

the user logs in, the migration will

continue from where it left off.  

· If you are planning to run a job

using a PowerShell script, make

sure the PowerShell console is

closed before you make the

connection using this method. 

Otherwise, an error will occur

when you attempt to run the

PowerShell job.

5. For Connect As, enter/select the login credentials you want to use to connect to the SharePoint

site/server. Use the information in the following table for guidance.

NOTE:  This option is disabled if you selected Local Connection (SharePoint Object Model) or

Web Browser Authentication (Not Auto Detected). 

If you want to … Then …

use the current Windows

user's authentication

credential

Select the (default)  <Domain>\<user> radio button.

use different authentication

credentials
· Select the Different User radio button, and

· Enter the applicable user name and Password. 

In cases where alternate credentials are entered, it is

recommended that you select the Remember my password

check box so Metalogix Content Matrix will automatically

remember that user account password.  This is especially

important if you chose Web Browser Authentication, as

credentials must be stored in the Credential Manager vault

before the connection is made. 

6. If you need to configure proxy settings:

a) Select the Proxy Options tab.

b) Follow the procedure for Configuring Proxy Settings.
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7. If you want to Add or Remove certificates to be included when connecting to SharePoint:

a) Select the Included Certificates tab.

Please see the Connecting with Certificates for more details on connecting to SharePoint

instances that require certificates.

b) After all of the desired connection options have been set, for all options tabs, click [OK] to

establish the connection.

If you selected a connection type other than Site, the Limit Site Collections dialog displays, giving

you the option to limit the site collections to include in your connection (when importing an xml file

with the list of URLs you want to include).  This is useful if the environment you are connecting to

includes a very large number of site collections. In this case, limiting displayed site collections can

improve performance.

NOTE:  If you want to View Sample xml, click the link on the dialog.  The xml file you import must

follow the same format as this sample.

8. Either:

§ Click [Yes – Import from XML] to specify the URLs of the sites you want to include in the

connection, then browse/upload the file

OR

§ Click [No – Continue with Connection] to add all sites within the selected scope to the

connection.
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If Metalogix Content Matrix successfully makes the connection, a new node will appear in the Explorer

View, and you can expand this node and navigate through the SharePoint objects. 

Overriding the Version of the Metalogix Extensions Web
Services (MEWS) When Making a SharePoint Connection

It is strongly recommended that when you select Remote Connection (Metalogix SharePoint

Extensions Web Service) to connect to SharePoint, the version of MEWS is installed on the remote

server is the same as the installed version of Content Matrix Console.  However, when you select

MEWS as the connection type, you will have the option to Override the MEWS Version and specify an

earlier MEWS Version (in the format n.n.n.n) when making a connection. Note that you will receive a

warning message that the installed version of MEWS may be incompatible.

 

You can hide the warning message for any new connections and re-connections made during the

current session by checking the Do not show this message until application restarts box.

IMPORTANT:  You cannot update the MEWS version once the connection has been created. 

If the MEWS version is overridden, the job log will display the warning message.  (If both the source and

target connections use an older version of MEWS, an entry will display for each.)
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Connecting to SharePoint Online

Metalogix Content Matrix Console can make a site level connection to a SharePoint Online

environment.   

To connect to SharePoint Online:

In the Metalogix Content Matrix ribbon, choose Connection > Connect to SharePoint.

Make sure the selected Target Type is Site.

To complete the Connection Options tab:

1. For Address, enter either the URL or IP address of the SharePoint site or tenant to which you want

to connect.

Note that the drop-down menu displays a list of previous connections.

2. For Target Type, select the connection type.  Use the information in the following table for

guidance. 

2. For Target Type, select Site.
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3. For Connection Type, select Remote Connection (SharePoint Client Side Object Model O365).

NOTE:  If you accept the default (Auto Detect), this option will be detected automatically.

 

4. For Authentication Type, select the method to use when trying to connect to the specified

SharePoint instance. When connecting to Office 365, the two main Authentication Types will be

Office 365 OAuth/Standard/ADFS Authentication and Office 365 Web Browser Authentication (Not

Auto Detected).  Use the information in the following table for guidance.

For a  SharePoint Online connection that uses"modern" (not "legacy") authentication, you must select

one of the O365 OAuth Authentication options or Office 365 Web Browser.  If the account is also part

of a SharePoint Online Multi-Factor Authentication Policy, Office 365 Web Browser or O365 OAuth

with MFA Authentication must be used.

For more information about legacy vs. modern authentication, refer to the Microsoft Support article

How modern authentication works for Office 2013 and Office 2016 client apps.)

If … Select …. Notes

you want Metalogix Content

Matrix to automatically

check against the SharePoint

environment 

Auto Detect Metalogix Content Matrix will check

for authentication types listed in the

drop-down (in order), and use the first

method that is found.

NOTE:  At the time you click [OK] to

complete the connection, a pop-up

box will display that asks if you want

to use Office 365 OAuth.  See Using

Office 365 OAuth Authentication to

Connect to SharePoint Online for

details.

· you want to connect to

Office 365 OAuth, Office

365 – Standard editions, or

systems with ADFS

Office 365

OAuth/Standard/ADFS

Authentication*

By default the logged in user

credentials will be unavailable, since

this uses the Windows authentication

https://social.technet.microsoft.com/wiki/contents/articles/36857.sharepoint-online-o365-set-up-multi-factor-authentication.aspx
https://support.office.com/en-us/article/how-modern-authentication-works-for-office-2013-and-office-2016-client-apps-e4c45989-4b1a-462e-a81b-2a13191cf517
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If … Select …. Notes

AND

· MFA is not being used 

method, and the Office 365 credentials

will need to be entered.

NOTE:  At the time you click [OK] to

complete the connection, a pop-up

box will display that asks if you want

to use Office 365 OAuth.  See Using

Office 365 OAuth Authentication to

Connect to SharePoint Online for

details.

your account requires the

use of Multi-Factor

Authentication (MFA)

Office 365 OAuth with

MFA Authentication

(Not Auto Detected)*

With this authentication type,  you do

not have to enter account credentials

in Content Matrix, and the Connect As

options will be disabled. 

you want to connect through

a Web browser 

Web Browser

Authentication (Not

Auto Detected)

This option is not searched for within

the “Auto Detect” option, and needs to

be manually set. 

In order for the Metalogix Content

Matrix Console to logon to the system,

users must have logged on to the

system being connected to through the

web browser on that system first (only

before the initial connection). Since

this is all done using the Web browser

for authentication, the credentials

section of the window will be grayed

out (since it is not needed), and it is

limited to the Metalogix Extensions

Web Service Connection Type because

it authenticates through IIS and not the

Active Directory (AD).

NOTES:  

· Because this connection method

uses cookies from the browser, it

may require multiple logins when

running a single migration.

However, this is only likely if the

migration is running for a long

session; this is mainly determined

by the web browser settings for

authentication. In the event that a

login is required, a dialog box
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If … Select …. Notes

appears that lets users log in. After

the user logs in, the migration will

continue from where it left off.  

· If you are planning to run a job

using a PowerShell script, make

sure the PowerShell console is

closed before you make the

connection using this method. 

Otherwise, an error will occur

when you attempt to run the

PowerShell job.

you want to connect through

a Web browser using

authentication for Office

365

Office 365 Web Browser

Authentication

This option works the same as Web

Browser Authentication (Not Auto

Detected) except:

· it looks for more specific Office 365

cookies

· it requires that users first log into

Office 365 through the browser

· instead of allowing multiple logins,

only one "request" for data can be

made at a time, which ensures that

no data is missed or lost due to the

system locking from too many

requests (but which may result in a

slower connection).

you want to make a site-

level connection to a GCC

High site using O365 User

Provided Authentication

Office 365 User

Provided

Authentication

(hidden by default)

You must first run a utility provided by

Quest Support and enable the setting

EnableUserProvidedAuthentication.

Refer to the Quest Support Knowledge

Base article Enabling User Provided

Authentication in Content Matrix for

details.

* If you are connecting to SharePoint Online using OAuth authentication and you used a custom

domain as the Address, you will also need to check the Override SharePoint Online Tenant

Domain Name and enter the default tenant domain name (which can be found at

https://admin.microsoft.com/Adminportal#/Domains) to allow Content Matrix to route the

request to the proper region.

https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
https://admin.microsoft.com/Adminportal#/Domains
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5. For Connect As, enter/select the login credentials you want to use to connect to the SharePoint

site/server. Use the information in the following table for guidance.

NOTE:  This option is disabled if you selected Office 365 OAuth with MFA Authentication, or Web

Browser Authentication (Not Auto Detected). 

If you want to … Then …

use the current Windows

user's authentication

credential

Select the (default)  <Domain>\<user> radio button.

use different authentication

credentials
· Select the Different User radio button, and

· Enter the applicable user name and Password. 

In cases where alternate credentials are entered, it is

recommended that you select the Remember my password

check box so Metalogix Content Matrix will automatically

remember that user account password.  This is especially

important if you chose Web Browser Authentication, as

credentials must be stored in the Credential Manager vault

before the connection is made. 

6. If you want to Add or Remove certificates to be included when connecting to SharePoint:

a) Select the Included Certificates tab.

Please see the Connecting with Certificates for more details on connecting to SharePoint

instances that require certificates.

b) After all of the desired connection options have been set, for all options tabs, click [OK] to

establish the connection.

If Metalogix Content Matrix successfully makes the connection, a new node will appear in the Explorer

View, and you can expand this node and navigate through the SharePoint objects. 

NOTE:  Should the log file ever show a "could not find site on remote SharePoint server" exception

message when working with CSOM connections, simply restart the CSOM service on all machines

running the Metalogix Content Matrix console and then rerun the action.
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Using Office 365 OAuth Authentication to Connect to
SharePoint Online

Office 365 OAuth Authentication is a token-based authentication method that can be used as an

alternative to Standard/ADFS Authentication to reduce throttling.

If Multi-Factor Authentication is set up for the tenant and enabled for the account (as described in the

Microsoft TechNet article SharePoint Online - O365: Set up Multi-Factor Authentication), you can

connect using Office 365 OAuth with MFA Authentication as an alternative to Office 365 Web

Browser authentication.  

Registering the Metalogix Content Matrix SharePoint Client
Application for OAuth Authentication

The very first time OAuth Authentication is selected, the application Metalogix Content Matrix

SharePoint Client must be registered for the tenant.

IMPORTANT:  Prior to version 9.2, the Metalogix SharePoint Migration Client application was used

for OAuth Authentication. Jobs created before version 9.2 (including those that use PowerShell) will

continue to use this application (as long as it is still registered in Azure Active Directory).  Starting with

version 9.2, all jobs using OAuth Authentication will use the Metalogix Content Matrix SharePoint

Client application.

Required Permissions

At a minimum, the following permissions are required to register and provide consent for the Metalogix

Content Matrix SharePoint Client application. 

· For a site-level connection, the account must have a minimum of Site Administrator and

Application Administrator permission roles.

· For a tenant-level connection, the account must have a minimum of Application Administrator

permission role.

Providing Consent to Grant the Application Requested Permissions

The first time a Content Matrix user attempts to connect to SharePoint Online using Office 365 OAuth

Authentication, a dialog displays requesting that you grant the permissions that the application needs

to perform migrations.

A Global Administrator can check the Consent on behalf of your organization box, which will prevent

this dialog from displaying for other users.  If the account is not a Global Administrator, the Consent on

behalf of your organization option will be hidden.

IMPORTANT:  If a Global Administrator does not consent on behalf of the organization,  each

Content Matrix user who attempts to connect using Office 365 OAuth Authentication for the first

time must sign in with an account that has the Application Administrator and SharePoint

Administrator permission role.

https://social.technet.microsoft.com/wiki/contents/articles/36857.sharepoint-online-o365-set-up-multi-factor-authentication.aspx
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After [Accept] is clicked, the connection is created (and the application will be registered if it does not

already exist in Azure Active Directory).  In addition, the token cache file ConnectionsTokenCache.dat

is created in the AppData/Roaming/Metalogix folder.  (Note, if you have used OAuth Authentication in

an earlier version of Content Matrix, this file will already exist.)

Completing a Connection to SharePoint Online Using Office 365
OAuth Authentication

When you select one of the Office 365 OAuth authentication types, before making a connection to

SharePoint Online, a pop-up specific to the authentication type will display, as described in the

following table.

NOTE:  If you click the Do not show the message again. box, Content Matrix will continue to use the

selected option and no longer display the pop-up.  You can resume having the pop-up display by

clicking Reset Configuration Options on the ribbon toolbar Settings tab. 
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If you selected... Then ...

Auto Detect or Office365

OAuth/Standard/ADFS Authentication 

the pop-up will prompt you to use the Office 365

OAuth option.  

Choose either [Yes - Use OAuth] or [No - Use Office

365 Standard/ADFS].

Office 365 OAuth with MFA Authentication

(Not Auto Detected)

the pop-up will describe this authentication type.

Signing into your O365 Account to Use Office 365 OAuth
Authentication

When prompted to sign into your O365 account, for Auto Detect or Office365 OAuth/Standard/ADFS

Authentication, you must use the account you specified as the Connect As account in Content Matrix.

 The connection will fail if you try to sign in with another account. (This is not an issue with Office 365

OAuth with MFA Authentication, which does not use a Connect As account.)
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IMPORTANT:  If you are using OAuth Authentication for the first time, a dialog  may display

requesting that you consent to granting permissions that the application needs to perform migrations.

 To  provide this consent, the account must be an Application Administrator.  (This dialog will not

display if a Global Administrator has granted consent on behalf of the organization.)

Connecting with Certificates

 Metalogix Content Matrix  can use client certificates to authenticate connections to eRoom servers

secured with X.509 Certificates. This type of authentication can be used for RSA authentication

implementations that support X.509 Certificates.

When connecting to SharePoint, there are two options that can be used to add certificates to the list of

included certificates: Add Installed Certificate and Add Certificate From File. 

SharePoint connections do not actually save the certificate information directly, but instead they save

the data on how to locate the certificates that are in use. This means that if the certificates are deleted
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or moved from the referenced location, they will no longer be used with the SharePoint connection

and will have to be manually re-added.

SharePoint Certificates are also supported when generating a PowerShell script. It is still recommended

that the initial SharePoint connection is first configured in the Metalogix Content Matrix Console. The

recommended process when working with certificates and PowerShell is to first add the connection

(with certificates) in Metalogix Content Matrix, then set up a migration action in the UI and generate a

PowerShell script. This will allow you to get the connection format that is required to create a

connection in PowerShell, and it can then be written out manually (if desired).

It should also be noted that the Web Browser Authentication type does not automatically detect

certificates. In order for certificates to be included with this method, they must first be installed in the

appropriate locations in order for a web browser itself to access them.

NOTE:   In some cases, including certificates can potentially result in receiving "maximum request

length" messages when migrating smaller files because the certificate information is included when

the data is being migrated.  

To Add Installed Certificates:

Only "Personal" certificates can be added in this manner because it is the only store that web browsers

use to find certificates when accessing a website.

1. In the SharePoint Logon dialog, select the Include Certificates tab.

2. Click [Add Installed Certificate].

The Add Installed Certificates dialog displays all of the certificates that are installed in the logged

in user account's "Personal" certificate store. 

3. Select any certificates that should be included, and click [OK].
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When you return to the SharePoint Logon dialog the selected certificates be displayed in the Included

Certificates list, and they will be included whenever Metalogix Content Matrix is running an action to or

from the SharePoint connection.

To Add a Certificate from a file:

1. In the SharePoint Logon dialog, select the Include Certificates tab.

2. Click [Add Certificate From File].

3. Either:

§ enter a filename and location into the Certificate File text box

OR

§ select the Browse button to open a file explorer dialog and navigate to, and select, the desired

certificate. 

4. If a password is required to use with the certificate, enter it in the Password (optional) text box. 

NOTE: When a connection to SharePoint is made, Metalogix Content Matrix will save the password

field for any certificates so it can re-establish a connection to that SharePoint instance at a later

date. If you are not comfortable with entering the password in the Password (optional) field, you

can move the certificate into the user account's "Personal" folder, and use the Add Installed

Certificate option instead, provided the user account/password is the same.

When you return to the SharePoint Logon dialog, the selected certificate will display in the Included

Certificates list, and it will be included whenever Metalogix Content Matrix is running an action to or

from the SharePoint connection.

Important Note About Self-Signed Certificates

For security purposes, Content Matrix always attempts to validate a certificate when connecting to a

TLS/SSL site.  Content Matrix cannot validate a self-signed certificate for an on-premises connection

however, and if it attempts to do so you will be unable to complete the connection.  To avoid this

issue, you must change the value of the key BypassCertificateValidation in the

EnvironmentSettings.xml file to True.

Removing Certificates

Any certificates that have previously been added through the two Add Certificates options can also be

removed from the list of Included Certificates. 

To remove a certificate:

1. In the SharePoint Logon dialog, select the Include Certificates tab.

2. Select the certificate(s) that you want to remove.
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3. Click [Remove].

Connecting to SharePoint Using PowerShell

You can create and edit connections to SharePoint using PowerShell.  These connections will display in

the Content Matrix Console.

To access the PowerShell cmdlets for connecting to SharePoint:

Open a PowerShell or PowerShell ISE session and add the PowerShell snap-ins for the application

framework.

The following cmdlets are now available:

· Get-MLSharePointConnections

· New-MLSharePointConnection

· Set-MLSharePointConnection

· Remove-MLSharePointConnection

To retrieve information about active connections in the Console:

Select (from the PowerShell ISE Command Window) or enter Get-MLSharePointConnections, then run
the cmdlet.

Details display for each active connection.

To create a new connection to SharePoint:

1. Select (from the PowerShell ISE Command Window) or enter New-MLSharePointConnection.

2. Select or enter the applicable parameters.  Use the information in the following table for guidance.

Parameter Notes

Address

(Required)

The Url of the SharePoint object (Site, Farm, WebApp or Tenant) you

want to connect to.

AuthenticationType

(Required)

Valid values are:

· Windows

· FormsBased

· Adfs
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Parameter Notes

NOTE:  Currently this cmdlet does not support connecting to

SharePoint Online with OAuth authentication.

· UserProvided

NOTE:  UserProvided authentication is used to make site-level

connections to special types of tenants, such as GCC High.  To use

this type of authentication, you must first run a utility provided by

Quest Support and enable the setting 

EnableUserProvidedAuthentication. Refer to the Quest Support

Knowledge Base article Enabling User Provided Authentication in

Content Matrix for details.

ConnectionType

(Required)

Valid values are: 

· Om (local object model)

· MEWS (remote connection using Metalogix Extension Web Service)

· CSOM (for SharePoint Online targets only)

TargetType

(Required)

Valid values are:

· Site

· WebApp

· Farm

ConnectAsCurrentUser Use this parameter if you want to make a SharePoint on-premises

connection using the currently logged-in user.

NOTE:  This parameter is not necessary when using an OM

connection, which automatically connects as the currently logged-in

user.

MewsVersion This parameter is only necessary if you want to use an older version

of the Metalogix Extension Web Service.

Password The password of the account making the connection.

RememberPassword This option is recommended to to ensure that the connection

remains active after the PowerShell session has ended.  If it is not

used, the password will have to be re-entered.

Readonly Use this parameter if you want to make a read-only connection to a

SharePoint source.

https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
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Parameter Notes

SkipConnectionCheck Use this parameter if you want to skip validation of the connection.

This is useful if you use a  connections factory and speeds up the

creation of connections.

User The user account making the connection.

3. Run the cmdlet.

Example Scripts:

New-MLSharePointConnection -Address http://win-pvf4cd21m55/ -
AuthenticationType Windows -ConnectionType MEWS -TargetType Site -Password
"Pass" -User Administrator -RememberPassword

New-MLSharePointConnection -Address https://metalogixsoftware-
admin.sharepoint.com -AuthenticationType Adfs -ConnectionType Csom -
TargetType Tenant -Password "Pass" -RememberPassword -User

cpqauser@metalogixsoftware.onmicrosoft.com 

To edit a connection to SharePoint:

1. Select (from the PowerShell ISE Command Window) or enter Set-MLSharePointConnection.

2. Enter the ConnectionId.

NOTE:  You can obtain the ConnectionId by running the Get-MLSharePointConnections cmdlet.

You can now update any of the following parameters, then run the cmdlet:

· ConnectAsCurrentUser (on premises connections only)

· Password

· RememberPassword

· SkipConnectionCheck

NOTE:  Use this parameter if you want to skip validation of the connection. This is useful if you use

a  connections factory and speeds up the creation of connections.

· User

Example Script:

Set-MLSharePointConnection -ConnectionId '91335f9c-9311-439e-9b8e-
78d6f7ef480a' -Password pass -RememberPassword -User Administrator

To remove a SharePoint connection:

1. Select (from the PowerShell ISE Command Window) or enter Remove-MLSharePointConnection.

2. Enter the ConnectionId.
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NOTE:  You can obtain the ConnectionId by running the Get-MLSharePointConnections cmdlet.

You can remove multiple connections using the PowerShell pipeline variable.

3. Run the cmdlet.

Example Scripts:

Remove-MLSharePointConnection -ConnectionID '2F91B056-C300-4263-9FA6-
17EEDF583594'

Remove multiple connections using the PowerShell pipeline variable:

Remove-MLSharePointConnection -ConnectionID '2F91B056-C300-4263-9FA6-
17EEDF583594 ,'2F91B056-C300-4263-9FA6-17EEDF583594','2F91B056-C300-4263-
9FA6-17EEDF583594' | Remove-MLSharePointConnection
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Preparing for Your Migration

7

Metalogix Content Matrix offers a number of tools to help you locate and organize data and in

preparation for your  migration.  You can: 

· Perform a pre-migration check to identify any potential migration issues 

· Create reports to identify whether nested eRoom content can be supported in a migration to

SharePoint

· Create SharePoint objects

· Delete SharePoint objects

Showing and Hiding Template Rooms

You can migrate eRoom template rooms into SharePoint in the same way you migrate standard eRoom

rooms.

These templates are created in eRoom using the Use this eRoom as a template option, in the

"Template" options for a selected eRoom. 

This option effectively changes the eRoom room into a template. By default, Metalogix Content Matrix

will display these templates However, because these templates are slightly different from standard

rooms, they can be hidden in Explorer View if you do not want to display them.

To show/hide template rooms:

1. In Explorer View, select the eRoom root connection.

2. Right-click and choose the applicable option:

§ Hide Template Rooms

OR
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§ Show Template Rooms

Any eRoom template rooms that are displayed can be migrated in the same way as any other eRoom

rooms. 

Performing a Pre-Migration Check

You can use Metalogix Content Matrix to perform a check on eRoom content and reports back any

potential migration issues. This includes URL length, file type, and size restrictions.

Each item in eRoom is identified by a URL with its own item ID value. This means that eRoom URL

length is not affected by its location within the structure, resulting in eRoom being able to have very

deep nested structures. In contrast to this, SharePoint URLs are based on site structure, with a

maximum URL length. In SharePoint the maximum URL length that can be entered in the User Interface

(UI) for a site is 255 characters, while folder and document items (in a document library) have a

maximum URL length of 128 characters.

This creates a situation where invalid URLs can be created when migrating deeply nested eRoom

structure to an equivalent SharePoint structure. The Pre-Migration Check feature is designed to help

find and identify these types of potential issues. While this feature is checking for any URL length

issues, it also checks to see if there are any file types or file sizes that could also cause issues, as well as

checking for illegal characters. 

These Pre-Migration Check functions are also available using PowerShell.

NOTE:  The Pre-Migration Check can only be run on eRoom facilities, rooms, and folders.

To run a Pre-Migration Check:

1. In Explorer View, select the eRoom container node for which you want to run a pre-migration

check.

2. Right-click and choose Run Pre-Migration Check to display the Pre-migration Options dialog.

3. Complete the appropriate fields on the General tab:  
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a) If you want to save a CSV file containing the results of the pre-migration check to a specified

location:

§ Make sure the Save pre-migration check outputs to the following folder is checked.

§ Enter or navigate to the file path to which you want to save the file.

By default, this location is the Application Data folder: "<Drive

>\Users\<USER>\AppData\Roaming\Metalogix\Metalogix Content Matrix Console -

eRoom Edition\."

NOTE:  If no issues are found, the Excel files will only contain the column name data, and no

actual entries. If any results already exist in the specified location, they will be overwritten.

b) Navigate to and select the target SharePoint Location against which the pre-migration check

will be run.

NOTE:  When you select a Location, a link to the SharePoint site or list displays to the right side

of the Location: header.  You can click this link to open the page in a new browser window.

c) Select the applicable Pre-Migration Checks.  Use the information in the following table for

guidance.

If ... Then ...

you want to prevent the pre-migration check

from running any checks on URL length.

select Do not check URL length.

· the Location you selected is a SharePoint

site (not list)

AND

select Check URL length when pasting as a

site.
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If ... Then ...

· you want a check to be run against the

URL

NOTE:  When this option is selected, a Site

URL Results Excel file will be saved to the

specified location.

· the Location you selected is a SharePoint

site (not list)

AND

· you want a check to be run against the

URL if a list or library copy is being

performed

select Check URL length when pasting as a

document library or folder.

NOTE:  When this option is selected, a

Document URL Results Excel file will be

saved to the specified location.

you want  to report on any files that are larger

than SharePoint site's maximum file size 

check the Check document size does not

exceed maximum file size box.

NOTE:  When this option is selected, a Size

Results Excel file will be saved to the

specified location.

you want to check the names of all content

within the eRoom container for characters

that may be illegal in SharePoint

check the Check name for illegal

SharePoint characters box.

NOTE:  When this option is selected, a

Name Results Excel file will be saved to

the specified location.

you want to check the eRoom container for

any type of eRoom content that is not

supported in SharePoint (which includes

eRoom inboxes, dashboards, and project

schedule database processes)

check the Check for unsupported eRoom

content types box.

NOTE:  When this option is selected, an

Unsupported Results Excel file will be

saved to the specified location.

4. Switch to the Content Options tab.

5. Make sure the types of of eRoom content you want to include. Enable the check-box beside any
eRoom item types that you want to include in the pre-migration check. For example, if you want to
include eRoom databases but not eRoom polls, enable Include databases check-box and deselect
the Include polls check-box.
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Using Nested Content Reports

Metalogix Content Matrix has an eRoom-specific feature that performs Nested Content Reports on

eRoom content. The nested contents report identifies eRoom content that is nested in a way that may

not be supported in a migration to SharePoint. 

Metalogix Content Matrix can use a generated nested contents report (saved as a CSV file) to identify

how to paste eRoom rooms as SharePoint Site Collections.

NOTE: By default, Nested Content Report options are disabled. 

These Nested Content Report functions are also available using PowerShell.

To enable Nested Content Report options:

1. Close Metalogix Content Matrix if it is not already closed. 

2. Navigate to ApplicationSettings.xml and open the file in a text editor. 

By default, this file is located in the directory: C:\Users\[User name]

\AppData\Roaming\Metalogix\Metalogix Content Matrix Console - eRoom Edition.

3. Navigate to the EnableNestedContentsReportActions entry and change its value to True. 

4. Save and close ApplicationSettings.xml and reopen Metalogix Content Matrix. 
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Report Contents

A Nested Content Report contains the following information:

· The facility ID 

· The room ID 

· Each root item's ID 

· Each root item's name 

· Each root item's type 

· Whether or not each root item has nested content 

If debugging is enabled, the report will contain additional information. To enable debugging, open the

ApplicationSettings.xml file and insert the following XML:

<XmlableEntry>
    <Key>EnableDebug</Key>
    <Value>True</Value>
</XmlableEntry>

The additional debugging information includes:

· The room ID 

· The root item 

· Each item's name 

· Each item's URL 

· Whether or not each item is nested content 

Running a Nested Content Report

If Nested Content Reporting is enabled, you can run two types of reports:

· the "standard" Nested Contents Report identifies eRoom content that is nested in a way that may

not be supported in a migration to SharePoint. For example, consider a four-level nesting of folders

and databases - a top-level folder with a database child, which itself has a folder child, and so on.

Because such a structure may not be supported in a SharePoint migration, the report would flag

these items.

NOTE:  Standard Nested Contents Reports can be run on eRoom root nodes, facilities, and rooms.

It is recommended to run the report on the lowest-level item possible; the report may be very

time-consuming if run on high-level nodes with large numbers of nested items. In addition, a nested

contents report of a room item can be used to migrate that room into SharePoint as a Site

Collection. For more information

· the Nested Contents URL Length Report identifies issues that may arise when migrating deeply

nested eRoom content with URLs that may exceed SharePoint's maximum URL length.

NOTE:  Nested Contents URL Length Reports can only be run on eRoom facilities and rooms. 
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These reports can also be run through PowerShell. 

To run a Nested Contents Report:

1. In Explorer View, select the eRoom root node, facility, or room for which you want to find nested

content URL lengths.

2. Right-click and choose Reporting > Nested Contents URL Length Report to display the Report

Options dialog.

3. Enter a Report Name, which will be used as the output CSV file name.

4. For Output Folder, enter or select the file path of the directory in which the report will be saved.

5. If you want to Overwrite existing report in the target file path, check this box.

Now you can Run the report immediately or Save and run it at a later time from the Job List.

When the action starts, a Job log will be created. The logs can be viewed (in progress or after the

action is finished) by clicking [Details>>]. After the action has completed a note will be displayed in the

bottom left corner of the dialog stating the number of completions, as well as any warnings or errors

that may have been encountered (if there were any). 

Once the action is complete, the CSV file will be available from the specified Output Folder.

To run a Nested Contents URL Length Report:

1. In Explorer View, select the eRoom root node, facility, or room for which you want to find nested

content.

2. Right-click and choose Reporting > Nested Contents Report to display the Report Options dialog.

3. For Site URL, enter a valid site collection URL. 

4. Enter a Report Name, which will be used as the output CSV file name.
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5. For Output Folder, enter or select the file path of the directory in which the report will be saved.

6. If you want to Overwrite existing report in the target file path, check this box.

Now you can Run the report immediately or Save and run it at a later time from the Job List.

When the action starts, a Job log will be created. The logs can be viewed (in progress or after the

action is finished) by clicking [Details>>]. After the action has completed a note will be displayed in the

bottom left corner of the dialog stating the number of completions, as well as any warnings or errors

that may have been encountered (if there were any). 

Once the action is complete, the CSV file will be available from the specified Output Folder.

Creating a SharePoint Object

You can create new SharePoint site collections, sites, folders, and lists via the Metalogix Content

Matrix Console.

Creating a SharePoint Site

You can create a new SharePoint site via Metalogix Content Matrix under an existing site collection or

site except for Database connections and the new site can use any site template that is installed on the

SharePoint environment.

To create a new SharePoint site:

1. In the Explorer View, select the site collection or site under which you want to create the new site.

2. Right-click and choose Create Site.

The Create Site dialog displays, prompting you to enter the Site Title, Site URL Name, Description,

and Template for the new site.

NOTE:  For Site URL Name, it is only necessary to enter the name of the site as you want it to

appear in the URL, not the entire URL path.
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Note that if you are migrating to SharePoint Online or SharePoint 2019, the default template is

(modern) Team Site (no Office 365 group).  For SharePoint Online, Content Matrix does not

support connections to tenant-level groups.

3. When you have completed the fields on the Create Site dialog, click [OK].

The new site will now display in Explorer View.

Create SharePoint Site Collection

 You can create a new site collections on a target SharePoint environment for any SharePoint

connection type, except for database and site connections.

To create a new SharePoint site collection:

1. In the Explorer View navigate to the SharePoint Farm/ Web Application (on premises) or Tenant

(SharePoint Online) where the new site collection should be created.

2. Right-click and choose Create Site Collection.

3. Complete the fields on the Create Site Collection dialog for the selected Mode as you would if you

were creating a site collection from within SharePoint.

NOTE:  In addition, you have the option to create a host named site collection using the Host

Header option.  Refer to the Microsoft TechNet article details about host-named site collections. 

https://social.msdn.microsoft.com/Forums/office/en-US/d549a367-ae78-4ed2-ab0e-826bfb94500f/sharepoint-hosted-apps-on-host-header-based-web-applications-vs-web-application-without-host-header?forum=appsforsharepoint
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Note that if you are migrating to SharePoint Online or SharePoint 2019, the default template is

(modern) Team Site (no Office 365 group) (STS#3). For SharePoint Online, Content Matrix does

not support connections to tenant-level groups. 

4. After completing the dialog, click [OK].

The new site collection now displays in the Explorer View.

Create a SharePoint List

You can create a new SharePoint list via Metalogix Content Matrix under an existing site as long as:

· the connection type is not read-only, and 

· the new list can use any site template that is installed on the SharePoint environment. 

 If site creation is not valid for the connection type, the option will be disabled.

To create a new list:

1. Navigate to the SharePoint Site where the list/library should be created.

2. Right-click and choose Create List.
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3. Complete the Create List dialog as you would if you were creating a list from within SharePoint.

4. After completing the dialog, click [OK].

The new site collection now displays in Explorer View.

Create SharePoint Folder

You can create a new SharePoint list via Metalogix Content Matrix under an existing list or library (or

within an existing folder) as long as the connection type is not read-only..  If folder creation is not valid

for the connection type, the option will be disabled.

To create a new SharePoint folder:

1. Navigate to the SharePoint Document Library, List, or Document Folder under which the new folder

should be created.

2. Right-click and choose Create Folder.
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3. Complete the Create Folder dialog.   

Note that the Folder Type drop down allows you to select the content type with which to create

the folder. if only one content type exists on that list/library/folder, the option will be grayed out.

There is also a check-box option to overwrite any existing folder that uses the same folder name at

the level the folder is being added.

4. After completing the dialog, click [OK].

The new folder now displays in Explorer View.

Deleting SharePoint Objects

You can delete one or more SharePoint objects via Content Matrix as long as the connection type is

not read-only. SharePoint objects that can be deleted via Content Matrix are:

· SharePoint Sites

· SharePoint Lists

· SharePoint Document Folders
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· SharePoint Documents

· SharePoint List Items

If the action is not valid for the connection type, it will be disabled.

NOTE:  Document versions and list item versions cannot be deleted via Content Matrix.

To delete one or more SharePoint Objects:

WARNING: When this action is used at the site level or below, the object will be deleted permanently

(i.e., it will not be sent to the Recycle Bin).  However, a pop-up dialog will display that allows you to

cancel the action.

1. Select the SharePoint object(s) to be deleted. 

NOTE:  Depending on the type of object, this may be in the Explorer View or in the Items View.

2. Either:

§ Press the Delete key on the keyboard.

§ Right-click on the object and choose Delete [Object].

You will be prompted to confirm the action before continuing.

Mapping Links for Link Correction

Metalogix Content Matrix can correct eRoom Link objects that are migrated as items in a SharePoint

Links list. If these links  point to an internal location they will be corrected to the new target location as

part of a migration. Metalogix Content Matrix can also correct links in column data within document

libraries and lists.

When content is migrated from eRoom to SharePoint, Metalogix Content Matrix will create a

SharePoint list called MigrationSourceURLs, with a column called MigrationSourceURL, and will place
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the URL for that eRoom container into this field. The MigrationSourceURLs list will store the source

URL data for the eRoom containers that are migrated, and the MigrationSourceURL column will hold

the actual URL value. A TargetURL column will also be added to the list, for the migration target URL.

This way, users can see the source and target URLs for the eRoom links.
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Initiating a Migration

8

From the Metalogix Content Matrix Explorer View, you can "copy" an object from the source

connection then "paste" it to the appropriate location on the target connection.  You will then be

prompted to configure Copy Options.

  

Migrating an eRoom Container as a SharePoint
Document Library

For eRoom deployments that almost exclusively contain documents, the logical SharePoint equivalent

is to migrate them as a SharePoint Document Library. While Document Libraries cannot contain other

sites or list types, they are the simplest user construct for document management

NOTE:  For deployments that contain all types of content (documents, calendars, discussion lists, and

databases), other migration options are available.

To initiate an "eRoom as a SharePoint Document Library"
migration:

1. In Explorer View, navigate to the eRoom or eRoom folder you want to migrate.

2. Right-click and choose the Copy eRoom Container.

3. Select the SharePoint site under which you want to create the Document Library.

4. Right-click and choose Paste eRoom Container > As Document Library.

5. Continue with Configuring Copying Options.

Migrating an eRoom as a SharePoint Site
Collection

For eRoom deployments that contain all types of content (documents, calendars, discussion lists, and

databases), you can migrate facilities, rooms, and folders as SharePoint site collections.

NOTE:  For deployments that contain all types of content (documents, calendars, discussion lists, and

databases), almost exclusively contain documents, the logical SharePoint equivalent is to migrate

them as a Document Library.
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When migrating to SharePoint Site Collections on a SharePoint 2013 or later target,

only a Local Object Model (Local OM) connection can be used. This is due to some

User authentication changes that have been made in beginning with SharePoint 2013,

which inadvertently restrict the creation of Site Collections using the SharePoint OM

remotely (i.e. the Remote Extensions Web Service connection). While these changes

affect Remote OM connections, they do not affect Local OM connections.  For more

information on this specific issue, please see the SharePoint Site Collection Creation

Issues in the Frequently Asked Questions section. 

To initiate an "eRoom as a SharePoint site collection" migration:

1. In Explorer View, navigate to the eRoom or eRoom folder you want to migrate.

2. Right-click and choose the Copy eRoom Container.

3. Select the SharePoint server connection under which you want to create the new site collection.

4. Right-click and choose Paste eRoom Container > As Site Collection.

5. Continue with Configuring Copying Options.

Migrating an eRoom as a SharePoint Site

For eRoom deployments that contain all types of content (documents, calendars, discussion lists, and

databases), you can migrate facilities, rooms, and folders as SharePoint sites.

NOTE:  For deployments that contain all types of content (documents, calendars, discussion lists, and

databases), almost exclusively contain documents, the logical SharePoint equivalent is to migrate

them as a Document Library.

To initiate a migration of an eRoom as a SharePoint site migration:

1. In Explorer View, navigate to the eRoom or eRoom folder you want to migrate.

2. Right-click and choose the Copy eRoom Container.

3. Select the SharePoint site under which you want to create the new child  site.

4. Right-click and choose Paste eRoom Container > As Site.

5. Continue with Configuring Copying Options.
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Migrating All eRoom Items into an Existing
SharePoint Site

In some cases, you may want to migrate all of the content from an eRoom container into SharePoint

without creating a new site in the process, or without having to copy each type of eRoom content

separately. For these types of scenarios you would use the Paste eRoom Container Special > All Items

option. This option will paste all the contents of the eRoom container into the root of an existing

SharePoint site.

Depending on the selected options, all nested content will also be migrated as SharePoint lists. These

lists will be created directly beneath the selected SharePoint target location, regardless of whether the

eRoom container was the top level container or not. If an eRoom container other than a folder

contains attachments, then a SharePoint site using the Blank Site template, with a Document Library to

hold the attachments, will also be created.

To initiate the migration of all eRoom items into an existing
SharePoint list:

1. In Explorer View, select the eRoom or eRoom folder to be migrated.

2. Right-click and choose Copy eRoom Container.

3. Select the target SharePoint parent site.

4. Right-click and choose Paste eRoom Container Special > All Items 

5. Continue with Configuring Copying Options.

Migrating eRoom Content into an Existing
SharePoint List

Metalogix Content Matrix can migrate individual eRoom items as SharePoint content. The types of

eRoom items that can be migrated individually are:

· Documents 

· Calendar events 

· Database entries 

· Discussion topics 

To initiate an "eRoom items into an existing SharePoint list"
migration:

1. In Explorer View, select the eRoom container containing the item(s) to be migrated.

2. Switch to Items View.



77
Initiating a Migration

Metalogix® Content Matrix eRoom Edition

3. Select the item(s) that you want to copy.

4. Right click and choose Copy [Item(s)].

Note that the name of the option depends on the item type being copied; for example, Copy

Document, Copy Calendar Event, etc

5. Select the target SharePoint list or library.

6. Right-click and choose Paste [Item(s)].

7. Continue with Configuring Copying Options.

Migrating an eRoom Discussion Board, Note, or
Inbox

Metalogix Content Matrix - eRoom Edition can migrate discussions, notes, and inboxes into SharePoint

as discussion boards. 

NOTE:  Option settings for these migration types only apply to top level items and not to nested

contents.

eRoom discussions and notes can be migrated incrementally, but inboxes cannot. 

Special Considerations When Migrating Eroom Notes

eRoom notes are a special case in Metalogix Content Matrix, because the eRoom and SharePoint

handling of these objects are slightly different. In eRoom, notes live independently within eRoom

containers of any type, and not in a specific list. SharePoint notes must be contained in Discussion

Boards. For this reason, eRoom Edition handles these objects differently than other eRoom list types.

There are a few cases to consider.

· If a single eRoom note item is copied and migrated into a SharePoint site (this is the only target

that will work for a copy of this level), Metalogix Content Matrix will migrate it as a Discussion list,

and will copy the note into the discussion list.

· In the event that an entire eRoom containing notes is migrated, the resulting SharePoint site will

automatically have a Notes list created, at the appropriate place(s) in the hierarchy. The individual

notes in the source eRoom container will be placed in these auto-generated lists.

To initiate the migration of one or more eRoom discussions,
notes, or inboxes into a SharePoint Discussion Board:

NOTE:  If you want to migrate selected discussion topics into an existing SharePoint Discussion Board,

use the procedure for Migrating eRoom Content into an Existing SharePoint List.

1. In Explorer View select the eRoom discussion board(s), note(s), inbox(es), or individual mail item(s)

to be migrated.
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2. Right-click and choose the appropriate option.  Use the information in the following table for
guidance.

If you want to migrate ... Then ...

eRoom discussion board(s) choose Copy eRoom Discussion.

eRoom note(s) choose Copy eRoom Notes.

eRoom inbox(es) choose Copy eRoom Inbox.

individual eRoom mail items choose Copy eRoom Mail.

3. Select the SharePoint target location.

NOTE:  For eRoom discussion boards and inboxes, the target may be either a SharePoint site or an

existing SharePoint Discussion Board.  For eRoom notes, only a SharePoint site can be selected as

the target.

4. Right-click and choose the appropriate option.  Use the information in the following table for
guidance.

If you want to ... Then ...

migrate the eRoom discussion board(s) into a

SharePoint site 

choose Paste eRoom Discussion.

migrate all eRoom discussion topics into an

existing SharePoint Discussion Board

choose Paste eRoom Discussion Special > All

Discussion Topics.

migrate the eRoom notes into a SharePoint site choose Paste eRoom Notes.

migrate the eRoom inbox(es) into a SharePoint

site 

choose Paste 

migrate all eRoom mail items into an existing

SharePoint Discussion Board

choose Paste eRoom Inbox Special > All Mail

Items.

migrate individual mail items into an existing

SharePoint Discussion Board

choose Paste eRoom Mail.

5. Continue with Configuring Copying Options.
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Migrating an eRoom Poll as a SharePoint Survey

Metalogix Content Matrix - eRoom Edition can migrate eRoom polls into SharePoint as surveys.

To migrate an eRoom poll as a SharePoint Survey:

1. In Explorer View, select the eRoom poll to be migrated.

2. Right-click and choose the Copy eRoom Poll.

3. Select the target SharePoint parent site.

4. Right-click and choose Paste eRoom Poll. 

5. Continue with Configuring Copying Options.

Migrating an eRoom Database to SharePoint

An eRoom database can be migrated to SharePoint as a new list or Discussion Board.  eRoom database

entries can also be migrated into an existing SharePoint list.

Before migrating an eRoom Database:

Please refer to the topic Configuration Considerations when Migrating an eRoom Database to

SharePoint.

To initiate an "eRoom Database to SharePoint" migration:

1. In Explorer View, select the eRoom database you want to migrate.

2. Right-click and choose Copy eRoom Database.

3. Select either:

§ the SharePoint site under which you want to create a new list or Discussion Board for the

migrated content

OR

§ the existing SharePoint list into which you want to migrate content.

4. Use the information in the table below to determine the appropriate Paste action to choose.

If you  ... Then ...
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selected a SharePoint site under which you

want to create a "generic" list

choose Paste eRoom Database.

selected a SharePoint site under which you

want to create a Discussion Board

choose Paste eRoom Database Special > As

Discussion Board.

selected an existing SharePoint list into which

you want to migrate the eRoom database

choose Paste eRoom Database Special > All

Entries.

5. Continue with Configuring Copying Options.

Configuration Considerations when Migrating an eRoom
Database to SharePoint

 Before you migrate an eRoom database, you may need to update the Metalogix Content Matrix

Application Settings.xml file to account for:

· columns containing numbers and special characters

· when migrating as a Discussion Board, the format of the discussion column, and/or

· the formatting of database Change Logs.

To open the ApplicationSettings.xml file:

1. Close Metalogix Content Matrix, if it is not already closed.

2. Navigate to ApplicationSettings.xml and open the file in a text editor. By default, this file is

located in the following directory: [Drive]:\Users\[User name]\Application

Data\Metalogix\Metalogix Content Matrix Console - [Product name] Edition.

Migrating Columns Containing Numbers and Special Characters

When migrating source data that contains Number-type columns with both numeric and non-numeric

characters, or with unsupported formatting, additional steps must be taken to preserve the formatting

of the columns. By default, certain characters are stripped when migrating, which may cause the

following unintended scenarios:

· For numeric data with leading zeroes, those zeroes stripped. This may affect data such as zip

codes, which can correctly begin with '0'.

· For numeric data containing non-numeric characters (with the exception of a single decimal point),

those characters stripped. For example, "7.2.0" will be migrated as "720", "+91 123-456-789" will

be migrated as "91123456789", and so on. This may affect data such as telephone numbers, which

can correctly begin with "+1" or "+91", or correctly contain hyphens, for example.

To migrate numeric data while preserving formatting, the ConvertNumericFieldsToText flag in

the ApplicationSettings.xml file must be updated. The flag preserves formatting by searching for

column Titles that contain specified strings, and then migrating their associated Number-type columns
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as Single Line of Text-type columns. The default column title values are as follows: Tel, Telephone,

Phone, Postal, and Zip. To modify this flag's values, do the following:

In the ApplicationSettings.xml file, navigate to the ConvertNumericFieldsToText entry and add

or remove values as desired. 

Values must be separated by a comma (','). The default code block is shown below:

<XmlableEntry>

<Key>ConvertNumericFieldsToText</Key>

<Value>Postal, Telephone, Phone, Tel, Zip</Value>

</XmlableEntry> 

Once ApplicationSettings.xml is saved, all future database migration actions will not strip non-numeric

characters from Number-type columns with any of the specified values as a Title.

Text Format When Migrating as a Discussion Board

When an eRoom Database is migrated into SharePoint as a Discussion Board, the discussion column

will be migrated as a Rich text column instead of an HTML text column by default. To migrate the

discussion column as an HTML text column, do the following: 

In the ApplicationSettings.xml file, navigate to the MigrateDiscussionColumnAsRichText entry,

and change its value from True to False. 

Note that this entry will not be available until at least one eRoom Discussion Board has been migrated. 

Once ApplicationSettings.xml is saved, all databases migrated as SharePoint Discussion Boards will

now use an HTML text column instead of a Rich text column. 

Changing the Formatting of eRoom Database Change Logs

By default, eRoom Change Logs are migrated as rich text entries. This preserves the change log table's

structure, as well as any applied HTML formatting.

In the ApplicationSettings.xml file, navigate to the EnablePlainTextHistory entry and change its

value to True.

Once ApplicationSettings.xml is saved, all Database Change Logs will be migrated as plain text.

Migrating Links

eRoom links are a special case of list migration because the eRoom and SharePoint handling of these

objects is slightly different. In eRoom, links are stored independently within eRoom containers of any

type, and not in a specific list. Conversely, in SharePoint, links must be contained in Links lists. For this
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reason, Metalogix Content Matrix handles these objects differently than other eRoom list types. There

are a few cases to consider.

· If a single eRoom link item is copied, it can only be migrated into a SharePoint Links List (this is the

only target that will work for a copy of this level).

· In the event that an entire eRoom container containing links is migrated, the resulting SharePoint

site will automatically have a Links list created, at the appropriate place(s) in the hierarchy. The

individual links in the source eRoom container will be placed in these SharePoint list.

To initiate the migration of a single link:

1. In Explorer View, select the eRoom link to be migrated.

2. Right-click and choose Copy eRoom Link(s).

3. Select the SharePoint Links list to which you want to migrate the link(s). 

4. Right-click and choose Paste eRoom Link(s). 

5. There are no configuration options for this action, so the migration of the links will start

immediately.

Alternately, if a SharePoint container that contains links is selected, the content can be migrated using

the Paste eRoom Container Special > All Items option. Please see the Migrate All Items of an eRoom

Container page for more details.
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9

The Paste [Object] dialog provides a tabbed interface that enables you to configure a migration

according to your specifications.  Available tabs will vary based on the type of migration that you

initiated.

Site Collection Options

If you chose to migrate an eRoom as a SharePoint Site Collection, complete the Site Collection

Options tab as described below.

To configure Site Collection Options:

1. Select the existing Web Application within which you want to create the collection from the drop-

down.

NOTE:  If the Self-Service Mode was selected this option will be set to the default web application

and cannot be changed.

2. Enter a Site Title and optional Description.

3. If different than the default, select a default Language for the new site collection.

NOTE:  Only languages that have language packs installed in SharePoint will be available for

selection.

4. If different than the default, select a base Template for the new site collection. 
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5. If the Web Application into which you are migrating the Site Collection has more than one Content

Database and you would like to specify the one you want to use, select it from the drop-down.

6. Select the appropriate managed path and enter the URL name in the Site URL field.

NOTE:   The text box is only available when the managed path is not set to the root of the site (as

this would overwrite the actual root site), but is available when the managed path is not set to the

root. 

7. If different from the default (the migrating account), enter the user account that will be the

Primary Administrator for the new Site Collection.

The migrating should be set as the Primary (or Secondary) Administrator to help ensure that the

account can access the new site collection after its creation, so it can migrate the remaining

content.

8. (Optional) Enter a user account that will be the Secondary Administrator for the Site Collection.

NOTE:  This field does not authenticate, so any spelling mistakes will not be automatically

corrected.

9. If you want to set a Site Quota:

a) Check the Set Site Quota box.

b) Click the […] button to display the Set Site Quota dialog.

c) Select the appropriate option:

§ To Source Value (default) - the quota value from the source site will be used. 

§ To Individual Values:

§ Limit site storage to a maximum of: "X" Mb - The maximum size of the new site

collection., in megabytes (Mb) 

§ Send warning e-mail when site storage reaches: "X" Mb - The size at which to send a

warning e-mail to the Site Collection Administrator, that the site collection is getting

near it's set volume capacity. 
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§ To Template - Match the same value for a site template on the target side. 

NOTE:  This drop down list will only display site templates that contain a site quota value.

Collision Options

As with any migration, it is possible that an item on the target may already use the same name as an

item being migrated from the source. The two most likely cases of this are:

· Content with the same name exists in multiple locations on the source, and this content may be

migrated to the same location on the target.

· Content on the source is updated after an initial migration, and these updates need to be moved

across to the target.

To deal with these types of scenarios, Metalogix Content Matrix - eRoom Edition contains a set of

Collision Options. These options will help you determine what action they want to be taken if these

types of scenarios are encountered during a migration.

To configure Collision Options:

NOTE:  Most of the Collision Options refer to a "name" value.  The "name" value that is referenced is

the unique identifier from SharePoint. In the case of SharePoint sites, this name value refers to the

internal name and site name for the created SharePoint site. For SharePoint lists and document

libraries this refers to the internal name and title value.  SharePoint folders refer to the folder name

and documents in SharePoint refer to the document name. 

Select the appropriate option.  Use the information in the following table for guidance.

If you want to ... Then ...
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copy the contents from the

source to the target so that:

· if objects of the same

name exist on the target,

the items being migrated

will be added to the

existing site or list 

AND

· If individual items are

being migrated, a new

version will be added to

the item on the SharePoint

side (provided versioning is

enabled)

select Use Existing Content.

NOTE:  If you are configuring an Incremental Migration,

this will be the only available option.

overwrite existing content on

the target if an object with the

same name exists (with the

option to rename or delete

existing content)

· Select Overwrite existing content with the same

name.

· Select the appropriate sub-option:

If you want ... Select ...

content that is being

migrated to be

created on the target

with a unique name,

but only if the

content is a different

type of SharePoint

object

Create current content with

unique name.

NOTE:  When this option is

selected,  Metalogix Content

Matrix will append a numerical

value to the end of the name. 

For example, if a SharePoint

document library called

"Research" exists on the target

SharePoint site, and this

content is migrated from the

source to the same target

node, but as a SharePoint site,

Metalogix Content Matrix

would detect the "Research"

document library that already

exists, but would detect that it

is a document library type, and

would allow the new site to be

created. This new site would

be given a new unique name
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If you want ... Select ...

(like "Research_1") and the

existing document library

would still exist, instead of

being deleted so the new site

could be created.

delete whatever

content on the target

that already exists

with the same name

and migrate the new

content to the

selected node, even if

the content is of

different types

Delete existing content and

create current content.

For example, if a SharePoint

document library called

"Research" exists on the target

SharePoint site, and content is

migrated from the source to the

same target node as a

SharePoint site, this option

would delete the existing

document library, and add the

new "Research" site in its place,

using the same name.

skip any items in the migration

that have the same name as

an item that already exists on

the target.

select Skip current content if content with same name

exists.

delete content on the target

that already exists with the

same name and migrate the

new content to the selected

node, even if the content is of

different types

select Rename current content with unique name.

When this option is selected,  Metalogix Content Matrix
will append a numerical value to the end of the name.  For
example, if an item called "MyFile" exists on the target it
would be renamed "MyFile_1, " MyFile_2," and so on.
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Container Options

The Container Options tab enables you to specify how you want Metalogix Content Matrix to migrate

specific types of content.

The available options depend on the migration action.  For example, if you chose to migrate as a site

collection or site, all options would be included, including options to

· Replace all invalid characters in name with: - This check-box option replaces any invalid

characters that are found during the migration with a character of your choice. By default this

character is set as "_" but this can be changed.

· Enable Tree View Navigation in Site - This check box activates the tree view settings in the target

SharePoint site. This means that the Quick (left-hand) Navigation will be changed from it's default

view to display a tree view of the navigation instead.

If you chose to migrate as a Document Library, a subset of these options are included.  
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If you chose to migrate a specific item type (Calendars, Discussion Boards, Links, Polls, etc.), only

options specific to that item type is available.

eRoom Containers - Include Subfolders

When the Container Options - Include subfolders box is checked, any subfolders from the eRoom

container will also be created in the SharePoint document library for any documents that are in the

eRoom subfolders. If not checked, no subfolders will be included in the migration.
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eRoom Containers - Include Inboxes/Notes/Discussions

If you initiated a migration of an eRoom as a SharePoint site collection or site or a migration of eRoom

inboxes, notes, or discussions, you can specify how inboxes and mail check the  Include inboxes/mails

box

If you initiated a migration of a Discussion Board, the Copy Discussion / Inbox / Note dialog contains a

separate tab, Inbox/Notes Options with the following options:

· Include comments - This option determines if all the content in the "Comments" column in the

eRoom content will be migrated into the SharePoint Discussion board. If this option is selected, all

the "Comments" will be migrated as the body of the discussion topic. If this option is not selected,

only the discussion topic (with the original heading comment) will be migrated, and no other

comments will be migrated to the SharePoint Discussion board. 

EXCEPTION:  if the contents to be migrated is nested, comments will be migrated regardless of the

"Include Comments" setting.

· Map user metadata - When this check-box option is selected users and groups will be migrated to

SharePoint, along with their metadata. For more information on this option please see Permissions

Options. 

· Migrate images in html contents into image library - If this check-box option is selected, any

images in the eRoom HTML content will be migrated and placed into a SharePoint Picture library.

After the images have been placed in the library, the HTML content containing the image will have

its internal link for the image corrected, to point the image link to the picture library, where the

image now lives. There is a text box below the check-box option that becomes enabled when the

check-box is selected. This text box allows you to specify the name for the picture library that will

be created.
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eRoom Containers - Include Documents

If you chose to migrate an eRoom container as a site collection, site, document library, or document(s)

you can specify how documents should be migrated.

To configure Document Options:

1. In the Container Options tab, make sure the Include Documents box is checked, and click the [...]

button to display the Document Options dialog.

NOTE:  If you chose to migrate individual documents, Document Options displays as a separate tab,

in place of the Container Options tab.

2. If you want to include Include versions in the document copy, check this box, then select the
appropriate sub-options.  Use the information in the following table for guidance.

If you want to ... Then ...

update any existing SharePoint libraries so that

versioning is enabled on them

check the Update existing libraries to enable

versioning box.

migrate all of the document versions from

eRoom into SharePoint

select the Migrate all versions radio button.

migrate only the last specified number of

versions

select the Migrate latest ...version, and select

the number of versions you want to migrate

from the drop-down.

NOTE:  If you accept the default value (1), only

the last version will be migrated.
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3. If you are migrating into an existing document library and want to map specified eRoom fields into

SharePoint fields:

a) Check the Map custom fields (Limited support) box.

b) Click [Edit Mappings].

c) Follow the procedure for Column Mapping.

4. If you want to apply a selected content type to the migrating content, check the Apply the

following content types box and select a content type from the drop-down (which contains all of

the content types that exist on the target).

eRoom Containers - Include Calendars

If you chose to migrate an eRoom container as a site collection, site, document library, or document(s)

you can specify how documents should be migrated.

To configure Calendar Options:

1. In the Container Options tab, make sure the Include Calendars box is checked, and click the [...]

button to display the Calendar Options dialog.

NOTE:  If you chose to migrate individual calendars, Calendars Options displays as a separate tab,

in place of the Container Options tab.

2. If you want Metalogix Content Matrix to check the eRoom ID for any existing calendars events to
see if the same ones already exist on the target, and If they do, update these events with any new
data, check the Update existing calendar events with same eRoom id box.

NOTE:  If this box is checked and these IDs do not exist on any calendar events, new ones will be

created.

If this option is selected it can cause some slower performance speeds. This is because the

migration will have to look at each calendar event on the eRoom source, and each calendar event
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on the SharePoint target site and compare all of the eRoom ID column data to see if any of the IDs

already exist. 

eRoom Containers - Include Databases

If you chose to migrate an  eRoom container as a site collection or site or initiated the migration of an

eRoom database, you can specify how the database(s) should be migrated.

To configure Database Options:

1. In the Container Options tab, make sure the Include Databases box is checked, and click the [...]

button to display the Database Options dialog.

NOTE:  If you chose to migrate databases directly, Database Options displays as a separate tab, in

place of the Container Options tab.

2. If you want  users and groups to be migrated to SharePoint, along with their metadata, check the

Map user metadata box.

NOTE:  If you want to map eRoom users to and target SharePoint users, click the [...] button.   

a) Check the Map database columns box.

b) Click [Edit Mappings].

c) Follow the procedure for Column Mapping.

When migrating a source Number-type column to a target Number-type column, if the source

column contains any non-numeric characters (with the exception of a single decimal point), they

will be stripped when migrated to the target. For more information, see Configuration

Considerations when Migrating an eRoom Database to SharePoint.
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3. If you want to migrate images in the database(s) into a new SharePoint Picture Library:

§ check the Migrate images in html contents into image library, and

§ if different than the default name, enter a name for the library that will be created.

4. If you want to migrate default values (also known as initial values) within the eRoom database to

the target SharePoint list, check the Migrate default values for columns box.

NOTE:  This option only migrates default values to columns that are newly created on the target

during migration; it does not migrate default values to existing columns. In addition, this option has

the following limitations based on column type: 

§ For all migration actions, this option does not work for the following eRoom column types:

Formatted text, Date, Member list, and Approval. 

§ For the Paste as Discussion Board migration action, this option does not work for Plain text

eRoom columns. For all other migration actions, this option migrates Plain text eRoom columns

correctly. 

§ For all migration actions, this option works correctly for the following eRoom column types:

Boolean, Number, Choice list, and Traffic light. 

5. If you want to create columns within the SharePoint list for any empty eRoom columns that were in
the eRoom database, check the Create SharePoint columns for empty eRoom columns box.

6. If you want to adds filters to the source eRoom database to filter out any columns of a specified
type:

§ check the Filter cells with following column type box, and

§ select the specific column type on which to filter the source eRoom database from the Filter

cells with following column type box.

NOTE:  The values of this drop-down are populated from the source eRoom side.  After a

column type has been selected, a new row will appear under the Column Type heading, and

additional column type filters can be added.

eRoom Containers - Include Polls

If you chose to migrate an  eRoom container as a site collection or site, or initated the migration of an

eRoom poll, you can specify how polls should be migrated.

NOTE:  eRoom polls are migrated as SharePoint Survey lists.
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To configure Poll Options:

1. In the Container Options tab, make sure the Include Polls box is checked, and click the [...] button

to display the Poll Options dialog.

NOTE:  If you chose to migrate individual polls, Poll Options displays as a separate tab, in place of

the Container Options tab.

2. If you want results in the poll to be migrated to SharePoint:

a) Make sure the Include ballots box is checked.

NOTE:  If this box is unchecked, only the poll with its questions will be migrated. 

b) Check/uncheck the appropriate sub-option(s):

o When the Include write in's box is checked, any "write-in" responses will be

included when migrating the ballots. (That is, any poll responses that contain text

box replies will be included.)

o When the Map user metadata box is checked, users and groups will be migrated

to SharePoint, along with their metadata. For more information on this option

please see the page on Permissions options. 

eRoom Containers - Include Links

If you chose to migrate an  eRoom container as a site collection, site, or document library, and you

want any links within the eRoom content to be migrated, make sure the Include Links box is checked. 

Any links that are found in the migration will be added to the site in a SharePoint Links list. If these links

are pointing to internal data their links will be corrected, provided that Link Correction is being used.
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Mapping Columns

Column mapping allow you to map one or more columns from the source to SharePoint columns on

the target when you click the [Edit Mappings] button is clicked from the Document Options or

Database Options tab. 

The column mapping option is only available when migrating eRoom containers (rooms or folders) or

documents. In the case of migrating eRoom documents, they must be migrating into an existing

document library on the target.

NOTE:  Mappings are saved as a separate .MLM files.

Known Limitation When Migrating an eRoom Database

When migrating an eRoom database to SharePoint, there is a limitation when migrating a Number-type
column to another Number-type column. Any non-numerical characters, with the exception of a single
decimal point, are stripped when migrated to the target. For example, "3.6.4" would appear as "364"
on the target; "+91 #123.@456.789" would appear as "91123456789" on the target. In order to
migrate the source Number-type column as-is, it must be migrated as a Text-type column on the target.
For information on migrating an eRoom database to SharePoint, see Migrating an eRoom Database to
SharePoint. 

To configure column mappings:

1. From the File drop-down at the top of the Edit Custom Property  dialog, choose the appropriate

option.  Use the information in the following table for guidance.

If you want to ... Then...
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load mappings from a previously-saved

Metalogix Mapping setting (.MLM) file
· choose File > Load.

AND

· Navigate to and open the mapping file to

populate the Mappings dialog.

create new mappings go to the next step.

2. Use the information in the following table to determine the appropriate action to take.

NOTE:  You can Filter items in each window to narrow displayed lists.

If you want to ... Then...

manually map each individual source column

to a target SharePoint column
· From the left (eRoom column) pane, select

the Item that you want to map.

· From the right (SharePoint column) window,

select an available Item.

· Click the Map icon.

have Metalogix Content Matrix automatically

map source fields to matching target

SharePoint columns

· From the left (eRoom column) pane, select

the Item(s) that you want to map.

· Click the Auto icon.

The mappings you create will display in the bottom window.  (Note that you can also Unmap

individually-selected mappings in the bottom window or Clear all mappings from the bottom

window.

NOTE:  If no column currently exists on the target that you want to map to, you must manually

create one in the SharePoint User Interface, then return to Metalogix Content Matrix and refresh

the connection to SharePoint.

3. To save the mappings in the dialog as a Metalogix Mapping setting (.MLM) file, choose File > Save.

4. Click [OK] once all desired mappings have been made and return to the Configuration Options

dialog.

Permissions Options

Users groups and permissions can be migrated from eRoom into SharePoint as part of a migration

action. eRoom users and groups can be manually, and is some cases automatically, mapped to

SharePoint users and groups, but permissions are automatically mapped using a special algorithm.

NOTE:  Permissions options are available when migrating eRoom containers (not individual lists or

items).
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How eRoom Users and Permissions are Mapped to a SharePoint
Target

Metalogix Content Matrix will will automatically try to map users from the eRoom source to the

SharePoint target. This automatic mapping will only work in cases where the eRoom source has been

configured to authenticate the user name format using Active Directory (AD), which is not a typical

scenario.  In all other cases, the eRoom users and groups must be mapped to users  that already exist

on the SharePoint target. 

Metalogix Content Matrix can also use a special alogorithm try  to migrate permissions by "best match"

between eRoom and SharePoint permissions.  A "match" is determined by comparing the explicit rights

assigned to a user on the source and the rights that are included in roles on the target server.

For example, consider the scenario where "billw" has permission to read and edit a calendar in eRoom.

During the migration of that calendar, eRoom Edition will analyze the available permissions on the

SharePoint server and might find the Contribute role which allows view, add, update and delete

permissions. If no other role is a better match, this role will be applied for the user mapped to "billw"

on the migrated calendar.

Each eRoom room has four built-in principle types of permissions by default, and these four principles

are a rough equivalent to the standard out-of-box SharePoint permission levels. A best practice

method when migrating permissions would be to migrate them from the eRoom room level. 

NOTE: These permission mappings are not set by default, and are only acting as basic guidelines. 

eRoom Rights SharePoint Permissions

Coordinators Full Control

Custom Roles Design / Manage Hierarchy

Participants Contribute

Observers Read/Restricted Read/Limited Access
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To configure Permissions Options:

1. If you want to map source eRoom users to target SharePoint users, check the Map user metadata

box.

If this box is not checked, or if the eRoom user does not have an equivalent user SharePoint user

that it is mapped to (or if the name format does not match the format used in AD), the migrating

account's information will be used instead.

2. Select the applicable sub-option(s).  Use the information in the following table for guidance.

If you want to ... Then ...

map eRoom users and groups to SharePoint

users and groups

Click the [Edit Mappings] button.

Follow the procedure for Mapping Users. 

have Metalogix Content Matrix use an

algorithm to  a "best match" mapping of

existing permissions between eRoom and

SharePoint

check the Migrate permissions by best-match

box.

NOTE:  No new permission levels will be

created on the SharePoint target.
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Mapping Users

You can set user and group mappings for migrating content when you click the [Edit Users] button from

the Permissions Options tab.

Users can also be mapped as a separate action.  

All user mappings are globally set, so once a mapping is created it will always be used unless removed.

NOTE:  If the source eRoom environment has a large number of users/groups, it is recommended that

the XML user mapping method be used instead, to help improve performance, and for better control

over user mapping. 

To map users:

NOTE:  Metalogix Content Matrix supports many-to-one mappings between source and target.

1. In the top left pane, select the top level eRoom community or group that contains the users and

groups that you want to map.

The source list becomes populated with all of the users and groups that exist under the selected

node.

2. In the lower left pane, select the SharePoint site collection to which you want to map the users and

groups.

The target list becomes populated with all of the users and groups that exist under the selected

node.
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3. Use the information in the following table to determine the appropriate action to take.

NOTE:  You can Filter items in each window to narrow displayed lists.

If you want to ... Then...

manually map individual users or groups on

the source to a target SharePoint user or

group

· From the source list, select the Item(s) that

you want to map.

· From the target list, select a target Item.

· Click the Map icon.

have Metalogix Content Matrix automatically

map source users/groups to target

SharePoint users/groups

· From the source list, select the Item(s) that

you want to map.

· Click the Auto icon.

NOTE:  Metalogix Content Matrix will only map

users automatically if the source and target side

names match, or if the emails match, and the

source and target environments are using the

same AD.

The mappings you create will display in the bottom window.  (Note that you can also Unmap

individually-selected mappings in the bottom window or or Clear all mappings from the bottom

window.

4. Click [OK] once all desired mappings have been made and return to the Copy Options dialog.

Importing User Mappings from an xml File

Metalogix Content Matrix can import any desired user mappings from an XML file. Importing user

mappings from an XML file involves creating an XML file with the desired mappings, then importing that

file. This option is generally used if migrating from an eRoom environment that has a large number of

users/groups.

To create a an xml file of user mapings:

Create a file, with any name, that contains any desired user mappings. The file can either be text based

or an XML file, but must contain a root level node named Mappings, and have one child node for every

mapping that you want imported. Each child node must contain two attributes: Source and Target. The

Source is the Login Name of the source side user, and the Target attribute is the Login Name of the

target user that is being mapped to.

The XML file should follow the below format:

<Mappings>
<Mapping Source="eRoomUser1" Target="Domain\User87" />
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<Mapping Source="eRoomUser2" Target="Domain\User254" />
</Mappings> 

NOTE: The Login Names used in the above example may vary depending on the authentication

methods used by the source and target environments. 

To import the XML file into Metalogix Content Matrix:

1. In Explorer View, select the top-level node of the eRoom connection .

2. Right-click and choose Import User Mappings to display the Import Users Mappings dialog.

3. Click Import From XML button, then navigate to and open the XML file you want to import.

The Import User Mappings dialog is populated with the mappings contained in the XML file.

 

Now you can:

§ delete single mappings (by selecting the desired mapping, and clicking Delete)

§ clear all mappings (by clicking Clear)

 Any mappings that are listed in the Import Users Mappings dialog are not authenticated until the

time of migration. Any spelling mistakes that exist will not be corrected. If a user mapping is not

valid, or authenticated, the migration account will be used instead. 

4. Click [Save] to continue and add the mappings.
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Nested Content Options

Hierarchy structure is different between eRoom and SharePoint. eRoom hierarchy structure can

become very complicated, because a list can have any number of sub-elements, including other lists,

folders, or items. These sub-elements can also contain other lists, folders, items, and so on. This kind of

potential behavior is called "nested content."

In SharePoint, however, only sites can contain other types of content (such as lists, calendars,

document libraries, etc.). This can become an issue when migrating content that can exist in a nested

structure to a different hierarchy structure. Metalogix Content Matrix has a set of Nested Content

options that users can set when migrating their content. These options are available for most migration

actions, and are found under the Nested Contents tab. The Nested Contents tab is available for the

following actions: 

To configure Nested Content Options:

Select how you would like to have nested content handled.  Use the information in the following table

for guidance.

If you want to ... Select ...

prevent any nested content from being migrated to

the target

Do not migrate contents.
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migrate any nested content of a migrated item into

a single subsite under the migration target (with all

of the nested content flattened to a single level and

placed under the subsite)

Migrate contents into subsite.

migrate any nested content into the target site or

list, so that:

· If the target is a SharePoint site, or if the

migration is creating a SharePoint site under

the selected target location, all of the nested

content would be flattened to a single level and

placed under the selected target site 

· If the target is a SharePoint list or library all of

the nested content would again be flattened to

a single level but would be placed under the

parent site of the selected target SharePoint

list/library.

Migrate contents into target list/site.

migrate any nested content into the target site or

list in the same manner as the Migrate contents

into target list/site option, but with the parent site

or list name appended to the end of the nested

content lists

Migrate contents into target list/site with

parent name.

Link Correction Options

Metalogix Content Matrix can correct eRoom Link objects that are migrated as items in a SharePoint

Links list. If these links  point to an internal location they will be corrected to the new target location as

part of a migration. Metalogix Content Matrix can also correct links in column data within document

libraries and lists.

When content is migrated from eRoom to SharePoint, Metalogix Content Matrix will create a

SharePoint list called MigrationSourceURLs, with a column called MigrationSourceURL, and will place

the URL for that eRoom container into this field. The MigrationSourceURLs list will store the source

URL data for the eRoom containers that are migrated, and the MigrationSourceURL column will hold

the actual URL value. A TargetURL column will also be added to the list, for the migration target URL.

This way, users can see the source and target URLs for the eRoom links.

NOTE:  While Link Correction Options are configured before the migration, both the mapping of links

and the actual running of the link correction are done as post-migration actions.  
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To configure Link Correction Options:

To configure Link Correction Options:

1. To have URLs from the source eRoom container/content saved into a SharePoint list, Make sure

the Store Container Source URLs in a List box is checked.

2. For Target List Location, click [Browse] to open a SharePoint tree view window, and select the site

under which you want the list to be created.

A MigrationSourceURL column will be created in this list and will list the source eRoom URL, and

another column will list the target SharePoint URL to which the eRoom container was migrated.

NOTE:  If the same location is used for multiple migration additional entries will be added to the

existing list, without overwriting any previous entries (unless the same source container has been

migrated to multiple locations).

3. If you want the source URL to be automatically added to the links to Link Dictionary for the post-

migration link correction, make sure the Automatically add links to Link Directory box is checked. 

Transformations Options

You can view, create, and edit Transformers which, as the name implies, "transform" content during

migration.

There are several built-in, non-editable transformers that Metalogix Content Matrix uses to process

data during the migration.  Advanced users can also create custom transformers using PowerShell.
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The Transformations tab consists of two main sections: Available Definitions and Applied

Transformers For <Object>. The Available Definitions section will list all of the transformation

definitions that are available for the current migration action, in alphabetical order. For example, the

Site definition is available when migrating at the site level or higher. However, if migrating as a

document library or migrating documents, this definition will not be listed.

When one of the Available Definitions items is selected, any transformations that exist/have been

configured within the migrating content will appear. Some of the actions that may be grayed out.

These grayed out items are mandatory transformations that are run during the course of a normal

migration, and these actions cannot be edited or removed. However, they can be reordered by using

the up and down arrows to the right-hand side of the window if you want a transformation action to

occur before a mandatory action. Actions that appear and are not grayed are user added

transformations, and can be moved, edited and deleted at the users discretion.

In some cases, you could add another instance of an existing transformer, and then have it run in two

different locations within the migration process. One could be run in the middle, and it could be run

again just before the end.

Using PowerShell to Create Custom Transformations

When you select the Add Transformer > Invoke PowerShell script option for an Available Definition,

you can use custom PowerShell scripts to create your own transformations beyond the built-in

capabilities of the Metalogix Content Matrix. 

Specify when you want the script to run by selecting one of the following options:

Begin Transformation – The transformation script will run before the migration of the affected

objects, allowing you to read and make changes to objects on the source before objects themselves

migrate.  

Transform – The transformation script will run while the migration of the affected object(s) is in

progress.  For example, the user mapping between source and target would be run using the Transform

option.

End Transformation – The transformation script will run after the migration of affected object(s),

allowing you to read and make changes to objects on the target.  

EXAMPLE:  The following Transformer consists of two scripts for disabling and re-enabling the

Required setting for a column list.

· The first script entered into the Begin Transformation tab sets the setting of any columns that are

Required to false before copying begins.
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· The second script, entered into the End Transformations tab, sets the setting back to true after

item migration has completed.
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Saving or Running a Migration
Action

10

When you finish configuring a migration action, you can run it immediately or save a copy of the

settings to a job file, which displays in the Job List section.  You can then:

· run a migration directly from the Job List section

OR

· create a PowerShell script and schedule it to run as a Windows Scheduled Task

OR

· trigger jobs in the Content Matrix Console to run using PowerShell. 

You can also save the job configuration as a template so that you can preserve and reuse settings for

future migration jobs.

When the migration starts, a status dialog box will appear. The job logs can be viewed (in progress or

after the migration is finished) by clicking [Details>>]. The Status section of the status box will list a live

count for the number of successes, warnings, failures, etc. for the migration. The Progress section of

this dialog will list any completions and the type of completion (Sites, lists, items, users, groups, etc.). A

Migration Completed message will appear when finished. Click Close to exit the status dialog.

IMPORTANT:  As of version 9.2, Distributed Migration has been removed from Content Matrix

eRoomEdition, and you will no longer have the option to Run Remotely.

Connecting to a Full SQL Job Database

If you are using SQL CE to host your Content Matrix Jobs Database, you will receive a warning in the job

log (and as a pop-up if you are running the job from the Console interface).

The use of SQL CE in a production environment is discouraged because of the following limitations:

· It uses a single .list file that is less robust and reliable and may be corrupted after the database

reaches 4 GB.

· Data compression is not supported.

· Support for large objects is limited.
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To switch to a full-feature SQL Server for the Content Matrix Job
Database: 

1. From the Job List choose File > Connect to Job Database.

2. Complete the Connect to SQL Server dialog: 

§ If you are connecting to an on premises SQL database, create (using the New Database option)

or select the database you want to use.

§ If you are connecting to an Azure SQL database, select the database that has been created in

Azure Portal for use by Content Matrix.  (Note that the New Database and Delete Database

options will be disabled.)
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3. If you want to use an encrypted connection to the database, check the Encrypt Connection box.

NOTE:  If the certificate used for encryption is not trusted, you will also need to check the Trust

Server Certificate box.

4. Select an Authentication method for connecting to SQL server.:

· Use Current Windows User

OR

· Use SQL Server Login

NOTE:  Currently, Use SQL Server login is the only valid option for an Azure SQL server.

5. Click [OK].

Saving a Job Configuration as a Template

You can create job configuration templates for a set of selected settings which can be saved and

reused, including any options that are not normally preserved using the Preserve Configuration

Options option (in the ribbon Settings menu). 

These templates can also be moved to another machine and used with a separate install of Metalogix

Content Matrix Console (provided that it is the same Edition of Metalogix Content Matrix, and the

same version number or greater).

To save a job configuration template:

1. After initiating a migration, complete the Configure (Object) Copying Options with the settings that

you want to include in the template.

2. Click [Save Job Configuration].

Here you can set the display name for the job template. This is not the actual file name, but it is

the name that Metalogix Content Matrix will use to list the template.

NOTE: In most cases, when a job template is saved by Metalogix Content Matrix it will be saved

to the following location: 

C::\Users\<User>\AppData\Roaming\Metalogix\Metalogix Content Matrix Console - <Product>

Edition
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However, it is highly recommended that you do not interact with this system location. If you are

trying to save a job template so it can be exported to another system the template can be exported

from the Manage Job Configurations dialog.

3. Enter the desired display name value and click [OK] to continue.

Once the save is complete, you will be returned to the Configure <Object> Copying Options dialog

where the migration can either be Run or Saved.

The saved job templates will now be visible in the Manage Job Configurations dialog.

NOTE: If you are looking to save a job template and move it to another system for use, this should be

done using the Export option in the Manage Job Configurations window. Additionally, if you are trying

to Import a job template from another system, this must also be done from either the Manage Job

Configurations dialog or it can be imported when applying a template. 

Applying a Job Template

Any job templates that have been imported or saved, and are available in the Manage Job

Configurations dialog can be applied to another migration of the same type. For example, if migrating

at the site level, you would not be able to use a job template that is created for a migration at the list

level. It would only be able to use a template that migrates at the site level.

The source and target connection types do not apply directly to a job template, so it does not matter if

the connection types for the new migration are the same as the connection types for the job template.

If the connection types are different than any options that are not applicable for the connection types

that are being used will not be available, but all other options will be set.

1. After initiating a migration, click [Open Existing Job Configuration] in the bottom left corner of the

 Configure <Object> Copying Options dialog to display the Select Job Configuration to Apply

dialog. 

NOTE:  Any options you have specified directly in the dialog will be overwritten once a job template

is applied.
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The  dialog lists all of the job templates that are currently available for the migration type (i.e. a

site, list, item, etc. migration), as well as only the templates for the specific Edition of Metalogix

Content Matrix that is being used. 

2. Select the desired job template and click [OK].

You will be prompted to confirm your action before continuing.  Remember that if you choose to

apply the template, any other settings that you entered directly in the Configure <Object> Copying

Options  will be lost.

The Configure <Object> Copying Options dialog will now reflect all of the template options. Any

additional configuration options can be set or modified, and the migration can continue as normal.

Managing Job Templates

Metalogix Content Matrix Console job templates can be managed in the Manage Job Configurations

dialog. This dialog allows users to Import, Export, Delete, or Filter any job templates. Below is a

breakdown of the available options in the Manage Job Configurations dialog.

· Import - This button allows users to Import a job template. The imported job template must be

from the same Edition of Metalogix Content Matrix Console. For example, if users are importing a

template into SharePoint Edition then the template must have been exported from SharePoint

Edition.

· Export - This button allows users to Export a job template. The export will create an XML file in a

desired folder location so the file can be copied and placed into another location as needed.

· Delete - This button will delete any selected job templates from Metalogix Content Matrix

Console. When deleting a template, a confirmation dialog will open and must be confirmed before

the templates are deleted. Deleting will permanently delete the selected templates from

Metalogix Content Matrix Console.
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· Filter - This is a text box that allow users to enter a value that Metalogix Content Matrix will filter

the job templates against. The filter will only display items that contain the specified value. There is

a Filter icon to the right-hand side of the filter text box. Clicking this icon will apply the filter text

value to all of the job templates listed in the Manage Job Configurations dialog, so only the

templates that contain/include the matching filter value will be shown. Filtering can be cleared by

removing the text value from the filter text box, and clicking the filter icon button.

Exporting a Job Template

To export a job template:

1. In Metalogix Content Matrix's ribbon toolbar, switch to the Settings tab and click [Manage Job

Configurations] button to display the Manage Job Configurations dialog.

2. Select the template you want to export then click the Export button at the top of the Manage Job

Configurations dialog, .

3. Navigate to the desired folder location where you want to save the job template, enter a File

name, and click [Save]. 

4. The job template XML file will be saved to the selected folder location, and Metalogix Content

Matrix will return to the Manage Job Configurations dialog. Any additional importing, exporting, or

deleting of job templates can be done. Click Close to return to the main Metalogix Content Matrix

window.

Now that the job templates have been exported and saved to a folder location they can be manually

moved to another location as required.
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Importing a Job Template

Only templates that have been created from the same Edition of Metalogix Content Matrix Console

can be imported. For example, a job template from SharePoint Edition cannot be used in eRoom

Edition or Public Folder Edition, it can only be imported into SharePoint Edition. 

To import a job template:

1. In Metalogix Content Matrix's ribbon toolbar, switch to the Settings tab and click [Manage Job

Configurations] button to display the Manage Job Configurations dialog.

2. Click the Import button at the top of the Manage Job Configurations dialog, navigate to the folder

location for the template XML file, then click [Open].

The job template will be added to the list of templates in the Manage Job Configurations dialog.

The template will be listed using the same Display name that was used when the task was created

on the original system, and will not have its file name displayed. 

The job template is now imported and can be applied to any migration.
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Refreshing the Migration Jobs List

NOTE:  The refresh is applied to whichever job list Metalogix Content Matrix is currently connected

to. 

To refresh the Job List:

1. From the Manage Queue dialog, select a job in the Job List.  The row selector icon and the

highlighted row indicates the selected row.

2. From the Job List menu bar, choose File > Refresh. 

If the status of the job has changed, the Status value will indicate the new status of the job.

Creating and Running a PowerShell Script from
the Jobs List
 In order to create a PowerShell (PS) script for Content Matrix, a job list (or batch file) must first exist in

the Job List section of the Content Matrix Console.  Once created, it can be run from the PowerShell

console or scheduled to run as a Windows Scheduled task.

NOTE:  It is recommended that the connections to the source and target environments have the

Remember my password check-box selected. This is to ensure that the PowerShell scripts will be

able to establish a connection to both the source and target environments when they are being run. If

a password is required and this check-box is not set, the migration will fail. However, users can

manually enter this value into the PowerShell script itself if the option was not checked when the

script was first generated.

To create a PowerShell script:

1. In Job List, and select the job (or jobs) that you want to run in PowerShell.

2. Click the Generate PowerShell Script button in the Job List tool bar, or right-click on one of the

items and select Generate PowerShell Script from the context menu. 

3. From the drop-down, choose the appropriate option.  Use the information in the following table for

guidance.
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If you want to generate a PowerShell script

for scheduling …

Choose …

that can be used only by the currently logged

in User Account on the machine it is

generated on

For Current User and Machine.

NOTE:  Any PowerShell scripts that are generated

for scheduling through this option can only be run

by the logged in user on the machine they were

generated on.

that can be used by any User account on the

machine it is generated on

For Local Machine.

that can be used by any User account on any

machine that has the certificate that is

specified when the script is created

For Certificate.

When you save the PowerShell script using this

method you will be prompted to select a security

certificate that exist on that machine. The

selected certificate will be required on any system

that attempts to run the script at a later date.

Once the PS script generation type is selected, Content Matrix Console will generate a PS script for

the select Job, which will be written to a Microsoft Notepad file. If multiple jobs are selected they

will all be written to the same file.

4. Choose  File > Save As... and select any desired save location for the PowerShell script. Give the file

any name you want, but change the file type to .PS1.



117
Saving or Running a Migration Action

Metalogix® Content Matrix eRoom Edition

The PowerShell (PS) script itself contains five sections. They are:

· Section 1 - This first section at the top (starting with an "if" statement) runs a check in the PowerShell

console to make sure that the Metalogix snap-ins have been added. If they are not found then it will

add them to that instance of the PS console.

· Section 2 - Load Configuration settings - This section will find and load all of the Metalogix Content

Matrix client application configuration settings into the PowerShell script. These are the client

application's environmental settings and not the migration/action settings.

· Section 3 - Load source - This section will load all of the data for the source environment

connection.

· Section 4 - Load target - Similar to the previous section, this will load target environment's

connection information.

· Section 5 - Run the action - Last is the "Run the action" section. This last section will contain all of

the other data for the migration, such as the type of migration (i.e. a site migration, list migration,

item migration, etc.) and all of the settings and configurations for the migration/action that is being

run. This includes things like settings for versions, content types, permissions, etc.

Now you can run or schedule the PowerShell script.
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Running a PowerShell Script

Once a PowerShell script has been created, you can run it from the PowerShell console.

To run the PowerShell script:

NOTES: 

·  If you have more than one edition of Content Matrix, only one edition can be run per PowerShell

session.

· If Content Matrix settings  is changed, in order to apply new settings all PowerShell sessions must be

restarted.  

To add the PowerShell cmdlets for the application framework:

1. Open a Powershell ISE or PowerShell console session.

2. Add the PowerShell snap-ins by pasting in the following text:

if ( $PsVersionTable.PSVersion.Major -lt 3 ) { Write-Host "Windows

PowerShell Version 3.0 or later needs to be installed in order to run

Content Matrix PowerShell scripts."; exit; }

if ( (Get-PSSnapin -Name Metalogix.System.Commands -ErrorAction

SilentlyContinue) -eq $null ) { add-pssnapin Metalogix.System.Commands |

out-null }

if ( (Get-PSSnapin -Name Metalogix.SharePoint.Commands -ErrorAction

SilentlyContinue) -eq $null ) { add-pssnapin

Metalogix.SharePoint.Commands | out-null }

if ( (Get-PSSnapin -Name Metalogix.eRoom.Commands -ErrorAction

SilentlyContinue) -eq $null ) { add-pssnapin Metalogix.eRoom.Commands |

out-null }

if (Get-Command Set-MetalogixJobPrerequisites -ErrorAction

SilentlyContinue){ Set-MetalogixJobPrerequisites -Value "Content Matrix

Console - eRoom Edition" } 

2. Set the directory to the location where the PowerShell script is located.

3. Enter the name and extension of the PowerShell Script (at its specified location), and the script will

run.

In the case that you are running a script from the same directory you would use the format: .

\[ScriptName].ps1. So if your PowerShell scrip was named "ResourceScript.ps1" then you would

enter: .\ResourceScript.ps1 into the window, and the script would run.

If the script is in a different directory, you would enter the location of that directory relative to

your current location, followed by the script name. For example, if your prompt is at the "C:\" drive

and your PowerShell script, named "ResourceScript.ps1" is on the desktop you would enter: C:

\Users\[User]\Desktop\ResourceScript.ps1, and the script would run.
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NOTE:  In some cases the Execution Policy may prevent you from running a PowerShell script. In this

case you will likely see the message: [Script].ps1 cannot be loaded because the execution of scripts is

disabled on this system. Please see "get-help about_signing" for more details. In this case, running the

command: set-executionpolicy RemoteSigned should change the existing script policy to allow you to

run these scripts for your location. It is advised that you check with your System Administrators

before doing this to ensure that no Company Policies are being broken by this action. If this is an

action you need to take, you should only need to run this command once.

The migration will begin, and any warnings and/or errors that are encountered in running the script will

be displayed in the PowerShell window.

Scheduling a PowerShell Script to Run as a Windows
Scheduled Task

Once a PowerShell script has been created, you can run any migration job as a scheduled task on the

system that the client application is installed on. This can be any migration action that exists in the Job

List section, whether it's a migration job that was saved or a job that was previously run. 

The Generate PowerShell Script option saves configurations for the selected job(s) as a PowerShell

script. After the script has been saved, you must create a Windows Scheduled task directly in the

Windows Task Scheduler.

Once these jobs have been created as scheduled tasks they can no longer be viewed (as scheduled

tasks) in Metalogix Content Matrix.  If you want to make any other modifications or remove the task

you can do so directly in the Windows Task Scheduler. If a task has been scheduled, the system will be

able to run the task at the appointed time(s), regardless of whether Metalogix Content Matrix client

application is open.

To schedule a PowerShell script to run via the Windows Task
Scheduler:

1. On the system where the scheduled task will run, open the Windows Task Scheduler.

2. Choose Actions > Create Task.

3. Enter a task Name and Description.

4. In the General tab, go to Security options and specify the user account that the task should be run

under. Change the settings so the task will run regardless of whether the user is logged in.

5. Select the Triggers tab, and click [New] to add a new trigger for the scheduled task. This new task

should use the On a schedule option. The start date can be set to a desired time, and the

frequency and duration of the task can be set based on your specific needs. Click [OK] when your

desired settings are entered.

6. Select the Actions tab and click [New] to set the action for this task to run. Set the Action to Start a

program.

7. In the Program/script box enter "PowerShell."
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8. In the Add arguments (optional) box enter the value ".\[Your PowerShell Script Name]." For

example, if your PowerShell Script is named "Migration1.ps1" then you would enter ".

\Migration1.ps1" as the value.

9. In the Start in (optional) box, add the location of the folder that contains your PowerShell script.

NOTE:  The location used in the Start in box will also be used for storing the scheduled task run

times, the job history for the copies, and any additional logging that may occur.

10. When all the desired settings are made, click [OK].

11. Set any other desired settings in the Conditions and Settings tabs. 

12. Once all the desired actions have been made (or added), click [OK]. 

The task will be immediately set, and is ready to run.

After the scheduled task has run, a new entry will be added to Metalogix Content Matrix's Job List

section.

Triggering a Job in the Content Matrix Console
to Run Using PowerShell
As an alternative to generating a PowerShell script, you can use PowerShell to trigger jobs that have

been created in the Content Matrix Console.

To access the PowerShell cmdlets for triggering jobs to run:

Open a PowerShell or PowerShell ISE session and add the PowerShell snap-ins for the application

framework.

The following cmdlets for running jobs are now available:

· Get-MLJobs

· Invoke-MLJob

To retrieve information about jobs in the Console:

1. Select (from the PowerShell ISE Command Window) or enter Get-MLJobs.

2. (Optional) Enter one or more of the following parameters if you want to filter jobs:

· JobNameOrTitle 

· JobStatus 

· Source 

· Target

NOTE:  If you do not apply filters, all jobs in the Console will be retrieved.

3. Run the cmdlet.
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Example scripts:

Get-MLJobs

Get-MLJobs -Source http//eroom/eroom/HR -Target
https://metalogixsoftware.sharepoint.com/sites/HR/Ma -JobStatus Failed -
JobNameOrTitle "Paste Container as Site"

To run one or more jobs:

1. Select (from the PowerShell ISE Command Window) or enter Invoke-MLJob.

2. Select or enter additional parameters.  Use the information in the following table for guidance.

Parameter Notes

JobID
· You can obtain the JobId by running the Get-MLJobs cmdlet.

· You can run multiple jobs using the PowerShell Pipeline variable.

JobStatus Valid statuses are:

· Running

· Not Running

· Paused

· Aborted

· Aborting

· Done

· Warning

· Failed

· Queued

· Triggered

· Cancelling

· Cancelled

Quiet Use this parameter if you do not want to display a status of the job as it

is running.

RunRemotely Use this parameter if you want to submit the job for Distributed

Migration.

NOTE:  This option is valid for SharePoint Edition only.

3. Run the cmdlet.

Example Scripts

Invoke-MLJob -JobId '92416012-4b69-4d4e-b3c2-984cde279909'

Invoke-MLJob -JobStatus Failed

Run multiple jobs using the PowerShell pipeline variable:

Invoke-MLJob -JobID 'c8176dd1-f1fd-484c-bc66-c002f5406f05' -RunRemotely
'5ca0d97f-4d1d-445f-a6d9-3292abe89a6f', '0a2e0874-a759-46f4-b459-
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bb98ec2991ad' | Invoke-MLJob '30bf6d71-0a28-4012-b612-2d22562b5b46',
'0b094765-46e0-4919-8922-cc5fe841e1f5' | Invoke-MLJob -Quiet

Job Log Files

You can view the progress of a migration tab in real-time via interactive log files. The logs are fully

searchable.

To view an interactive log:

After starting an action, click Details>> in the progress dialog box. 

NOTE:  All logging in Metalogix Content Matrix is done through jobs. If a job list is deleted from the

Job List, all logging for those actions will also be deleted. There is no backup for the job lists, unless

the job is manually saved to another location. Once a job list is deleted, all logging for the actions

within that job list are gone. Metalogix Content Matrix will automatically hold any job lists created

through any copy or compare actions, in the Job Lists section, and these job lists can only be deleted

through the appropriate Delete commands. The job lists can also be manually selected and saved

through the Job list section.

There are two types of jobs in Metalogix Content Matrix:

A job list is a collection of job items. A Job list is created for each copy or compare action that is made.

Any "Copy" action/job that is in the Job List section can be used as the base of an incremental copy job.

Job items can be viewed in the Log Viewer, by opening a job list. There are three basic ways to open a

job list to access the Log Viewer:

· Double-click on a job list.

· Select a job list, then in the Job List section of the toolbar click View Log.

· Select a job, right-click, and choose View log.

Job items are job files, or logging, for individual items within the scope of an action. For example, if a

SharePoint site is copied, there would be a job item for adding each list and each item in that list, and

one job item for adding or creating each site or sub-site. If a SharePoint list with five documents is

copied, then there would be a job item for adding/creating the list, and then one job item for adding

each of the documents.
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Job items are job files, or logging, for individual items within the scope of an action. For example, if a

SharePoint site is copied, there would be a job item for adding each list and each item in that list, and

one job item for adding or creating each site or sub-site. If a SharePoint list with fie documents is

copied, then there would be a job item for adding/creating the list, and then one job item for adding

each of the documents.

From the Log Viewer you can select and view any job items that exists within that job list.

NOTE:  Some actions in Metalogix Content Matrix have the ability to run with Verbose Logging. This

option will increase the size of the log file.

Log Item Details

To view Log Item Details:

1. From the Log Viewer, select the item whose details you want to view.

2. Use one of the following options:

§ Double-click on the item.

OR

§ Right-click and choose View Job Item.

OR

§ If the job is currently running, click Details>>.
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The Job Details dialog contains the following information:

· Operation - The last operation performed on the item.

· Status – The status of the item. If a compare action is being performed then this could be:

completed, different, or missing.

· Item Name - For items, the Item ID. For documents, the Filename.

· Time Started – The time the action for the item was started.

· Time Finished – The time the action for the item was finished.

· Bytes Copied – The  bytes (B) that were copied in the action. This will be displayed in KB in some

cases.

· Source - The Source URL for the item.

· Target - Target URL for the item.

· Information - Provides an informational message about the item, such as. This section will provide

a description for any different and/or missing attributes/metadata for an item.

· Details View - Any errors that were encountered with the item when an action was performed.  

· Content Comparer tab - Any differences between Source and Target content (from a compare

action). You can display this information in either a Grid View, which displays a metadata property

grid for the item, or as a Text View, which displays a XML text format of the item.  This option is

most useful if Verbose Logging has been checked
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You can also:

· Use [Search KBs] to have Content Matrix query the Quest Support Knowledge Base for relevant

articles if you selected a failed item.

· Use [Copy] to copy all of the item information and details (including the Details tab) into the

system’s clipboard.  You can then paste the information when it can then be pasted to another

location. When pasted the information will look similar to that of the actual Log Item Details

dialog. This can be used for easy copy/pasting of an items migration log details.

· Use [Prev] and [Next] buttons to move to the previous or next item on the list (if applicable).

Exporting Jobs to an Excel File

You can export a selected job or multiple jobs from the Job List section into a Microsoft Excel file. The

export will include all of the operations within each job (whether it is a migration action or some other

action), and their details. This is to help users better understand their migration data and results, and

provides another way to review the resulting logs.

In addition to the log details that are provided, there are also a number of tables and charts that can be

accessed in different tabs within the Excel file. These tables and charts will help breakdown the

information in a more visible manner.

To export one or more jobs to an Excel file:

1. In the Job List, select the job(s) you want to export.

2. Use one of the following options:

§ From the Job List menu, select Export Excel 

OR

§ Right-click and choose Export selected job to Excel.

3. Save the file to the desired location.

By default the Excel file will open after it has been created. This process may take a few minutes

depending on the size of the selected job(s) and the number of actions in the log(s).

Information in Exported Excel Files

When an Excel file is exported from the Metalogix Content Matrix Job List there are a number of page

tabs that can be viewed. Each page tab will display a different set of data, and some of these tabs will

also display pivot graphs (with pivot tables behind them).

NOTE: The data within all of these Excel tabs (both the tables and the graphs) should only be

considered a starting point when looking at your migration data. You can modify the existing graphs

https://support.quest.com/metalogix-content-matrix/kb
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through various methods, such as applying filters, changing the data values, etc.  You can also take the

"raw" data from the LogItems tab and use it to create your own graphs or sets of data as required.

The exported file contains the following tabs:

· Jobs - All of the specific jobs that are included in the export. This includes migration jobs as well as

other actions.

· LogItems - All of the operations that have been run by Metalogix Content Matrix and provide all of

the logging details that are available in the Log Viewer and Log Item Details windows. Some

examples of these operations are: adding lists, adding content types, copying documents, adding

users, updating lists, etc.

· Error Rates - A a graph that represents the number of errors and warnings that Metalogix Content

Matrix encounters during a migration on a "per minute" basis. The vertical axis will list the number

of errors/warnings that are encountered (at the specified time), and the horizontal axis lists the

amount of time (displayed in a "per minute" value). The horizontal axis can also be changed to

display in month, day, or hour time values as well. Below the graph is a table that provides a

different view of the same error/warning breakdown.
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· Operation Counts - The number of operations/actions that are run over a period of time. Some

examples are: copying sites, copying lists, copying documents, adding SharePoint groups, adding

users, copying permissions, etc., and each operation has its own line representation on the graph.

The vertical axis lists the number of operations that are running (at the specified time), and the

horizontal axis lists the amount of time (this is displayed in a "per minute" value). The horizontal

axis can also be changed to display in month, day, or hour time values as well. Below the graph

there is a table that provides a different view of the same migration operation data.

· Operation Duration - The total duration of time for each operation/action type against the total

migration time.   This is potentially the most confusing graph to read in the exported Excel file. The

vertical axis lists the total duration time for each action. This is determined by finding the

difference between each operation/actions Time Started and Time Finished values, and then
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adding the totals together for all of that operation/actions of that type that are running. This is

then displayed against the horizontal axis which lists the time (displayed in a "per minute" value) for

the migration. The horizontal axis can also be changed to display in month, day, or hour time values

as well. Below the graph there is a table that will provide a different view of the same migration

data.

An example of how to read this graph is: if at minute 25 (of the hour, not the 25 minute of the

migration) a large number of small documents are copied and completed (all in the 25th minute),

then at minute 25 in the graph there will likely be a spike in the "duration time" for the "Copying

Document" operation/action. If each document was copied in 2 seconds, and there were 41 small

documents, then the Sum of Duration value would be listed as 82 seconds (or 0:01:22). So the

results in the graph would show a spike for the Copying Document operation/action and minute

25, with a value of 0:01:22.

· Operation Throughput – The  amount of data/throughput (in MB) that is migrated on a "per

minute" basis. The vertical axis lists the amount of data that is being pushed through Metalogix

Content Matrix for a given operation (at the specified time), and the horizontal axis lists the time

(displayed in a "per minute" value) at which that the action was performed. The horizontal axis can

also be changed to display in month, day, or hour time values. Below the graph there is a table that

will provide a different view of the same throughput data.
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Copying Job Logging to Other Applications

It is possible to copy the results of migration jobs from log files to other applications. This can be

beneficial if you want to keep track of copy or incremental information outside of Metalogix Content

Matrix, or want to manipulate the information for reporting or retention purposes. The log information

is copied as text, to the clipboard, and can then be pasted within any other application that allows text

pasting. For example, if a copy action was made, the logging can be copied into a Word file, or into an

Excel spreadsheet, then saved. 

NOTE:  Only the end results of the total action will be copied.

To copy the logging for a job list:

1. Select a job from the Job List.

2. Right-click, and choose Copy selected job to clipboard (alternately Ctrl+C can be used).

3. Open the desired target program (for example: Microsoft Word, Microsoft Excel, Notepad, etc),

then paste the content into the application (Ctrl+V, or the paste command in the application

itself). 

NOTE:  The logging for each action within the list must be copied separately.

To copy the logging for job items:

· Select the desired job list or job item(s) that the logging is to be copied from, and open the job list

to access the Log Viewer.

· Select any job items that are to be copied. Single or multiple items can be selected in the Log

Viewer. In order to copy the logging for the entire job, all job items in the Log Viewer must be

selected.
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· When all of the desired items are selected, right-click on one of them, and select Copy Log Items to

Clipboard, and select to either copy them with, or without details. The Details are a set of extra

columns that are added to the logging. These columns are typically: Details, SourceContent, and

TargetContent. These columns do not always contain extra information. The default copy option

(Ctrl+C) is to copy the logging without the Details.

Creating a Support Zip File for a Migration Job

You can generate a zip file of data associated with a single job item to help Quest Support facilitate

troubleshooting.

The high-level data collected in the zip file includes:

· Application Settings files.

· Product information (product version, license, etc.).

· Information about the job item (what action settings were set, the job log, etc.).

IMPORTANT: Please review the contents of the zip file before sending it to Support. While this

feature attempts to only collect non-sensitive data, no guarantees can be made - it is up to you to

ensure that any files in the zip folder are stripped of any confidential data. Regardless, Quest assures

that the contents of the zip file will only be used for troubleshooting the associated support ticket.

To create a support zip file:

1. In the Job List, select the job for which the zip file is to be generated.

2. Use one of the following options:

https://support.quest.com
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§ In the main ribbon, click the Help tab, then Create Support Zip File.

§ Right-click and choose Create Support Zip File.

3. Save the file to the desired location using the desired file name.

4. If you wish to review the zip file for sensitive information, click Yes to open the zip file. Once you

are satisfied with the contents of the zip file, it can be sent to Quest Support to aid in

troubleshooting.

Enabling Trace Logging

You can enable trace logging on the machine where Content Matrix is installed and migrations are run

to assist Quest Support with troubleshooting. 

NOTE:  For Distributed Migration, trace logging must be enabled on each agent machine.

To enable trace logging:

1. Open the file LogSettings.xml, which can be found in one of the following folders:

· If you are required to be a local administrator on the machine where Content Matrix is installed: C:

\ProgramData\Metalogix

OR

· If you are not required to be a local administrator on the machine where Content Matrix is

installed:  C:\Users\<username>\AppData\Roaming\Metalogix\Common

2. Set <LoggingLevel> to one of the values described in the following table.

WARNING:  When trace logging is enabled, entries are appended to the log file for each migration

job that is run, and the same log file is used for all editions. This means the log file can become

very large, which is why it is recommended that you only enable trace logging at the request of

Quest Support.

Value Description

None [Default] Trace logging is disabled (i.e., no entries are written to the log file).

Error Only Error messages are logged.

Debug Error and Debug messages are logged.

NOTE:  Debug should only be used for advanced troubleshooting as it may

impact migration performance.

Log entries are written to the file MetalogixGlobalLog.txt, which is located in the same folder as

LogSettings.xml.

https://support.quest.com
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Mapping Links and Running Link
Correction

11

Link correction in Metalogix Content Matrix eRoom Edition involves the following post-migration

actions:

· Mapping the source and target URLs, which are based on the links listed in the Link Dictionary

THEN

· Running the link correction.

NOTE:  Link Correction options are specified as a pre-migration configuration task.

To map source and target URLs after a migration:

1. In Explorer View, select the target SharePoint site for which you want to map links. 

2. Right-click and choose Link Correction > Map Links. 

An informational dialog and the Map Links Options dialog displays. 

3. When you are ready to map links, close the informational dialog.

4. If you want links to be mapped for all subsites of the selected site, make sure the Recursively map

links from subwebs box is checked.

5. If you want links that exist in list items (in the list item's field data) to be included in the mapping,

make sure the Map Links from List Items box is checked.
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NOTE:  This option is more specific for eRoom links that are migrated to SharePoint (as items in a

Links list).

6. If you want to add any link mappings from the MigrationSourceURLs list into the Link Dictionary:

a)  Make sure the Map Links from MigrationSourceURLs List box is checked.

b) Click [Browse...] to open a SharePoint tree view with all of the data connections, and select the

MigrationSourceURLs list that had been configured on the Link Correction Options tab prior to

migration to include in the link correction mappings.

c) If you want Metalogix Content Matrix to validate the target side links from the

MigrateSourceURLs list, click the [...] button to display a secondary Map List Options dialog

and make sure the Validate Target URLs option is checked.

d) Click [OK] to return to the primary Map List Options dialog.

Now you can save or run the link mapping action.

When the map links option is run the target node will be crawled looking for list items with values in the

MigrationSourceURL column. These values are then used to populate the Link Dictionary.

To run Link Correction:

REMINDER:  Links must be mapped before Link Correction can be run.

1. In Explorer View, select the target SharePoint site for which you want to correct links. 

2. Right-click and choose Link Correction > Correct Links to display the Correct Links Options dialog.

3. If you want Metalogix Content Matrix to output a CSV file containing a list of any of the links that
were corrected by the link correction action:

a) Check the Export corrected links to CSV file: box.

b) Enter a file name in the text box, then click the folder icon and navigate to the location where

you want to save the CSV file.

Now you can save or run the link correction action.
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Managing the Link Dictionary

Metalogix Content Matrix - eRoom Edition uses a Link Dictionary database to store a list of mappings

for link correction. This database is populated through the use of the  Link Correction Options tab when

configuring a migration, and as a post migration option. 

The first method to manage the Link Dictionary is through the use of the Settings heading in the ribbon

menu, which includes the following options:

· Export Link Dictionary - This option will create a CSV file containing a list of all of the current URL

mappings between the eRoom source and the SharePoint target. The CSV will contain two

columns, Source URL and Target URL. Selecting this option will open the Link Dictionary Export

Options dialog.

If you want Metalogix Content Matrix to output a CSV file containing a list of any of the links that

were corrected by the link correction action, enter a file name in the text box, then click the folder

icon and navigate to the location where you want to save the CSV file.

Then you can save or run the CSV creation action.

· Clear Link Dictionary - This option will delete any link mappings that currently exist in the Link

Dictionary database file. When selected a warning dialog will open to confirm that the links should

be cleared.

The second method is through a manual process. The database file that is used for the link mapping can

be found at the following location:

[Drive]:\Users\[USER]\AppData\Roaming\Metalogix\Metalogix Content Matrix Console -

eRoom Edition

In this folder, the LinksCache.sdf file is a database file that contains the link mappings.

NOTE:  If using this method, the Metalogix Content Matrix Console should be closed/shutdown

before editing/accessing any files in this folder location. 
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If you want to remove all the existing mapping, and are not able to use the Settings > Clear Link

Dictionary method, you can navigate to this folder location and delete the LinksCache.sdf file, then

restart the Metalogix Content Matrix Console.

You may also want to clear any existing link mappings, but do not want to permanently lose the existing

mappings. In this case the current LinksCache.sdf file can be renamed and saved, and a new

LinksCache.sdf file can be created. All of the existing mappings will still exist in the renamed file, and

new mappings can be created in the new file. Should you want to switch back, you can rename the

newer version of the file, and return the original file back to its original file name, LinksCache.sdf.
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Incremental Migration

12

Metalogix Content Matrix lets you run an incremental migration (also known as a delta migration or an

incremental copy) to migrate new and updated data from the source to the target. This can save time

when relatively minor changes have been made to a large source environment, and you want to

migrate those changes to your target environment.

Incremental migrations are based off previous migration actions. In order to create an incremental job,

a non-incremental migration action must have already been run, and a job item for that action must

exist in the Job List.

Incremental migrations can be run from the Metalogix Content Matrix Console  UI or through a

PowerShell script.

Prerequisites and Limitations of Incremental Migrations

· To run an incremental migration, a full migration must have already been run for the content you

want to migrate incrementally. This is because of the following: firstly, there must be content on

the target environment to compare changes on the source environment against, and secondly,

incremental migrations can only be created from an existing job item in the Job List.

· The only supported connection types are Local Connection (SharePoint Object Model) and Remote

Connection (Metalogix SharePoint Extensions Web Service). For more information about

connection types, please see Connecting to SharePoint.

· Incremental migration works by comparing the last modified dates for each item on the source and

target. Therefore, the following scenarios do not fully support incremental migration: 

§ If an item on the source is moved after the initial non-incremental migration action, it is

considered a new item and is migrated incrementally. This will result in duplicated items.

§ If an item on the source is deleted after the initial non-incremental migration action, there is no

longer a last modified date on the source to compare to the target. This will result in the

deletion not being detected by Metalogix Content Matrix Console, which means that the

deleted item on the source remains on the target after the incremental migration action.

· Only Title and Description eRoom metadata is supported. Other metadata types are not supported

because they have no equivalent object in SharePoint.

· It is a Known Issue that an incremental migration action will incorrectly duplicate eRoom objects

if: 

1. A set of eRoom objects is migrated non-incrementally to a subsite on the target. 

2. That same set of eRoom objects is then migrated non-incrementally to a different subsite

on the target. 
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3. An incremental migration job is then created from the non-incremental migration action

that was created in step 1. 

NOTE:  This issue applies to all eRoom object types and migration actions that support incremental

migration.

Supported Incremental Migration Actions and Objects

The following is a list of migration actions that support incremental migration:

· Paste as Document Library (except when migrating calendars, discussions, and polls) 

· Paste as Site 

· Paste all Items As Site 

· Paste as Site Collection 

· Paste as Site Collection using Nested Object Flattening 

· The following object-specific migration actions: 

§ Paste Calendar and Paste Calendar Event 

§ Paste as Database 

§ Paste Discussion and Paste Discussion Topic 

§ Paste Document, Paste Container as Folder, and Paste Folder > All Items 

§ Paste as eRoom Link and Paste Link as Link to a Document 

§ Paste Note 

§ Paste as Poll 

The following is a list of eRoom objects that support incremental migration:

· Calendars 

· Databases

· Discussions (known as Discussion Boards in SharePoint)

· Documents

· Links

· Metadata (only 'Title' and 'Description')

· Notes

· Polls (known as Surveys in SharePoint)

· Rooms

To migrate eRoom Content Incrementally:

1. Ensure that a non-incremental migration action has already been run for the content you want to

migrate incrementally.
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2. In the Job List, select the existing job item.

3. Right-click and choose Create incremental job.

A new incremental job is added to the Job List.

4. If you want to change the configuration options for the incremental job:

§ In the Job List, navigate to the incremental job:

§ Right-click and choose Change configuration for selected job to display the Copy

Container As... dialog.

5. Change any configuration settings as you would if you were configuring copying options for a full

migration.
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EXCEPTIONS: 

§ In the Migration Mode tab, the Incremental Copy option is selected, and all other

options are disabled.

§ In the Collision Options tab, the Use existing content option is selected, and all other

options are disabled.

Now you can save or run the action.
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Using PowerShell with Content
Matrix

13

Metalogix Content Matrix can generate PowerShell scripts to be used to migrate SharePoint content

through the PowerShell command window.  You can also use PowerShell to perform other actions,

including:

· connecting to SharePoint

· triggering a job in the Content Matrix Console to run

The Content Matrix PowerShell Console shortcut is added to the same Start Menu folder location

where the to Metalogix Content Matrix Consoles are placed after installation. The same PowerShell

console can be used for any edition, as long as the edition-specific snap-ins are used.  You can also use

a standard PowerShell console or PowerShell ISE.

Adding PowerShell Snap-Ins for the Application
Framework

Whenever a new PowerShell session is launched, the edition-specific snap-ins must be added before

you can perform a Content Matrix action.

NOTES: 

· If you have more than one edition of Content Matrix, only one edition can be run per PowerShell

session.

· If Content Matrix settings change, in order to apply new settings all PowerShell sessions must be

restarted.  

To add the PowerShell cmdlets for the application framework:

1. Open a Powershell ISE or PowerShell console session.

2. Copy and paste  the PowerShell snap-ins from the Quest Support Knowledge Base article located at

https://support.quest.com/metalogix-content-matrix/kb/333879.

https://support.quest.com/metalogix-content-matrix/kb/333879
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Using Powershell for Nested Content Reports
and Pre-Migration Check

You can perform Pre-Migration Checks, Nested Contents Reports, and Nested Contents URL Length

Reports through the PowerShell command window. 

In order to create a PowerShell script for a Nested Contents Report or a Pre-Migration Check, Nested

Contents URL Report, a report item must first exist in the Job List section.

To create a PowerShell script for Nested Content Reports and Pre-
Migration Checks:

1. In the Job List section, select the report(s) want to run in PowerShell. 

2. Either:

§ Click the [Generate PowerShell Script] button in the Job List menu options

OR

§ Right-click and choose Generate PowerShell Script. 

3. Choose the appropriate option from the sub-menu to specify the security method that will be used

when generating the PowerShell script . Use the information in the following table for guidance.

If you want to generate a

PowerShell script …

Choose …

that can be used only by the

currently logged in User Account on

the machine it is generated on

For Current User and Machine.

NOTE:  Any PowerShell scripts that are generated for

scheduling through this option can only be run by the

logged in user on the machine they were generated

on.

that can be used by any User

account on the machine it is

generated on

For Current Machine.

that can be used by any User

account on any machine that has

the certificate that is specified when

the script is created

For Certificate.

When you save the PowerShell script using this

method you will be prompted to select a security

certificate that exist on that machine. The selected

certificate will be required on any system that

attempts to run the script at a later date.
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If you want to generate a

PowerShell script …

Choose …

Once the applicable option is selected, Metalogix Content Matrix Console will generate a

PowerShell script for the selected report, which will be written to a Notepad file. If multiple reports

are selected, they will all be included in that single file.

3. To save the file as a PowerShell script:

a) In the Job List section toolbar, choose  File > Save As.... 

b) In the Save As dialog box, navigate to the directory in which the script file is to be saved. 

c) Click the Save as type drop-down menu and select All Files. 

d) Enter a name for the script and append the .ps1 file extension to the file name to save it as

a PowerShell script. 

To run the PowerShell script:

NOTES: 

·  If you have more than one edition of Content Matrix, only one edition can be run per PowerShell

session.

· If Content Matrix settings  is changed, in order to apply new settings all PowerShell sessions must be

restarted.  

To add the PowerShell cmdlets for the application framework:

1. Open a Powershell ISE or PowerShell console session.

2. Add the PowerShell snap-ins by pasting in the following text:

if ( $PsVersionTable.PSVersion.Major -lt 3 ) { Write-Host "Windows

PowerShell Version 3.0 or later needs to be installed in order to run

Content Matrix PowerShell scripts."; exit; }

if ( (Get-PSSnapin -Name Metalogix.System.Commands -ErrorAction
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SilentlyContinue) -eq $null ) { add-pssnapin Metalogix.System.Commands |

out-null }

if ( (Get-PSSnapin -Name Metalogix.SharePoint.Commands -ErrorAction

SilentlyContinue) -eq $null ) { add-pssnapin

Metalogix.SharePoint.Commands | out-null }

if ( (Get-PSSnapin -Name Metalogix.eRoom.Commands -ErrorAction

SilentlyContinue) -eq $null ) { add-pssnapin Metalogix.eRoom.Commands |

out-null }

if (Get-Command Set-MetalogixJobPrerequisites -ErrorAction

SilentlyContinue){ Set-MetalogixJobPrerequisites -Value "Content Matrix

Console - eRoom Edition" } 

2. Change the active directory to the file path in which the script file is saved by using the change

directory command ("cd <File path>") and then enter ".\" followed by the script name. For example,

if your script is named "ResourceScript.ps1", you would enter .\ResourceScript.ps1 to run the

script.

NOTE:  If the active directory is different than the directory in which the script file is saved, enter

the full file path of the script file relative to your current directory, and then the script file name.

For example, if your prompt is at "C:\", your script is named "ResourceScript.ps1", and the script is

saved on the desktop, you would enter C:\Users\<User>\Desktop\ResourceScript.ps1

to run the script.

In some cases, the Execution Policy may prevent you from executing a PowerShell script. In this

case, you will likely see the following message: [Script].ps1 cannot be loaded because the

execution of scripts is disabled on this system. Please see "get-help about_signing" for more

details. In this case, run the following command: set-executionpolicy RemoteSigned. This

will change the existing script policy to allow you to run these scripts in the specified location.

However, it is advised that you check with your System Administrators before doing so to ensure

that no Company Policies are being broken by this action. 

All Pre-Migration Checks, Nested Contents Reports and Nested Contents URL Reports included in the

PowerShell script will run, and any warnings or errors that are encountered while the script runs will be

displayed in the PowerShell window.

Content Matrix PowerShell Commandlet List

Metalogix Content Matrix can generate PowerShell script for you, for any migration action that is

available through it. The below cmdlets are used in the generated PowerShell script, but can also be

used to write your own script, should you desire to do so. For more information on each cmdlet, simply

type get-help [cmdlet]. For example, if you want more information on Copy-MLSharePointList cmdlet

you would enter get-help Copy-MLSharePointList, followed by the Enter (return) key.

Below is a list of the available cmdlets (and their parameters), broken up into the available commands

for each snap-in.
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Metalogix.System.Commands

Set-ApplicationDataPath

· Path - The path to be used as the root folder for the application path. Note that relative path

elements relating to the product being used will still be generated within this directory, and that the

application data will be contained within those folders. (Mandatory)

· IncludeCompanyName - Indicates that the Metalogix company name should still be used as part of

the relative path from the specified directory to the application data folder.

Set-CommonDataPath

· Path - The path to be used as the root folder for the common data path. Note that relative path

elements relating to the product being used will still be generated within this directory, and that the

common data will be contained within those folders. (Mandatory)

· IncludeCompanyName - Indicates that the Metalogix company name should still be used as part of

the relative path from the specified directory to the common data folder.

Get-MetalogixConfigurationVariable

· Name - The name of the configuration variable. (Mandatory)

· ValueType - Specify the value type of the configuration variable. This type must be IConvertible.

(Default: IConvertible).

New-Filter

· PropertyName - The name of the parameter to compare the value to on the object being filtered.

(Mandatory)

· Operand - The operand to use to compare the specified value to the given property value.

(Mandatory)

· Value - The value to compare the given property to. (Mandatory)
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· CaseSensitive - Indicates if the comparison should be case-sensitive. This parameter is only

meaningful when the property to be compared to is a string.

· TypeName - The name of a type to apply the filter to. If not specified, the filter will apply to any

object.

Join-Filter

· Logic - The logic to use in the join (and or or). (Mandatory)

· FilterExpression - The filter object to join together. Can be a set of filters). (Mandatory)

Invoke-Filter

· Objects (Mandatory)

· Filter (Mandatory)

Load-MetalogixConfigurationVariableSettings

· FilePath - The full file path of the configuration variable settings file to load. (Mandatory)

· Scope - The scope to load these settings into. (Default: Environment).

New-MetalogixSerializableObject

· TypeName - The name of the type of object to create. (Mandatory)

· AssemblyName - The name of the assembly containing the type to be created. (Mandatory)

· SerializedValue - The XML representation of a single serializable Metalogix object. (Mandatory)

· Enumerate - If set, any collections returned by the cmdlet will enumerated. Otherwise, collections

will be returned as a single object.
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New-MetalogixSerializableObjectCollection

· SerializedValue - The XML representation of a Metalogix object collection. Generally this will be

obtained by requesting the PowerShell command for a job configured in the GUI. This cmdlet is not

recommended for general use. (Mandatory)

Set-MetalogixConfigurationVariable

· Scope - The scope of the configuration variable. Possible values are Environment,

EnvironmentSpecific, User, UserSpecific, Application, ApplicationSpecific,

ApplicationAndUserSpecific. (Default: ApplicationAndUserSpecific). (Mandatory)

· Name - The name of the configuration variable. (Mandatory)

· Value - The value of the configuration variable. (Mandatory)

Set-MetalogixDefaultResolverSetting

· Name - The name of the configuration variable ("ResourceTableResourceTableLink"). (Mandatory)

· Value - The value of the configuration variable. This value will indicate where to obtain configuration

key settings from. Options are local file system ("Metalogix.ResourceFileTableResolver") or agent

database (Metalogix.Core.ConfigVariables.ResourceDatabaseTableResolver). (Mandatory)

Metalogix.SharePoint.Commands

Add-MLSharePointSiteCollection

· WebApplicationName - Name of the Web Application to Create the Site Collection in. Web

Application must exist in the specified Target. (Mandatory)

· WebTemplateName - Web (Site) Template to use for the Site Collection. Web (Site) Template must

exist. The value must be in the form name#configuration. E.g., STS#1 for Blank Site (Mandatory)

· Language - Language to use for the Site Collection. Can be Language Code (LCID) or Language

Name. Language must exist in the specified Target. (Mandatory)
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· ExperienceVersion - The experience version to use when creating the site. This setting is only used

for SharePoint 2013. Use 15 for the 2013 UI and 14 for the 2010 UI.

· Title - The Title for the Site Collection. (Mandatory)

· Description - Description for the Site Collection.

· Path - Managed Path for the Site Collection. Include forward-slash characters where required. E.g.,

"/sites/" or "/sites/". (Mandatory)

· URL - Server Relative portion of URL solely used to identify the Site Collection itself. E.g.,

"TestSiteCollection" (Mandatory)

·

· OwnerLogin - Domain and username to be used as the Primary Administrator for the Site Collection.

E.g., "sampledomain\sample.user" (Mandatory)

· SecondaryOwnerLogin - Domain and username to be used as the Secondary Administrator for the

Site Collection. E.g., "sampledomain\another.user"

· ContentDatabaseName - Content Database Name to use. Not specifying this value will use the

default content database (auto detect).

· SelfServiceCreateMode - Allow users without Farm Administrator privileges to add the Site

Collection.

· SetSiteQuota - Set Quota for the Site Collection.

· QuotaMaximum - Limit site storage to maximum size (Mb). SetSiteQuota must be set to true and

SelfServiceCreateMode should be false. Mutually exclusive with QuotaID.

· QuotaWarning - Send a warning email when the site storage reaches this size (Mb). SetSiteQuota

must be set to true and SelfServiceCreateMode should be false. Mutually exclusive with QuotaID.

· QuotaID - Use Quota Template. Can be the integer ID or the string name of the Quota. SetSiteQuota

must be set to true and SelfServiceCreateMode should be false.

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.
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· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-Permissions

· Name - The name of the user or group you wish to assign a permission level to. (Mandatory)

· PermissionLevel - The name of the permission level you want to grant the specified user or group.

(Mandatory)

· Recurse - A flag that indicates the given permissions level should be granted to the given user for

each item below the target which has unique permissions.

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointFolder

· Name - The name of the folder to be created. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.
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· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointList

· Name - The name for the new list. (Mandatory)

· TemplateName - The numeric code of the template to use. (Mandatory)

· Description - A description of the list.

· Title - The title for the new list.

· IsOnQuickLaunch - Indicates if the list should be added to the quick launch.

· HasVersions - Indicates if the list should enable major versions.

· HasMinorVersions - Indicates if the list should enable minor versions.

· RequiresContentApproval - Indicates if the list should require content approval.

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Add-SharePointSite

· URL - The URL name for the new site. If not specified, it will be automatically generated from the

given name.

· Name - The name for the new site. (Mandatory)
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· TemplateName - The name of the template to use, either in [Name]#[Config] form or by the name

of the STP file. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Clear-GlobalMappings

· ClearGuidMappings - Indicates that global GUID mappings should be cleared.

· ClearURLMappings - Indicates that global URL mappings should be cleared.

· ClearUserMappings - Indicates that global user mappings should be cleared.

· ClearDomainMappingss - Indicates that global domain mappings should be cleared.

Compare-MLSharePointFolder

· CompareFolders - Indicates whether or not to compare folders.

· CompareItems - Indicates whether or not to compare items.

· CompareVersions - Indicates whether or not to compare item versions.

· CompareMetadata - Indicates whether or not to compare object metadata.

· VerboseLog - Indicates whether or not to compare object metadata.

· HaltIfDifferent - Indicates whether or not to halt the comparison if a difference is encountered.

· FilterListsAndFolders - Indicates whether or not to filter lists and folders.

· ListAndFolderFilterExpression - The filter expression applied to lists and folders.
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· FilterItemsAndVersions - Indicates whether or not to filter list items and their versions.

· ItemAndVersionFilterExpression - The filter expression applied to list items and versions.

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Compare-MLSharePointList

This is the same as Compare-MLSharePointFolder with additional parameters.

Compare-MLSharePointSite

This is the same as Compare-MLSharePointList with additional parameters:

· CompareLists - Indicates whether or not to compare lists.

· CompareSubSites - Indicates whether or not to compare sub sites.

· FilterSubSites - Indicates whether or not to filter sub sites.

· SubSiteFilterExpression - The filter expression applied to sub sites.

Get-MLSharePointDatabase

· Server - The name of the database server. (Mandatory)

· Database - The name of the SharePoint content database. (Mandatory)

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.
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Get-MLSharePointFolder

This is the same as Get-MLSharePointList with an additional parameter:

· FolderPath - The list-relative path to the desired folder, seperated by "/". (Mandatory)

Get-MLSharePointFolderFromDatabase

This is the same as Get-MLSharePointListFromDatabase with an additional parameter:

· FolderPath - The list-relative path to the desired folder, separated by "/". (Mandatory)

Get-MLSharePointItembyFileName

· FileName - The filename of the SharePoint document. (Mandatory)

· FolderPath - The list-relative path to the desired folder, separated by "/".

· ListName - The name of the desired list. (Mandatory)

· SiteURL - The URL of the SharePoint site to connect to. (Mandatory)

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

· AdapterType - The short name of the adapter type you want to use for the connection. Use OM for

a local SharePoint or WS for a remote SharePoint where the Metalogix Extensions Web Service is

installed.

· ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointItembyID

· Id - The ID of the SharePoint item. (Mandatory)

· FolderPath - The list-relative path to the desired folder, separated by "/".

· ListName - The name of the desired list. (Mandatory)

· SiteURL - The URL of the SharePoint site to connect to. (Mandatory)
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· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

· AdapterType - The short name of the adapter type you want to use for the connection. Use OM for

a local SharePoint or WS for a remote SharePoint where our Metalogix Extensions Web Service is

installed.

· ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointItemFromDatabase

This is the same as Get-MLSharePointListFromDatabase with additional parameters:

· FolderPath - The list-relative path to the desired folder, separated by "/".

· ItemName - The filename or ID of the desired item. (Mandatory)

Get-MLSharePointList

This is the same as Get-MLSharePointSite with an additional parameter:

· ListName - The name of the desired list. (Mandatory)

Get-MLSharePointListFromDatabase

This is the same as Get-MLSharePointSiteFromDatabase with an additional parameter:

· ListName - The name of the desired list. (Mandatory)

Get-MLSharePointServer

· ServerURL - The URL of the SharePoint server to connect to. (Mandatory)

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

· ReadOnly - Indicates that the connection made to the SharePoint site should be read only.
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Get-MLSharePointSite

· SiteURL - The URL of the SharePoint site to connect to. (Mandatory)

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

· AdapterType - The short name of the adapter type you want to use for the connection. Use OM

for a local SharePoint or WS for a remote SharePoint where the Metalogix Extensions Web Service

is installed.

· ReadOnly - Indicates that the connection made to the SharePoint site should be read only.

Get-MLSharePointTenant

· TenantURL - The URL of the SharePoint tenant to connect to. (Mandatory)

· User - A user to connect as, in user@company.onmicrosoft.com format. (Mandatory)

· Password - The password for the user provided. (Mandatory)

· ReadOnly - Indicates that the connection made to the SharePoint tenant should be read-only.

Get-SharePointSiteFromDatabase

· Server - The name of the database server. (Mandatory)

· Database - The name of the SharePoint content database. (Mandatory)

· SiteURL - The server-relative URL of the SharePoint site to connect to.

· User - A user to connect as, in DOMAIN\Login format.

· Password - The password for the user provided.

· HostHeader - A host header for a specified subsite. Use this if you are connecting to a site or

subsite with a host header name.

Refresh-SharePointNode

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.
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· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointFolder

· Folder - The Folder object retrieved by using the Get-MLSharePointFolder Cmdlet. (Mandatory)

· Item - The ListItem object retrieved by using the Get-MLSharePointItem Cmdlet. (Mandatory).

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointItem

· Item - The ListItem object retrieved by using the Get-MLSharePointItem Cmdlet. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.
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· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointList

· List - The list object retrieved by using the Get-MLSharePointList Cmdlet. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Remove-MLSharePointSite

· Site - The site object retrieved by using the Get-MLSharePointSite Cmdlet. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.
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Remove-MLSharePointSiteCollection

· SiteCollection - The Site Collection object retrieved by using the Get-MLSharePointSite Cmdlet.

(Mandatory)

· Server - The parent Server object of the Site Collection, retrieve by using the Get-

MLSharePointServer Cmdlet. (Mandatory)

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.

Search-SharePointSite

· SearchTerm - The search term to use.

· MaxResults - The number of search results to output.

· MatchExactly - Indicates that the search term must match one of the searched fields exactly.

· Recursive - Indicates that data within all subwebs should be included in the search.

· IncludeItems - Indicates that the search results should include items.

· IncludeDocuments - Indicates that the search results should include documents.

· IncludeFolders - Indicates that the search results should include folders.

· IncludeLists - Indicates that the search results should include lists.

· IncludeSites - Indicates that the search results should include sites.

· ContentType - If specified, search results must include this value in their content type name.

· Author - If specified, search results must have been created by an author matching this value.

· Editor - If specified, search results must have been modified by an editor matching this value.
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· CreatedBefore - If specified, search results must have been created before this date.

· CreatedAfter - If specified, search results must have been created after this date.

· ModifiedBefore - If specified, search results must have been modified before this date.

· ModifiedAfter - If specified, search results must have been modified after this date.

· Transformers - The collection of data transformers which the action needs to run. Note that if the passed-in

value for this parameter does not include transformers which are considered mandatory, they will be added
automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is invalid, an

exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the 'JobDatabase'
parameter will take precedence and the job will only be written to the job database.

Update-SharePointSiteCollectionSettings

· SiteCollectionAdmins - A list of login names to be granted site collection administrator privileges.

· QuotaMaximum - An independently defined maximum storage size for this site collection.

· QuotaWarning - An independently defined size at which to send a warning email for this site

collection.

· QuotaID - A quota template ID to use for this site collection.

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically.

· Quiet - If set, the operation will not report progress to the PowerShell console.

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created.

· Source - The source node for the actions.

· Target - The target node for the actions.

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database.
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Metalogix.Jobs.Reporting.Commands

Export-JobHistory

· SqlCeDbFilePath - Specify the path to the SQL database file that contains the Job History data.

(Mandatory)

· ServerName - The name of the SQL Server. (Mandatory)

· DatabaseName - The name of the Job History database. (Mandatory)

· AuthType - Indicates whether to use Integrated (Windows) or SQL Authentication. If not specified

will Integrated Authentication will be used.

· Username - Specify the username for SQL Authentication.

· Password - Specify the password for SQL Authentication.

Metalogix.ERoom.Commands

Copy-eRoomCalendar

· CollisionOptions - Overwrite, rename, or skip on existing calendar with same name. 

· NestedContentOptions - Specify how to handle nested contents: do not migrate, migrate only new

items, migrate into subsite, migrate into current directory with parent name as prefix. 

· UpdateCalendarEvents - Enable/disable updating of existing calendar events with same eRoom ID. 

· LinkCorrectionOptions - Options for Link Correction. 

· MigrationModeOptions - Specifies whether the migration is full or incremental. 

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

· Quiet - If set, the operation will not report progress to the PowerShell console. 

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created. 
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· Source - The source node for the actions. 

· Target - The target node for the actions. 

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database. 

Copy-eRoomContainerAsDocumentLibrary

This is the same as Copy-eRoomContainerAsSite.

Copy-eRoomContainerAsFolder

This is the same as Copy-eRoomContainerAsSite.

Copy-eRoomContainerAsNestedSiteCollection

· Name - The name of the nested site collection. (Mandatory) 

· Path - The managed path in the web application to add the site collection under. (Mandatory) 

· URL - The name of the site collection that is part of the URL. The path appended to the URL

becomes the relative URL to the site collection. (Mandatory) 

· OwnerLogin - The username of the owner. (Mandatory) 

· WebApplicationName - The web application name. (Mandatory) 

· WebTemplateID - The web template ID. (Mandatory) 

· WebTemplateConfig - The web template config. (Mandatory) 

· LanguageCode - The language code. (Mandatory) 

· ReportLocation - The filepath of the nested contents report to be used to migrate the eRoom

container. 

· Description - An optional description of the site collection. 

· SecondaryOwnerLogin - The username of the owner. 
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· ContentDatabaseName - The content database name. If not specified, Metalogix Content Matrix

will attempt to auto-detect it. 

· SetSiteQuota - Set the site quota. 

· QuotaID - The quota ID. 

· QuotaMaximum - The maximum quota in bytes. 

· QuotaWarning - The quota at which the warning will be triggered in bytes. 

· PasteContainerOptions - Paste container options (XML). 

· MigrationModeOptions - Specifies whether the migration is full or incremental. 

· Transformers - The collection of data transformers which the action needs to run. Note that if the

provided value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

· Quiet - If set, the operation will not report progress to the PowerShell console. 

· JobFile - The name of a job file to use for logging. If the file does not exist, it will be created. 

· Source - The source node for the actions. 

· Target - The target node for the actions. 

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database. 

Copy-eRoomContainerAsSite

· CollisionOptions - Overwrite, rename, or skip on existing container with same name. 

· ContentOptions - Specify how to handle nested contents: do not migrate, migrate only new items,

migrate into subsite, migrate into current directory with parent name as prefix. 

· WebTemplateID - The web template ID. 

· WebTemplateConfig - The web template config. 

· LinkCorrectionOptions - Options for Link Correction. 

· CorrectName - Enable/disable automatic replacement of invalid SharePoint characters in name. 



162
Using PowerShell with Content Matrix

Metalogix® Content Matrix eRoom Edition

· CorrectNameCharacter - Specify the replacement character for invalid SharePoint characters in

name. 

· MigrateCalendars - Migrate calendars. 

· CalendarOptions - Calendar options. (XML) 

· MigrateDatabases - Migrate databases. 

· DatabaseOptions - Database options. (XML) 

· MigrateDiscussions - Migrate discussions. 

· DiscussionOptions - Discussion options. (XML) 

· MigrateDocuments - Migrate documents. 

· DocumentOptions - Document options. (XML) 

· MigrateSubFolders - Migrate subfolders. 

· MigrateInboxes - Migrate inboxes. 

· MigrateMail - Migrate mail. 

· InboxAndMailOptions - Inbox and mail options. (XML) 

· MigrateLinks - Migrate links. 

· MigrateNotes - Migrate notes. 

· NoteOptions - Note options. (XML) 

· MigratePolls - Migrate polls. 

· PollOptions - Poll options. (XML) 

· MapUsers - Enable/disable user metadata mappings. 

· MapPermissions - Enable/disable automated eRoom permissions mapping to best-matching

SharePoint role. (Requires -MapUsers) 

· MappingsOptions - User/permission mapping options. 

· MigrationModeOptions - Specifies whether the migration is full or incremental. 

· LinkOptions - Link options. (XML) 

· MigrateTreeViewSetting - Enable/disable migration of the Tree View setting. 
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· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

· Quiet - If set, the operation will not report progress to the PowerShell console. 

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created. 

· Source - The source node for the actions. 

· Target - The target node for the actions. 

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database. 

Copy-eRoomContainerAsSiteCollection

· Name - The name of the site collection. (Mandatory) 

· Description - The description of the site collection. 

· Path - The managed path in the web application to add the site collection under. (Mandatory) 

· URL - The name of the site collection that is part of the URL. The Path appended with the URL

becomes the relative URL to the site collection. (Mandatory) 

· OwnerLogin - The username of the owner. (Mandatory) 

· SecondaryOwnerLogin - The username of the owner. 

· WebApplicationName - The web application name. (Mandatory) 

· ContentDatabaseName - The content database name. If not specified, it will be auto detected. 

· WebTemplateID - The web template ID. (Mandatory) 

· WebTemplateConfig - The web template config. (Mandatory) 

· LanguageCode - The language code. (Mandatory) 

· SetSiteQuota - Set the site quota. 

· QuotaID - The quota ID. 

· QuotaMaximum - The maximum quota (in bytes). 

· QuotaWarning - The quota at which the warning will be triggered (in bytes). 
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· PasteContainerOptions - Paste Container Options (XML). 

· MigrationModeOptions - Specifies whether the migration is full or incremental. 

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

· Quiet - If set, the operation will not report progress to the PowerShell console. 

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created. 

· Source - The source node for the actions. 

· Target - The target node for the actions. 

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database. 

Copy-eRoomDocument

· CollisionOptions - Overwrite, rename, or skip on existing file with same name. 

· LinkCorrectionOptions - Options for Link Correction. 

· CorrectName - Enable/disable automatic replacement of invalid SharePoint characters in name. 

· CorrectNameCharacter - Specify the replacement character for invalid SharePoint characters in

name. 

· MapCustomFields - Map Custom eRoom Fields to SharePoint Fields (limited support). 

· MigrateVersions - Migrate document versions. 

· EnableVersioning - Enabled: migrate versions to all target SharePoint document libraries. Disabled:

migrate versions to only SharePoint document libraries that support document versioning. (DEFAULT:

True) 

· MigrateAllVersions - Migrate all document versions. 

· MigrateXVersions - Migrate the latest 'x' document versions. 

· NumberOfVersions - Specify the 'x' document versions to migrate. 

· MapUsers - Enable/disable user metadata mappings. 
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· MapPermissions - Enable/disable automated eRoom permissions mapping to best-matching

SharePoint role. (Requires -MapUsers) 

· MappingsOptions - User/permission mapping options. 

· MigrateContentTypes - Apply content types. 

· ContentTypes - List of content types to apply. 

· MigrationModeOptions - Specifies whether the migration is full or incremental. 

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

· Quiet - If set, the operation will not report progress to the PowerShell console. 

· JobFile - The name of a job file to use for logging. If the file does not exist it will be created. 

· Source - The source node for the actions. 

· Target - The target node for the actions. 

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database. 

Copy-eRoomLinkCorrectionAtItemLevel

· Target - Specifies the target SharePoint item where link correction is to be performed. (Mandatory) 

· Source - Specifies the eRoom source. 

· ExportToCSV - Indicates whether to export the corrected links to a CSV file. 

· ExportToCSVPath - The filepath, including file name, of the CSV file in which the corrected links are

to be stored. 

· Transformers - The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

· Jobfile - The filepath, including file name, of a job file to use for logging. 
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Copy-eRoomLinkCorrectionAtListLevel

This is the same as Copy-eRoomLinkCorrectionAtItemLevel, except Target should specify the target

SharePoint list (instead of target SharePoint item) where link correction is to be performed. Target is

still mandatory.

Copy-eRoomLinkCorrectionAtWebLevel

This is the same as Copy-eRoomLinkCorrectionAtItemLevel, except Target should specify the target

SharePoint web (instead of target SharePoint item) where link correction is to be performed. Target is

still mandatory.

Get-eRoomNode

· Connection - The eRoom connection to get node from. (Mandatory) 

· NodePath - The path to the eRoom node as defined in eRoom Edition. (Mandatory) 

Get-NestedContentsReport

· ReportName - Specifies the name of the nested contents report CSV file. (Mandatory) 

· OutputFolder - The folder where the nested contents report CSV file is to be saved. (Mandatory) 

· Overwrite - Specifies whether or not to overwrite any existing files if a conflict is encountered. 

· Recursive - Indicates that data within all subwebs should be included in the search. 

· Transformers - The collection of data transformers which the action needs to run. Note that if the

provided value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

· Quiet - If set, the operation will not report progress to the PowerShell console. 

· JobFile - The name of a job file to use for logging. If the file does not exist, it will be created. 

· Source - The source node for the actions. 

· Target - The target node for the actions. 
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· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database. 

Get-NestedContentsUrlLengthReport

This is the same as Get-NestedContentsReport, with the following exceptions:

· No Recursive property. 

· Additional property: SiteCollectionURL - The Site Collection URL that the report will be generated

with respect to. (Mandatory) 

· The Target parameter is Mandatory.

Get-PreMigrationCheck

· CheckName: Check name for illegal SharePoint character. 

· CheckSize: Check documents size does not exceed maximum file size. 

· CheckUnsupported: Check for unsupported eRoom content types. 

· CheckURLAsDocLib: Check URL length when pasting as document library. 

· CheckURLAsSite: Check URL length when pasting as site. 

· ContentOptions:Content Options e.g. Include SubFolders, Include Database, Include Documents etc. 

· CsvFileName: Output csv report file name. 

· JobDatabase - The connection string of a jobs database to use for logging. If the connection string is

invalid, an exception is thrown. If both 'JobFile' and 'JobDatabase' parameters are specified, then the

'JobDatabase' parameter will take precedence and the job will only be written to the job database. 

· JobFile - The name of a job file to use for logging. If the file does not exist, it will be created. 

· OutputCsv: Save output report files to output folder or not. 

· OutputFolder: Specify path of output report files. 

· Quiet - If set, the operation will not report progress to the PowerShell console. 

· Source - The source node for the actions. 
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· Target - The target node for the actions. 

· TargetLocation: Target SiteCollection/Site/Document library location based on which URL length

calculated. 

· TargetURL: URL of SiteCollection/Site. 

· Transformers: The collection of data transformers which the action needs to run. Note that if the

passed-in value for this parameter does not include transformers which are considered mandatory,

they will be added automatically. 

New-eRoomConnection

· ServerURL - The URL of the eRoom server to connect to. (Mandatory) 

· ServerXmlURL - The URL of the eRoom server to connect to. (Mandatory) 

· User - A user to connect as, in DOMAIN\Login format. (Mandatory) 

· Password - The password for the user provided. (Mandatory) 
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Modifying Content Matrix
Configuration and Settings

14

You can configure and customize a number of Metalogix Content Matrix settings, including:

· the use of encrypted SQL database connections

· proxy settings

· available actions and events

· default settings in configuration variable files

· client-side settings

· resource utilization settings

Using Encrypted SQL Database Connections

When connecting to a full SQL Content Matrix Job Database, you are given the option to connect using

TLS/SSL encryption.  

NOTE:  Content Matrix can use any version of TLS that is compatible with .NET Framework 4.7.2.  The

default version of TLS used by the operating system on the machine from which you are connecting

will be used by Content Matrix.    

The encrypted connection can use either:

· a self-signed certificate or a trusted certificate from the third party authority (refer to the Microsoft

article https://docs.microsoft.c om/en-us/sql/database-engine/configure-windows/enable-

https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/enable-encrypted-connections-to-the-database-engine?view=sql-server-ver15
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encrypted-connections-to-the-database-engine?view=sql-server-ver15 for instructions on

configuring an encrypted connection using a certificate)

OR 

· a SQL-generated certificate,  which does not require configuration.

NOTE:  If a trusted certificate is used, it is not necessary to check the Trust Server Certificate box. 

However,  if the box is not checked and the certificate is not trusted, the following message will

display:

In this case, the Trust Server Certificate box must be checked in order to continue the connection.

Configuring Proxy Settings

In most cases Metalogix Content Matrix can automatically connect to SharePoint and authenticate

license keys, through an environment's proxy setting, However, in some cases the proxy may need to

be configured within Metalogix Content Matrix. In these cases users can specify the proxy settings

though the connecting dialog. 

There are two basic places where this proxy setting can be configured. The first of these is when

activating a license key, and the second when connecting to SharePoint. The  dialogs for these options

look slightly different, and the when you are using a proxy to connect to SharePoint, you have the

additional option to Import Proxy from Internet Explorer.

https://docs.microsoft.com/en-us/sql/database-engine/configure-windows/enable-encrypted-connections-to-the-database-engine?view=sql-server-ver15
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NOTE:  For information on setting proxy information when connecting to eRoom, see Connecting to

eRoom.

To configure proxy settings:

1. In the Proxy server dialog, check the Enable proxy box.

2. Use the information in the following table to determine the appropriate action to take.

If ... Then ...

you want to

manually enter

proxy information

A. Select Enter Manually.

B. Enter the Server name (or IP) and Port for the proxy. 

C. Specify the credentials to be used when connecting to the target server.

The Windows authenticated credentials of the current user will be

selected by default. You can specify alternate SharePoint credentials by

clicking the Different user radio button, and entering an alternate

username and password.

Internet Explorer

has been

configured to use

a proxy server via

a proxy auto-

configuration

(.PAC) file and you

want  to connect

to SharePoint

using this method

select Import Proxy from Internet Explorer.

NOTE:  This option is currently available only when connecting to

SharePoint.

Refer to the Microsoft article Auto proxy configuration settings for Internet

Explorer for more information.

https://docs.microsoft.com/en-us/internet-explorer/ie11-deploy-guide/auto-proxy-configuration-settings-for-ie11
https://docs.microsoft.com/en-us/internet-explorer/ie11-deploy-guide/auto-proxy-configuration-settings-for-ie11
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3. If you accessed the dialog from the License Activation dialog, click [Set].

NOTE:  If this method does not seem to be working, you can manually configure Metalogix Content

Matrix to use a proxy setting.  See Manually Configuring Proxy Settings.

Manually Configuring Proxy Settings

If, for some reason, Metalogix Content Matrix cannot connect through a proxy, then the proxy settings

can be configured through the Metalogix Content Matrix UI. If you are not able to configure the proxy

settings through the product's UI for some reason, it can be configured manually. The below directions

should help you manually configure some explicit proxy settings, enabling the product to work with

your proxy.

To manually configure proxy settings:

1. Open the Metalogix Content Matrix Console and add a connection to the desired SharePoint

location.

2. After a connection has been added, close Metalogix Content Matrix.

3. Open the ActiveConnections.xml file, which can be found in the following locations, in a text

editor:

C:\Users\<USER>\AppData\Roaming\Metalogix\Metalogix Content Matrix Console - <Product>

Edition

Within the XML file there is a <Connection /> XML element for each added connection. In order for

proxy settings to be added to a connection, another element needs to be added inside the

connection XML. The added element should be named Proxy, and it should have an attribute

named URL. The value for this URL attribute should be the actual URL for the proxy that will be

used.

For example, if we are trying to add a proxy connection to the following node:

<Connection NodeType="Metalogix.SharePoint.SPWeb, Metalogix.SharePoint,

Version=1.0.0.0, Culture=neutral, PublicKeyToken=3b240fac3e39fc03"

AdapterType="WS" URL=http://SharePoint2010 />

We would add: <Proxy URL="http://metalogixproxy:8000/" />. So the end result

would be:

<Connection NodeType="Metalogix.SharePoint.SPWeb, Metalogix.SharePoint,

Version=1.0.0.0, Culture=neutral, PublicKeyToken=3b240fac3e39fc03"

AdapterType="WS" URL="http://SharePoint2010">

<Proxy URL="http://metalogixproxy:8000/" />

</Connection>

If the proxy connection requires a user name and password that differ from your normal logged in

Windows credentials, then these can also be specified in the Proxy element. The attribute
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UserName can be used to enter a user name (in domain\user format), and an attribute named

Password can be used to enter the password value.

In this case the Proxy value <Proxy URL="http://metalogixproxy:8000/" /> would

become:

<Proxy URL="http://metalogixproxy:8000/" UserName="DOMAIN\ProxyUser"
Password="ProxyPassword" />

4. After these values have been entered to the desired connection, save and close the

ActiveConnections.xml file.

5. Re-launch Metalogix Content Matrix. 

The connection using the proxy should now be configured, and the connection should be

established and working.

Restricting Available Actions and Suppressing
Events

Metalogix Content Matrix provides you with the ability to control what actions are available to the

client application through configuring on the SharePoint server. Product behaviors can be restricted

along three dimensions: 

· Available actions

· Unrestricted users

· Suppressed events

Configuring the behavior of the Metalogix Content Matrix client from target SharePoint servers

requires that an XML configuration file be added to the target SharePoint server web application

directory. The XML file must be named ServerAdapterConfig.xml and placed in the ML folder directory

located within the SharePoint hive (this is the same directory where the Metalogix SharePoint

Extensions Web Service files are). Below are some examples of the typical directory location of the ML

folder, depending on SharePoint product version and configuration:

· SharePoint 2013: - C:\Program Files\Common Files\Microsoft Shared\Web Server

Extensions\15\isapi\ML

· SharePoint 2016: - C:\Program Files\Common Files\Microsoft Shared\Web Server

Extensions\16\isapi\ML

· SharePoint 2019:-  C:\Program Files\Common Files\Microsoft Shared\Web Server

Extensions\16\isapi\ML
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ServerAdapterConfig.xml File Format

Below is an example of the simple XML format required for ServerAdapterConfig.xml.

    <ServerAdapterConfig>

      <DisabledActions>

        <Action>Metalogix.SharePoint.Actions.Migration.PasteSiteActi
on</Action>

        <Action>Metalogix.SharePoint.Actions.Migration.PasteSiteColl
ectionAction</Action>

        <Action>Metalogix.SharePoint.Actions.Migration.PasteSiteList
s</Action>

     <Action>Metalogix.SharePoint.Actions.Migration.CopyRoleAssignme
ntsAction</Action>

     <Action>Metalogix.SharePoint.Actions.Migration.CopyWorkflowAsso
ciationsAction</Action>

     <Action>Metalogix.SharePoint.Actions.Migration.PasteFolderActio
n</Action>

      </DisabledActions>

      <ExemptUsers>

        <User>METALOGIX\geordie</User>

        <User>METALOGIX\julien</User>

      </ExemptUsers>

      <SuppressEvents>False</SuppressEvents>

    </ServerAdapterConfig>

There are three main sections within the root ServerAdapterConfig section of this XML:

· DisabledActions: This section defines the set of actions that cannot be run on the client.  See

Actions That Can Be Disabled on the Server Side for a complete list.

· ExemptUsers: This section defines the set of users by user name who are exempt from any

DisabledActions. In other words, a user in the ExemptUsers is not subject to any restrictions

imposed on Metalogix Content Matrix clients by the DisableActions section.

· SuppressEvents: This section defines if any of SharePoint's event receivers are suppressed/disabled

during a migration and then restarted once the action is complete. The value for this section is set

to "True" by default, but can be manually configured if want event suppression to be disabled.

Suppression of event receivers allows Metalogix Content Matrix to avoid any potential

concurrency issues when migrating (mainly with regards to workflows).
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Actions That Can Be Disabled

Many of the SharePoint related actions available in the Metalogix Content Matrix Console can be

disabled on the server side. The table below lists the complete set of client actions that can be disabled

from the server and provides the format of the action name required in the DisabledActions section of

the ServerAdapaterCongifuration.xml file.

NOTE:  When an action that is available via the client UI is disabled on the server, it will be visible in

client menus but disabled.

Action Configuration File Format

Change Global

Navigation Settings

Metalogix.SharePoint.Actions.Administration.ChangeGlobalNavigationActio

n

Change Quick Launch Metalogix.SharePoint.Actions.Administration.ChangeQuickLaunchAction

Create Folder Metalogix.SharePoint.Actions.Administration.CreateFolderAction

Create List Metalogix.SharePoint.Actions.Administration.CreateListAction

Create List From XML Metalogix.SharePoint.Actions.Administration.CreateListFromXMLAction

Create Site Metalogix.SharePoint.Actions.Administration.CreateSiteAction

Create Site Collection Metalogix.SharePoint.Actions.Administration.CreateSiteCollection

Create Site Collection

in Self-Service Mode

Metalogix.SharePoint.Actions.Administration.CreateSiteCollectionSelfServic

eMode

Delete Discussion Item Metalogix.SharePoint.Actions.Administration.DeleteDiscussionItem

Delete Item Metalogix.SharePoint.Actions.Administration.DeleteFolder

Delete List Metalogix.SharePoint.Actions.Administration.DeleteItem

Delete Site Metalogix.SharePoint.Actions.Administration.DeleteList

Delete Site Collection Metalogix.SharePoint.Actions.Administration.DeleteSite

Export Doc Items Metalogix.SharePoint.Actions.Administration.DeleteSiteCollection

Publish Documents

and Pages

Metalogix.SharePoint.Actions.Administration.PublishDocumentsandPagesAc

tion

Update Site Collection

Settings

Metalogix.SharePoint.Actions.Administration.UpdateSiteCollectionSettingsA

ction

Add Role Assignments Metalogix.SharePoint.Actions.Migration.AddRoleAssignmentsAction

Copy Folder

Permissions
Metalogix.SharePoint.Actions.Migration.CopyFolderPermissions

Copy Item Alerts Metalogix.SharePoint.Actions.Migration.CopyItemAlertsAction
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Action Configuration File Format

Copy List Alerts Metalogix.SharePoint.Actions.Migration.CopyListAlertsAction

Copy List Permissions Metalogix.SharePoint.Actions.Migration.CopyListPermissions

Copy List Role

Assignments
Metalogix.SharePoint.Actions.Migration.CopyListRoleAssignments

Paste Web Parts Metalogix.SharePoint.Actions.Migration.CopyWebPartsAction

Paste Master Page

Gallery
Metalogix.SharePoint.Actions.Migration.CopyMasterPageGalleryAction

Paste Content Types Metalogix.SharePoint.Actions.Migration.CopySiteContentTypesAction

Paste All Subsites Metalogix.SharePoint.Actions.Migration.CopySubSitesAction

Copy Web Alerts Metalogix.SharePoint.Actions.Migration.CopyWebAlertsAction

Copy Web Permissions Metalogix.SharePoint.Actions.Migration.CopyWebPermissions

Paste Workflow

Associations
Metalogix.SharePoint.Actions.Migration.CopyWorkflowAssociationsAction

Paste All List Items Metalogix.SharePoint.Actions.Migration.PasteAllListItemsAction

Paste All List Items

into Items View

Metalogix.SharePoint.Actions.Migration.PasteAllListItemsIntoItemsViewActi

on

Paste Audiences Metalogix.SharePoint.Actions.Migration.PasteAudiencesAction

Paste Default Web

Part Page
Metalogix.SharePoint.Actions.Migration.PasteDefaultWebPartPageAction

Paste Duplicate List Metalogix.SharePoint.Actions.Migration.PasteDuplicateListAction

Paste Duplicate Site Metalogix.SharePoint.Actions.Migration.PasteDuplicateSiteAction

Paste Folder Metalogix.SharePoint.Actions.Migration.PasteFolderAction

Paste List Metalogix.SharePoint.Actions.Migration.PasteListAction

Paste List as Folder Metalogix.SharePoint.Actions.Migration.PasteListAsFolderAction

Paste List Email

Notifications
Metalogix.SharePoint.Actions.Migration.PasteListEmailNotificationAction

Paste List Item Metalogix.SharePoint.Actions.Migration.PasteListItemAction

Paste List Item into

Items View
Metalogix.SharePoint.Actions.Migration.PasteListItemIntoItemsViewAction

Paste My Sites Metalogix.SharePoint.Actions.Migration.PasteMySitesAction

Paste Navigation Metalogix.SharePoint.Actions.Migration.PasteNavigationAction

Paste Roles Metalogix.SharePoint.Actions.Migration.PasteRolesAction
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Action Configuration File Format

Paste Site Metalogix.SharePoint.Actions.Migration.PasteSiteAction

Paste Site Collection Metalogix.SharePoint.Actions.Migration.PasteSiteCollectionAction

Paste Site Content Metalogix.SharePoint.Actions.Migration.PasteSiteContentAction

Paste Site Lists Metalogix.SharePoint.Actions.Migration.PasteSiteLists

Remove Role

Assignments
Metalogix.SharePoint.Actions.Migration.RemoveRoleAssignmentAction

Event Suppression Metalogix.SharePoint.Actions.Migration.SuppressEvents

Note that many of the above listed actions are used by other actions. When a given action is enabled,

but one or more of its sub-action is disabled, the sub-actions will not run. When a user attempts to run

an action for which sub-actions are disabled, they will be notified with a dialog similar to the following:

Configuration Variable Files

Metalogix Content Matrix uses a set of configuration variable files behind the scenes to help set and

manage settings for all of the Metalogix Content Matrix Editions. This section explains what the

configuration variable files are, their general behavior, and where to find them.

Configuration variables are contained in the following three files:

· EnvironmentSettings.xml

· UserSettings.xml

· ApplicationSettings.xml

Some settings can be configured for all Product Editions, while other settings are limited to individual

Product Editions.

Any settings that are configured in multiple files will be scoped to the lowest level (either in the

"UserSettings.xml" file or the "ApplicationSettings.xml" file), including values that are pulled from the

old EnvironmentSettings.xml file.
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IMPORTANT:  Make sure the Content Matrix Console is closed when making updates to configuration

variable files.

EnvironmentSettings.xml File

This file allows users to configure general settings for all Product Editions. This means that these

settings only need to be set in a single file, either for all users of the machine (if users are required to be

local administrators) or for each individual user of the machine (if users are not required to be local

administrators) and can be found in one of the following locations:

· If you are required to be a local administrator on the machine where Content Matrix is installed: C:

\ProgramData\Metalogix

OR

· If you are not required to be a local administrator on the machine where Content Matrix is installed: 

C:\Users\<username>\AppData\Roaming\Metalogix\Common

UserSettings.xml File

This file allows users to configure general settings for all Product Editions for a specific user account

(the logged in account). This means that these settings will be configured for all Product Editions, but

only for the current user account. If another user would like to configure these same settings to work

for them, they must be configured manually under the appropriate user account.  It can be found in the

following location:

C:\Users\<USER>\AppData\Roaming\Metalogix

ApplicationSettings.xml File

This file allows users to configure settings that are limited to the specific Product Edition of Metalogix

Content Matrix Console, for a specific user account (the logged in account). This means that each

Product Edition, for every user account, must be configuredindividually. While the

"ApplicationSettings.xml" file for each Product Edition can contain some of the same settings, there are

some settings that are Edition specific (for example, some settings may only work for eRoom Edition,

so they will only be available in eRoom Edition). Any settings that are replicated through various

version of the file will only be applied to the specific Edition.

For example, the "AllowCheckResults" setting is available in every "ApplicationSettings.xml" file, but it

must be set on an individual Product Edition basis. Setting it for SharePoint Edition will not configure it

for eRoom Edition.  It can be found in the following location: 

C:\Users\<USER>\AppData\Roaming\Metalogix\Content Matrix Console - <Product> Edition.
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Changing Resource Utilization Settings

How many threads can be used simultaneously per job in Metalogix Content Matrix is controlled by the

Edit Resource Utilization Settings option, which is accessible from the Settings ribbon at the top of the

Console UI.

If the option is clicked, a dialog containing a slider will appear that will allow control of the number of

threads available within a single action. If the slider is moved all the way to the left, this will turn off

multithreading and only allow a single thread to be used during the action. (For more information on

threading, refer to the Microsoft article About Processes and Threads.)

NOTE:  Turning off multithreading in this way can be a valuable way of troubleshooting whether

multithreading is causing issues.

If the slider is left in the middle, it will allow twice the number of processors in threads to be created

per action. For example, if the machine running Metalogix Content Matrix has a two core CPU, four

threads will be able to be used if the slider is in the below state:

Moving the slider farther to the right will allow more threads to be used, but can potentially overwhelm

system resources.  This could lead to potential errors if the system resources cannot handle the data

being migrated.  There is a chance that if the speed is too high, you would see a slowdown in the

overall migration, because the migration is trying to run actions faster than the resources properly

allow.

While this value can be set through the Content Matrix Console, you can also set it through the back

end, if the UI setting does not seem to be working for you. Please contact Quest Support for more

information on this back end setting.

https://docs.microsoft.com/en-us/windows/win32/procthread/about-processes-and-threads
https://support.quest.com
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Frequently Asked Questions

15

This section answers some of the most frequently asked questions about using Metalogix Content

Matrix.

Images Not Migrating with eRoom Content

Question
I have migrated some content from eRoom, but the images within the content do not seem to have

been migrated. What could be the issue, and what are the possible solutions?

Answer
In eRoom, images are generally stored in Database lists. When eRoom Edition migrates these images it

uses an HTML method.

If images haven't migrated after the Database has been migrated, the first thing to do is check the log

file for any warnings or errors for the image item. Search through the log for an image item that failed

to migrate, and open its Log Item Details, and go to the Error Details tab. In the Error Details you can

see the URL that eRoom Edition used to fetch the image from (not the SourceURL). Copy the image

URL, and enter it into a web browser to see if it works (if the image is displayed).

The most common cause of images not migrating, is that this URL isn't completely correct. In some

cases there is an extra "bit" added to the URL. This is usually an extra "/eRoom" added near the root of

the URL. Remove this extra bit and try to view the image through the URL again. If it works then

proceed to the next step. If not, continue adjusting the URL until you find one the allows your browser

to view the image.

Once you have the correct URL, make a new connection to eRoom using the root address of this image

URL, then try re-migrating your image.

If the issue persists after this, please contact Quest Support.

https://support.quest.com
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Permission Mapping Between eRoom and
SharePoint

Question
How are permissions mapped between eRoom and SharePoint?

Answer

The following table lists the SharePoint permission mappings for various permission scenarios in

eRoom:

eRoom Access

Mapped Permission Level

in SharePoint
Notes

Read: anyone

Write: any member who can get to it

Target will have inherited

permission

Target will have default

permissions if we paste

folder as a site collection

Read: anyone

Write: coordinators only

Visitors and Members

granted "Read" permission

level

Coordinators ranted "Full

Control" permission level

For nested items, read

rights are inherited from

their parent item

Read: anyone

Write: coordinators and specific members

Visitors and Members

granted "Read" permission

level

Coordinators granted "Full

Control" permission level

Specific members granted

"Contribute" permission

level

For nested items, read

rights are inherited from

their parent item

Read: coordinators only

Write: any member who can get to it

Coordinators granted "Full

Control" permission level

In this case, Coordinators

is the only default group

created on the SharePoint

target

Read: coordinators only

Write: coordinators only

Coordinators granted "Full

Control" permission level

In this case, Coordinators

is the only default group

created on the SharePoint

target

Read: coordinators only

Write: coordinators and specific members

Coordinators granted "Full

Control" permission level

In this case, Coordinators

is the only default group

created on the SharePoint

target
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eRoom Access

Mapped Permission Level

in SharePoint
Notes

Specific members granted

"Contribute" permission

level

Read: coordinators and specific members

Write: any member who can get to it

Coordinators granted "Full

Control" permission level

Specific members granted

"Contribute" permission

level

In this case, Coordinators

is the only default group

created on the SharePoint

target

Read: coordinators and specific members

Write: coordinators only

Coordinators granted "Full

Control" permission level

Specific members granted

"Read" permission level

In this case, Coordinators

is the only default group

created on the SharePoint

target

Read: coordinators and specific members

Write: coordinators and specific members

Coordinators granted "Full

Control" permission level

Specific members granted

"Contribute" and "Read"

permission levels

In this case, Coordinators

is the only default group

created on the SharePoint

target

DB_Owner Permission

Question

Are read and write permissions to the SharePoint content database sufficient for the Metalogix

Extensions Web Service to perform migration?

Answer

As you may know, the Metalogix Extensions Web Service requires read and write permissions to the

Content Database, according to a Microsoft KB article (http://support.microsoft.com/kb/935751.

However, this is only a solution if you have encountered the message "Unhandled Exception:

system.IO.FileNotFoundException" when using the SharePoint object model. We have found that few

users have reported this issue, since the Web Service account is usually granted the sysadmin server

role, which has complete control over all database functions.

After some internal testing we have determined that the Web Service installing account requires more

than read and write permissions to function without database errors.

1. "db_owner" rights to the SharePoint Content Database is required.

http://support.microsoft.com/kb/935751
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If the Web Service account does not have the db_owner right to the SharePoint Content Database,

Metalogix Content Matrix will not be able to migrate list items using the Web Service, and may

receive one of the following errors:

4/19/2010 7:13:53 PM Error copying list item: 1/1 (id: 1, title: Get Started with Windows SharePoint

Services!): Service Error: [MLSPService could not add items: MLSPServiceMethods.AddListItems()

Failed: Cannot open database "WSS_Content" requested by the login. The login failed.

4/20/2010 10:21:01 AM Error copying list item: 1/2 (id: 1, title: Get Started with Windows

SharePoint Services!): Service Error: [MLSPService could not add items:

MLSPServiceMethods.AddListItems() Failed: Operation aborted (Exception from HRESULT:

0x80004004 (E_ABORT))

2. "db_owner" or "WSS_Content_Application_Pools" rights to the SharePoint Admin Content

Database is required.

If the Web Service installing account does not have db_owner or WSS_Content_Application_Pools

rights to the SharePoint_AdminContent, Metalogix Content Matrix will not be able to create/paste

site collections, and will receive an error.

With these cases in mind we have determined that the Metalogix Extensions Web Service account

should be granter the db_owner permission rights, at a minimum, to allow Metalogix Content

Matrix to correctly migrate content to the target SharePoint instance.

Keyboard Shortcuts

Question

Are there any keyboard shortcuts in the Metalogix Content Matrix Console? If so, what are they?

Answer

Yes, there are a few basic keyboard shortcuts within the Metalogix Content Matrix Console. They are:

· Ctrl + A - This will Select All items within the Items view or in any of the logging sections (such as the

Job List section or the Log Viewer).

· Ctrl + C - This will Copy any selected item(s) within Explorer view or Item view, including sites and

lists. It will also copy any selected item(s) or information within the logging sections (such as the Job

List section or the Log Viewer).

· Ctrl + V - This will Paste any selected item(s) within Explorer view or Item view, including sites and

lists. It will also paste any selected item(s) or information within the logging sections (such as the Job

List section or the Log Viewer).
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· F2 key - This will Rename any selected job list in the Job List in the main UI. Simply select the desired

job list, in the Job List section, press F2, and type in the new name for the job list.

Activating the License Key Silently

Question

I would like to activate my license outside of the Content Matrix Console.  Is that possible?

Answer

You can activate your Content Matrix license using PowerShell.  Follow the steps below.

NOTE:  This method can only be used for online activations.

1. Open the Content Matrix PowerShell Console.

2. Run the following cmdlet, which includes specifying the Content Matrix Console Edition for which

you want to activate the license.

if (Get-Command Set-MetalogixJobPrerequisites -ErrorAction
SilentlyContinue){ Set-MetalogixJobPrerequisites -Value "Content Matrix
Console - <Edition_name>" }

NOTE:  Valid values for <Edition Name> are SharePoint Edition, eRoom Edition, Public Folder

Edition.  If you license covers more than one Edition, it is only necessary to activate one.  The

license activation will automatically be applied to any other Edition for which you are licensed.

3. Run the Set-MetalogixLicense cmdlet.  Note that additional parameters are required if a proxy

server is used.

Without proxy server:

Set-MetalogixLicense -Key "<license_key>"

With proxy server:

Set-MetalogixLicense -Key "<license_key>" -ServerUrl
"<proxy_server_IP_addres>" -Port "<proxy_port_number>" -UserName
"<user_account>" -Password "<password>"

NOTE:  When entering the license key, include hyphens.
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License Key Troubleshooting

Question

I have been unable to get Metalogix Content Matrix to recognize my license key. When I copy and

paste it into the box, I get a "the specified license key is invalid" error.

Answer

Here are some things to check:

· Make sure that the license covers the product edition.  (For example, if you are licensed for

SharePoint Edition and Public Folder Edition and try to activate the license for eRoom Edition, the

invalid error will display.) 

· Confirm that the license you are installing is for the correct application versions of Metalogix

Content Matrix. Contact Quest to verify that it is.

· When performing an offline key activation, make sure to enter the long key in its entirety, including

the "=" symbol at the end of it.

· Verify that you have write privileges to the registry. The installer will fail if the registry is locked. In

some cases there may be a group policy that is preventing the user from adding the key in the

registry, despite the user having the correct permissions.

· Some versions of Windows will automatically block write access to the registry under the user

account, even if that account has write access to the registry. In this case you can go to the

application installation folder, right click on the application .exe file, and choose 'Run as

Administrator'. Then re-enter the license key.

Using Proxies, Load Balancing or Alternate
Access Mappings

Question

How does Metalogix Content Matrix deal with environments that use proxies, load balancing and/or

alternate access mappings (AAM)?

https://www.quest.com/company/contact-us.aspx
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Answer

Metalogix Content Matrix Console should not run into any issues with these three things. Metalogix

Content Matrix uses the Metalogix Extensions Web Service (MEWS), which deploys over a whole farm

and functions identically to a regular SharePoint web service. SharePoint web service's get the benefits

of IIS redirection, proxy pushing, and anything else that SharePoint can utilize, such as Alternate Access

Mappings (AAM). Since the Metalogix Extensions Web Service acts the same as a SharePoint web

service it also gets all of these benefits.

In the case for load balanced environments the Metalogix Extensions Web Service would need to be

deployed through the target side SharePoint farm. When the Web Service is installed it automatically

gets deployed to all the SharePoint instances within that farm, as a SharePoint solution. Once the Web

Service is installed on the target server, then load balancing should no longer be an issue.

There are, however, some cases where proxy settings may not work correctly by default. In these cases

it is possible to set some specific proxy settings for the specified connection. Please see the

Configuring Proxy Settings page for more details, or the Manually Configuring Proxy Settings page if

the proxy settings need to be manually configured.

Changing a Job Configuration for Multiple Files

Question

Is it possible to change the configuration for multiple job files at one time in the Job List section of

Metalogix Content Matrix?

Answer

Yes, this is possible. Most users will only need to change the configuration of a single job in the Job List

section, but it is possible to change the configuration for multiple jobs at one time.

In order to modify the configuration for multiple job files at one, select all of the jobs in the Job List

section. Once all of the desired jobs are selected there are two methods that can be used to access the

configuration dialog. The first is to click the Change Configuration button at the top of the Job List,

and the second method is to open the context (right-click) menu, and select the Change configuration

for selected jobs option.

The behavior for changing the configuration of multiple files at once changes slightly depending on the

version of Metalogix Content Matrix Console that is being used.

Behavior in Versions 6.1.00 and Later
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When changing the configuration for multiple files that use the same type of action at once, only

settings that are changed during the re-configuration will be pushed into all of the selected jobs. This

means that even if all of the jobs contain different settings, they will all still contain these different

settings after the configurations have been modified. Only the settings that were re-configured will be

changed (to whatever setting they were changed to).

Let's look at the example of three "Paste Site" jobs that are previously configured, and each has a

different Rename action applied to it as well as a few various other differences in selected options.

When the Change Configuration is applied to all three at once, only the settings that were

reconfigured will be affected. So if the web part options were changed, then those options will be

applied to all three jobs, but each will still retain their original Rename setting, and any other settings

that were configured even if there are differences.

Behavior in Versions 6.0.0201 and Earlier

When changing the configuration for multiple files that use the same type of action at once, all of the

selected files will have the options for the first job in the Job List section pushed into them, regardless

of any other setting the previously used. Basically, all of the jobs after the first select job in the Job List

will be modified to use all of the settings from the Change Configuration dialog.

Let's look at the example of three "Paste Site" jobs that are previously configured, and each has a

different Rename action applied to it as well as a few various other differences in selected options.

When the Change Configuration is applied to all three at once, all of the configuration options that are

set for the first of the selected jobs in the Job List will be pushed to the two remaining jobs. These two

remaining jobs would then use all of the exact same configuration options as the first job, including the

values for the rename options. Any of the previous settings for the two remaining jobs would be lost

(because they are replaced with the first jobs configuration options).

SharePoint 2013 and 2016 Site Collection
Creation Issue

Question

I have been trying to create a new Site Collection in SharePoint 2013 or later through Metalogix

Content Matrix but I have been encountering issues. Why is this happening? and what can I do about it?

Answer

Starting with SharePoint 2013, most web applications use claims authentication, but the Central

Administration web application that manages the server level settings uses Classic authentication. When

Metalogix Content Matrix Console connects to a SharePoint server it has to authenticate through a

web application. When connected to a SharePoint 2013 or later web application that uses Claims

authentication, SharePoint itself can have trouble recognizing that the accessing User account has

permissions in the web application areas that are managed by Classic authentication. This is also true if
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connected to a web application that uses Classic authentication, if trying to access an area managed by

Claims authentication.

In SharePoint 2013 and later, the permissions to create Site Collections is managed by Classic

authentication, so if connected through a Claims authentication web application users will receive a

"401 Unauthorized" error message when trying to create a new Site Collection. This happens even if

the user account has all of the appropriate permissions. If connecting through a Classic authentication

web application, users will receive permission errors when trying to set any settings on a Site Collection

that uses a Claims authentication web application, after the Site Collection is created.

From internal testing, we have determined that SharePoint 2013 or later connections
that use the Local Object Model connection will not run into this issue. This is because
the Local OM connection type does not run authentication through IIS, which appears
to be a trigger point for the authentication issues.

From testing we have also determined that you are still able to create SharePoint 2013

or later Site Collections when using the Remote OM connection type, but in order to do

this Metalogix Content Matrix Console must elevate your permissions for the creation

step. Before elevating any credentials, Metalogix Content Matrix Console will run a

preliminary check to ensure the migrating user has enough permissions initially to be

able to use the elevated Site Collection creation. In order for these elevated

permissions to be used, the migrating user account must explicitly (by name) have "Full

Control" permissions on the Web Application that the Site Collection is being created

on.

In the Remote OM connection case users can also create a Site Collection within any

web application if they are a member of the Farm Administrator group in SharePoint

and they are connected to Central Administration as a farm connection.

Possible Errors when Creating Site Collection in SharePoint 2013
or later

Below is a list of errors (and their explanations) that you might encounter when trying to create Site

Collections in SharePoint through Metalogix Content Matrix Console.

· Error Message 1 - Unable to obtain Web Application '<web application name>'.

Explanation/Resolution - Metalogix Content Matrix is unable to find the web application. This

should not occur unless a serious issue within SharePoint has occurred from the time the Site

Collection configuration dialog was displayed, and the call to the Metalogix Extensions Web Service

(for remote OM connections) was made to perform the Site Collection creation. Check your

SharePoint environment, and resolve any issues. Then try again.

· Error Message2 - Migrating user '<migrating user>' requires explicit Full Control on the web

application where the site collection is intented to be created. If the migrating user is a member of

the Farm Administrators group then connect to the Central Administration site and try again.
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Explanation/Resolution - The migrating user has read permissions on the web application (using a

farm or web connection type) that they're connected to, but does not have full control on the web

application that they are trying to create the Site Collection in. To resolve this, the migrating user

account must be added explicitly (by name) with Full Control to the respective Web Application that

they are trying to create the site collection in. They can also create a Site Collection within any web

application if they are a member of the Farm Administrator group in SharePoint, and they are

connected to Central Administration as a farm connection.

Retrying Failed Document Copies to O365 CSOM
Connections

Question

When I try to migrate some of my content into O365 using a SharePoint CSOM connection type, and

this content contains a large Document Library, I see that some of my documents fail to migrate. The

logs for the failure indicate that a "HTTP 500 - Internal Server Error" was thrown. What is the cause of

this? And how can I fix it?

Answer

There is a potential issue when migrating specifically to SharePoint Online where users can encounter

an "HTTP 500" error. This is caused by a combination of the CSOM adapter and SharePoint's document

upload methods. To help resolve this issue there is a document retry feature that can be configured.

This retry feature will attempt to upload the document(s) into the SharePoint Online  target, and

depending on the configured setting, will attempt to retry the upload process if it fails or times-out on

the initial try.

The below steps will explain how to enable and configure this retry setting.

NOTE: This retry method is only meant for migrating to SharePoint Online  targets. If you are

migrating to an on premises target, then this retry feature will not benefit you since it makes use of

O365 specific methods.

1. Make sure that the Metalogix Content Matrix client application is closed.

2. In the file system that the Metalogix Content Matrix Console client application is installed on,

navigate to the the appropriate file location:

· If you are required to be a local administrator on the machine where Content Matrix is installed: 

C:\ProgramData\Metalogix

OR

· If you are not required to be a local administrator on the machine where Content Matrix is

installed:  C:\Users\<username>\AppData\Roaming\Metalogix\Common
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3. In this location there should be an EnvironmentSettings.xml file. Open this file in an editor

program. For example, Notepad, etc.

4. There are two variables that will need to be modified in order for the retry method to work. They

are:

· CSOMDocumentRetriesNumber - This value determines the number of times that Metalogix

Content Matrix will make another attempt to upload/migrate any document(s) that has failed the

initial document upload try, when migrating to a SharePoint Online CSOM target.

· CSOMDocumentRetriesDelay - This value determines the amount of time, in seconds (s), that

Metalogix Content Matrix will wait before starting a document upload retry, and is based on the

above ("CSOMDocumentRetriesNumber") variable.

NOTE: The default values for these two variables will be set as "0". Users can set these values as

desired, based on what works best for their environment.

5. After the desired values have been entered in the two variables, save and close the file.

6. Restart the Metalogix Content Matrix client application. The changes should now be in Metalogix

Content Matrix Console, and used when running any migration to a SharePoint Online target

environment.

After these values have been set and the client application has been restarted, any documents that fail

on the initial migration attempt we be retried.

Errors Connecting to SharePoint 2019 or
SharePoint Server Subscription Edition in a
FIPS-Enabled Environment

Question

Why am I getting an error when I try to connect to SharePoint 2019 or SharePoint Server Subscription

Edition in a FIPS-enabled environment?

Answer

Content Matrix uses some assemblies for FIPS compliance that are not supported for certain

SharePoint 2019 and SharePoint Server Subscription Edition connections.  

For a remote object model (MEWS) connection (displays for the top node) for SharePoint 2019:

Client found response content type of 'text/html; charset=utf-8', but expected 'text/xml'. The request

failed with the error message: -- <!DOCTYPE html> <html>

For a local object model (OM) connection (displays at the item level for SharePoint 2019 and

SharePoint Server Subscription Edition):
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The type initializer for 'Microsoft.SharePoint.ApplicationRuntime.SPRequestModule' threw an exception

In addition, errors will display in Browser View and Items View.  

For SharePoint Server Subscription Edition, you can connect using a remote object model (MEWS)

connection.  

Error Making a Browser-Based Connection with
PowerShell Console Open

Question

Why do I get a "Manual Reconnection Required" error when I try to run a Metalogix Content Matrix job

using PowerShell?

 Answer

This error would occur if you used the Metalogix Content Matrix Console to connect to a SharePoint

target with Web Browser Authentication while the PowerShell console is open.  To avoid this issue,

take the following steps:

1. Make sure that the PowerShell console is closed at the time you make a target connection via the

Metalogix Content Matrix Console when Web Browser Authentication is used.  

NOTE: After entering your credentials, be sure to check the Remember my Password box, as

credentials must be stored in the Credential Manager vault before the connection is made.

2. After you have created your PowerShell job, close the Metalogix Content Matrix Console.

NOTE:  At this point, it is recommended that you remove your Web Browser Authentication

credentials from Windows Credential Manager.  You will be prompted to re-enter them when the

PowerShell job is run. 

3. Launch the PowerShell console and run the job.

4. When prompted, re-enter the credentials you used to connect via the Metalogix Content Matrix

Console.  (Again, remember to check the Remember my password box.)
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Support for GCC High Tenants

Question

Does Content Matrix support SharePoint Online GCC High connections?

Answer

Refer to the following table for specific target connections that Content Matrix supports for GCC High

tenants.

IMPORTANT:  In order to use ADFS authentication with a GCC High tenant you must first run a utility

provided by Quest Support and enable the setting EnableUserProvidedAuthentication. Refer to the

Quest Support Knowledge Base article Enabling User Provided Authentication in Content Matrix for

details.

OAuth OAuth with

MFA

ADFS ADFS 

(Office 365 User

Provided

Authentication)

Web Browser

Authenticatio

n

Office 365 Web

Browser

Authentication

-- -- --

-- --

https://support.quest.com/metalogix-content-matrix/kb/330254/enabling-user-provided-authentication-in-content-matrix
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Quest creates software solutions that make the benefits of new technology real in an increasingly

complex IT landscape. From database and systems management, to Active Directory and Office 365

management, and cyber security resilience, Quest helps customers solve their next IT challenge now.

Around the globe, more than 130,000 companies and 95% of the Fortune 500 count on Quest to deliver

proactive management and monitoring for the next enterprise initiative, find the next solution for

complex Microsoft challenges and stay ahead of the next threat. Quest Software. Where next meets

now. For more information, visit www.quest.com. 

Contacting Quest

For sales or other inquiries, visit www.quest.com/contact.

Technical Support Resources

Technical support is available to Quest customers with a valid maintenance contract and customers

who have trial versions. You can access the Quest Support Portal at https://support.quest.com

The Support Portal provides self-help tools you can use to solve problems quickly and independently,

24 hours a day, 365 days a year. The Support Portal enables you to:

· Submit and manage a Service Request

· View Knowledge Base articles

· Sign up for product notifications

· Download software and technical documentation

· View how-to-videos

· Engage in community discussions

· Chat with support engineers online

· View services to assist you with your product

http://www.quest.com
http://www.quest.com/contact
https://support.quest.com


194
About Us

Metalogix® Content Matrix eRoom Edition


	Introduction
	Supported Source Systems
	Supported Target Systems
	Key Features
	Product Announcements Splash Screen
	Automatic Updates

	Entering the License Key
	Online Activation
	Offline Activation
	Checking the Current Content Matrix Console License

	Selecting the SQL Database You Want to Connect to
	Content Matrix Console End User Interface
	Main (Ribbon) Toolbar
	Quick Access Toolbar
	Explorer Control View Tabs
	Explorer View Tab
	Items View Tab
	Browser View Tab

	Jobs List
	Using Multi-Select

	Connecting to eRoom
	Enabling eRoom XML
	Connecting or Reconnecting to eRoom Using Web Browser Authentication

	Connecting to SharePoint
	Connecting to a SharePoint On Premises Site or Server
	Overriding the Version of the Metalogix Extensions Web Services (MEWS) When Making a SharePoint Connection

	Connecting to SharePoint Online
	Using Office 365 OAuth Authentication to Connect to SharePoint Online
	Registering the Metalogix Content Matrix SharePoint Client Application for OAuth Authentication
	Completing a Connection to SharePoint Online Using Office 365 OAuth Authentication


	Connecting with Certificates
	Removing Certificates

	Connecting to SharePoint Using PowerShell

	Preparing for Your Migration
	Showing and Hiding Template Rooms
	Performing a Pre-Migration Check
	Using Nested Content Reports
	Running a Nested Content Report

	Creating a SharePoint Object
	Creating a SharePoint Site
	Create SharePoint Site Collection
	Create a SharePoint List
	Create SharePoint Folder

	Deleting SharePoint Objects
	Mapping Links for Link Correction

	Initiating a Migration
	Migrating an eRoom Container as a SharePoint Document Library
	Migrating an eRoom as a SharePoint Site Collection
	Migrating an eRoom as a SharePoint Site
	Migrating All eRoom Items into an Existing SharePoint Site
	Migrating eRoom Content into an Existing SharePoint List
	Migrating an eRoom Discussion Board, Note, or Inbox
	Migrating an eRoom Poll as a SharePoint Survey
	Migrating an eRoom Database to SharePoint
	Configuration Considerations when Migrating an eRoom Database to SharePoint

	Migrating Links

	Configuring Copying Options
	Site Collection Options
	Collision Options
	Container Options
	eRoom Containers - Include Subfolders
	eRoom Containers - Include Inboxes/Notes/Discussions
	eRoom Containers - Include Documents
	eRoom Containers - Include Calendars
	eRoom Containers - Include Databases
	eRoom Containers - Include Polls
	eRoom Containers - Include Links
	Mapping Columns


	Permissions Options
	Mapping Users
	Importing User Mappings from an xml File


	Nested Content Options
	Link Correction Options
	Transformations Options 
	Using PowerShell to Create Custom Transformations


	Saving or Running a Migration Action
	Connecting to a Full SQL Job Database
	Saving a Job Configuration as a Template
	Applying a Job Template
	Managing Job Templates
	Exporting a Job Template
	Importing a Job Template

	Refreshing the Migration Jobs List
	Creating and Running a PowerShell Script from the Jobs List
	Running a PowerShell Script
	Scheduling a PowerShell Script to Run as a Windows Scheduled Task

	Triggering a Job in the Content Matrix Console to Run Using PowerShell
	Job Log Files
	Log Item Details
	Exporting Jobs to an Excel File
	Information in Exported Excel Files

	Copying Job Logging to Other Applications
	Creating a Support Zip File for a Migration Job
	Enabling Trace Logging


	Mapping Links and Running Link Correction
	Managing the Link Dictionary

	Incremental Migration
	Using PowerShell with Content Matrix
	Adding PowerShell Snap-Ins for the Application Framework
	Using Powershell for Nested Content Reports and Pre-Migration Check
	Content Matrix PowerShell Commandlet List
	Metalogix.System.Commands
	Set-ApplicationDataPath
	Set-CommonDataPath
	Get-MetalogixConfigurationVariable
	New-Filter
	Join-Filter
	Invoke-Filter
	Load-MetalogixConfigurationVariableSettings
	New-MetalogixSerializableObject
	New-MetalogixSerializableObjectCollection
	Set-MetalogixConfigurationVariable
	Set-MetalogixDefaultResolverSetting

	Metalogix.SharePoint.Commands
	Add-MLSharePointSiteCollection
	Add-Permissions
	Add-SharePointFolder
	Add-SharePointList
	Add-SharePointSite
	Clear-GlobalMappings
	Compare-MLSharePointFolder
	Compare-MLSharePointList
	Compare-MLSharePointSite
	Get-MLSharePointDatabase
	Get-MLSharePointFolder
	Get-MLSharePointFolderFromDatabase
	Get-MLSharePointItembyFileName
	Get-MLSharePointItembyID
	Get-MLSharePointItemFromDatabase
	Get-MLSharePointList
	Get-MLSharePointListFromDatabase
	Get-MLSharePointServer
	Get-MLSharePointSite
	Get-MLSharePointTenant
	Get-SharePointSiteFromDatabase
	Refresh-SharePointNode
	Remove-MLSharePointFolder
	Remove-MLSharePointItem
	Remove-MLSharePointList
	Remove-MLSharePointSite
	Remove-MLSharePointSiteCollection
	Search-SharePointSite
	Update-SharePointSiteCollectionSettings

	Metalogix.Jobs.Reporting.Commands
	Export-JobHistory

	Metalogix.ERoom.Commands
	Copy-eRoomCalendar
	Copy-eRoomContainerAsDocumentLibrary
	Copy-eRoomContainerAsFolder
	Copy-eRoomContainerAsNestedSiteCollection
	Copy-eRoomContainerAsSite
	Copy-eRoomContainerAsSiteCollection
	Copy-eRoomDocument
	Copy-eRoomLinkCorrectionAtItemLevel
	Copy-eRoomLinkCorrectionAtListLevel
	Copy-eRoomLinkCorrectionAtWebLevel
	Get-eRoomNode
	Get-NestedContentsReport
	Get-NestedContentsUrlLengthReport
	Get-PreMigrationCheck
	New-eRoomConnection



	Modifying Content Matrix Configuration and Settings
	Using Encrypted SQL Database Connections
	Configuring Proxy Settings
	Manually Configuring Proxy Settings

	Restricting Available Actions and Suppressing Events
	ServerAdapterConfig.xml File Format
	Actions That Can Be Disabled

	Configuration Variable Files
	Changing Resource Utilization Settings

	Frequently Asked Questions
	Images Not Migrating with eRoom Content
	Permission Mapping Between eRoom and SharePoint
	DB_Owner Permission
	Keyboard Shortcuts
	Activating the License Key Silently
	License Key Troubleshooting
	Using Proxies, Load Balancing or Alternate Access Mappings
	Changing a Job Configuration for Multiple Files
	SharePoint 2013 and 2016 Site Collection Creation Issue
	Retrying Failed Document Copies to O365 CSOM Connections
	Errors Connecting to SharePoint 2019 or SharePoint Server Subscription Edition in a FIPS-Enabled Environment
	Error Making a Browser-Based Connection with PowerShell Console Open
	Support for GCC High Tenants

	About Us
	Contacting Quest
	Technical Support Resources


